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1 Overview 
This document outlines the operation and functionality of the Signal Hound SpikeTM spectrum analyzer 

software. SpikeTM is compatible with Signal Hound’s line of spectrum analyzers and tracking generators 

which include,  
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• SM series – SM200A / SM200B / SM200C / SM435B / SM435C 

• SP series – SP145 

• BB series - BB60A / BB60C / BB60D 

• SA series - SA44 / SA44B / SA124A / SA124B 

• TG series - TG44 / TG124  

o A TG series device can only be interfaced when a compatible spectrum analyzer is 

connected in the Spike software. 

This document will guide users through the setup and operation of the software. Users can use this 

document to learn what types of measurements the software is capable of, how to perform these 

measurements, and how to configure the software. 

1.1 WHAT’S NEW 
With Version 3.0, the software has been rebranded Spike. The software now supports all Signal Hound 

spectrum analyzers and tracking generators. Some older versions of the SA44 and SA124 require a 

firmware update to work with Spike. 

1.2 SOFTWARE UPDATES 
The latest version of the Spike software is always available at www.signalhound.com/Spike. As of Spike 

Version 3.0.10, the software will also alert a user when a newer version of the software is available. This 

alert will appear in the status bar as well as on the Help->About Spike dialog. The software will provide a 

link to where the latest version can be downloaded. 

2 Preparation 
2.1 SYSTEM REQUIREMENTS 

Supported Operating Systems* 

• Windows 11/10 64-bit 

• Ubuntu 22.04/20.04/18.04 64-bit (SM, SP, and BB devices only) 

Minimum System Requirements 

• Processor requirements  

o SM435B, SM200B/A, SP145, BB60D/C/A 

▪ Intel Desktop quad-core i5/i7/i9 processors, 4th generator or later**. 

o SM435C, SM200C 

▪ For 200MS/s I/Q streaming, 8th generation i7 or newer or i9 is 

recommended. 

o SA44/SA124 

http://www.signalhound.com/Spike
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▪ Dual-core Intel processors. 

• RAM requirements, the software will on average require less than 1GB of memory, certain 

configurations for the BB and SM products can consume several GB of memory. 

o Recommended - 8 GB  

o Minimum - 4 GB 

• Peripheral support 

o SM435B, SM200B/A, BB60D/C/A 

▪ USB 3.0  

o SP145 

▪ USB 3.0 type C port with 10W power delivery. 

▪ Or, USB 3.0 using external power supply. 

o SM435C, SM200C 

▪ 10GbE network connectivity through NIC via SFP+ connectors or through 

Thunderbolt 3 to SFP+ adapter. See network setup guide for more 

information. 

o SA44/SA124  

▪ USB 2.0 

• Graphics drivers 

o OpenGL 3.0 support 

(* We do not recommend running the Signal Hound products in a virtual machine, i.e. 

Parallels/VMWare/etc.) 

(** Our software is highly optimized for Intel CPUs. We recommend them exclusively. Xeon processors 

are not recommended) 

2.2 SOFTWARE INSTALLATION (WINDOWS) 
The software can be found on the CD included with your purchase or on our website at 

www.SignalHound.com/Spike. The most current version of the software is always on the website. 

Once you have located the software, on Windows systems run the Spike Installer(x64).msi or the Spike 

Installer(x86).msi and follow the on-screen instructions. You must have administrative privilege to 

install the software. The installer will install the device drivers for the SM, SP, and BB series devices. The 

SA and TG series drivers must be installed separately and can be found at www.signalhound.com/Spike.  

It is recommended to install the application folder in the default location.  

Note: It is becoming more common for customers to need to enable the “High Performance” power plan 

in the Control Panel -> Power Options menu. If you are using a low power/ultra-portable PC or laptop, 

consider this step to ensure optimal performance. See power management settings for more 

information. 

http://www.signalhound.com/
http://www.signalhound.com/Spike
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2.3 SOFTWARE INSTALLATION (LINUX) 
Download the latest Linux Spike application at www.signalhound.com/spike. Follow the installation 

instructions found in the README file included in the download. 

2.4 DRIVER INSTALLATION (WINDOWS) 
The drivers for the SA series devices must be downloaded and installed separately. Visit the 

www.signalhound.com/Spike page to download the USB drivers. The installer must be run as 

administrator. 

The drivers for the USB 3.0 devices are placed in the application folder during installation. The 

\drivers\x86\ folder are for 32-bit systems and the \drivers\x64\ folder for 64-bit systems. The drivers 

should install automatically during setup. If for some reason the drivers did not install correctly, you can 

manually install them in two ways by following the instructions below. 

To manually install the USB 3.0 drivers, navigate to the application folder (where you installed the Spike 

software) and find the Drivers64bit.exe file. (If on a 32-bit system, find the Drivers32bit.exe file) Right 

click it and Run as administrator. The console output will tell you if the installation was successful. 

If manually running the driver installers did not work, make sure the driver files are in their respective 

folders. You can also right click on the .inf file in the respective driver folder and select “Install”.  

If for some reason the drivers still did not install properly, contact Signal Hound. 

2.5 DRIVER INSTALLATION (LINUX) 
Signal Hound USB devices use the libusb driver on Linux. Please follow all installation instructions found 

in the README file in the Linux application download. 

2.6 CONNECTING YOUR SIGNAL HOUND 
With the software and device drivers installed, you are ready to connect your device. The supplied device 

USB cable should be connected to the PC first, then connected to the device. If your device supplies a Y-

cable, ensure both USB ends are connected into the PC before connecting the device.  

Once connected, you can verify the device has been properly recognized by the computer by looking in 

the device manager under the “Universal Serial Bus Controllers” tab. 

Once connected, run Spike. The first time a device is run on a new PC, it may require additional 

initialization time. 

If your device uses a 10GbE network connection, please see our separate network configuration manual 

for additional instructions. 

http://www.signalhound.com/spike
http://www.signalhound.com/Spike
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2.7 RUNNING THE SOFTWARE FOR THE FIRST 
TIME 

Once the software and drivers have been installed and the device is connected to the PC, you can launch 

the software. This can be done through the desktop shortcut or the Spike.exe file found in the installation 

directory. The default installation directory for Spike on Windows is C:\Program Files\Signal Hound\Spike. 

If a USB device is connected to the PC or an Ethernet device’s network address has been saved when the 

software is launched, the software will attempt to open the device immediately. 

If no USB device is connected to the PC and no Ethernet device’s network address has been saved, the 

software will notify you. If multiple devices are found, a selection dialog will appear allowing you to 

choose which device to connect. Cancel to go into Idle mode. 

 

Figure 1: Multiple Devices Found dialog  

In Idle moce, a device can be opened using the File > Connect Device menu option. 

If your Signal Hound device is connected to the PC and the Spike software still reports no devices found, 

see the Troubleshooting section for more information. 

Note: If you see the IF overload message on program startup, please see this troubleshooting tip. 

3 Getting Started 
This section describes the UI in detail and how the UI can be used to control your Signal Hound spectrum 

analyzer. 
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Below is an image of the software on startup. If a device is connected when the application is launched, 

the software begins sweeping the full span of the device: 

 
Figure 2 : SpikeTM UI after launch 

3.1 THE MENU 
3.1.1 File Menu 

• Load User Preset – Load a user selected preset. See Presets for more information. 

• Save User Preset – Save a user selected preset. See Presets for more information. 

• Print – Print the current view. Whether or not the control panels are included alongside 

graticule is chosen in Preferences > Screenshot Settings > Include Control Panels in Image.  

• Save as Image – Save the current view as a PNG, JPG, or BMP image. 

• Quick Save Image – Capture the current view as a PNG image without specifying the file 

name or save location. The image files are named in increasing order and prefixed with 

SpikeImage. The save directory is the last directory used to save an image file. If an image 

file has never been saved, this defaults to MyDocuments/SignalHound. 

• Manage Correction Data – Bring up dialog to view and clear correction data files for your 

Signal Hound devices. See Correction Data for more information. 

• Connect Device – If no device is connected, this will attempt to discover all Signal Hound 

devices connected to the PC via USB and list the devices and their serial numbers. It will 

also list saved network devices by name. From this list, a single device can be selected. 

• Manage Ethernet Devices - Bring up dialog to add, edit, and remove name and addressing 

information for Signal Hound networked devices. See  Ethernet Devices for more 

information. 
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• Disconnect Device – This option disconnects the currently connected device. This option 

combined with “Connect Device” is useful for cycling a devices power or swapping devices 

without closing the Signal Hound software. 

• Exit – Disconnect the device and close the software. 

3.1.2 Edit Menu 
• Restore Default Layout – After selecting this option, the software will restore its original 

layout the next time the application is launched.  

• Title – Enable or disable a custom title. The title appears above the graticule and is included 

in the screen captures via printing as well as session recordings. 

• Clear Title – Remove the current title. 

• Hide Control Panels – Temporarily hides all visible control panels. Useful for presentations 

or for viewing on small resolution displays. 

• Show Control Panels – Shows any control panels that were previously hidden. If the mode 

changes or a preset is loaded, the software will automatically show any hidden control 

panels. 

• Theme – Select a color theme for the application. This sets every color in the Colors section 

of the Preferences dialog. 

• Preferences – Opens a configuration dialog allowing further configuration of the software. 

3.1.3 Presets 
Presets are an easy way to store and load measurement configurations. Each preset stores the full 

software configuration making it easy to switch between measurement configurations and pick back up 

where you left off. 

Presets have the file extension ‘ini’ which is a Windows initialization file. The Spike software can store and 

load presets in three ways. In the file menu, the user can save and load explicit preset files by selecting 

the ini files directly. Alternatively, in the Presets menu, up to 9 presets are available for quick use. These 

presets are always available and can be quickly loaded with keyboard shortcuts. Finally, a power on 

preset can be saved from the Presets menu, which will automatically load when a device is connected. 

Presets can only be loaded by the same type of device which was used when the preset was saved. 

Presets accessed through the Preset menu are stored in 

C:\Users\YourUserName\AppData\Roaming\SignalHound\. AppData\ is a hidden folder by default on 

Windows systems. Each quick preset is stored in its own folder labeled “Preset [1-9]”. The main file has 

the .ini extension and is named “Preset [1-9].ini”. The power on preset is named “PowerOnPreset.ini”. To 

use a preset on a different computer, simply copy the preset folder to the new computer in the correct 

path.  

The power on preset can be deleted from the Presets menu, or it can be manually deleted from the file 

system. 
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3.1.4 Settings 
• Reference – Change the source of the reference oscillator and whether a 10 MHz reference 

signal is emitted.  

o Internal or external reference can be chosen. If external reference is chosen, ensure 

a 10MHz reference is connected to the appropriate BNC or SMA input port.  

o For select devices, a reference output can be enabled.  

o Device Options 

▪ SM analyzers 

• Use Internal Reference – Use the internal 10 MHz clock. 

• Use External Reference – Use an external 10 MHz clock into the 

“10 MHz In” SMA port. 

• Internal Out Enabled – Emit a 10 MHz reference signal from the 

“10 MHz Out” SMA port. 

▪ SP analyzers 

• Use Internal Reference – Use the internal 10MHz clock. 

• Use External Reference – Use an external 10MHz reference clock. 

If one is not present and this selection is chosen, a large frequency 

offset will be present in the measurement. 

▪ BB60 analyzers 

• Use Internal Reference – Use the internal 10 MHz clock. 

• Use External Reference (AC) – Use an external 10 MHz AC/sin wave  

reference clock into the “10 MHz Ref In/Out” BNC port. 

• Use External Reference (DC) – Use an external 10 MHz DC/CMOS-

TTL input clock into the “10 MHz Ref In/Out” BNC port. 

• Reference Out – Emit a 10 MHz reference signal from the “10 MHz 

Ref In/Out” BNC port. Internal corrections will not be applied since it 

is assumed that the incoming signal is from an instrument 

referenced to the BB60’s own 10 MHz output. 

▪ SA124B 

• Not Set, Use Internal Reference – Use the internal 10 MHz clock. 

• Internal Reference Out – Emit a 10 MHz reference signal from 

from the “10 MHz Ref In/Out” BNC port. 

• Use External Reference – Use an external 10 MHz clock into the 

“10 MHz Ref In/Out” BNC port. 

▪ SA44B 

• Not Set, Use Internal Reference – Use the internal 10 MHz clock. 

• Internal Reference Out – NOT USED. 

• Use External Reference – Use an external 10 MHz clock into the 

“10 MHz Ref In” BNC port. 

• Reference Level Offset - Adjust the measurement amplitude to compensate for an 

attenuator, probe, or preamplifier. The offset is specified as a flat dB offset. This offset is 

then applied to the measurement. See Using the Reference Level Offset for more 

information. 

• Spur Reject – See Spur Rejection for more information. 
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• Enable Manual Gain/Atten – Enable the ability to change gain and attenuation. Signal 

Hound recommends keeping gain and attenuation set to automatic and controlling the 

sensitivity of the receiver through the reference level control. 

3.1.5 Analysis Mode 
This menu option allows you to switch between the main measurement modes in Spike. 

• Idle – Suspend operation. 

• Sweep –See Swept Analysis for more information. 

• Real-Time–See Real Time Spectrum Analysis for more information. 

• Zero-Span –See Zero Span Analysis for more information. 

• Harmonics – See Harmonic Analysis for more information. 

• Scalar Network Analyzer – See Scalar Network Analysis for more information. 

• Phase Noise– See Phase Noise for more information.  

• Digital Modulation Analysis – See Digital Demodulation for more information. 

• EMC Precompliance – See EMC Precompliance for more information. 

• Analog Demod – See Analog Demod for more information. 

• Interference Hunting – See Interference Hunting for more information. 

• Spectrum Emission Mask – See Spectrum Emission Mask for more information. 

• Noise Figure – See Noise Figure for more information. 

• Bluetooth® Low Energy – See Bluetooth® Low Energy for more information. 

• WLAN - See WLAN Modulation Analysis for more information. 

• LTE – See LTE for more information. 

• Mapping – See Mapping for more information. 

3.1.6 Utilities 
• Path Loss Tables – See Managing Loss Tables for more information. 

• Limit Lines – See Managing Limit Lines for more information. 

• Audio Player – See Audio Player for more information. 

• Measuring Receiver – See Using the Measuring Receiver Utility for more information. 

• Frequency Difference Meter – See the Frequency Difference Meter for more information. 

• Timebase Adjustment – See Adjusting Your Timebase for more information. 

• Tracking Generator Controls – If a SA or BB series spectrum analyzer is the current active 

device in the software and a Signal Hound tracking generator is connected to the PC, 

selecting this utility introduces an additional control panel for controlling the tracking 

generator output manually. The tracking generator will only respond if the scalar network 

analysis mode is not active. 

• SA124 IF Output – Brings up a dialog box to control the IF downconverter for the SA124 

spectrum analyzers. While the SA124 IF downconverter is active, the device cannot perform 

other tasks.  

• SM435 IF Output – Control the SM435 as an IF downconverter. The SM435 device must 

have the IF output option. The SM435 can function as a 24-43.5GHz to 1.5GHz 

downconverter, with 800MHz of bandwidth. While the device is functioning as a 

downconverter no other measurements can be performed. 
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• Self-Test – Brings up a dialog box to manually self-test SA44B and SA124B devices. The 

dialog will explain the process of setting up the device for self-test and will display the 

results immediately after the test is performed. 

• BB60D UART Controls – See BB60D GPIO Controls for more information. 

• SP145 UART Controls – See SP145 GPIO Controls for more information. 

• SM GPIO Controls – See SM GPIO Controls for more information. 

• Diagnostics – Brings up a dialog window with various temperature and power sensor 

measurements depending on device. Also, for devices that have active cooling, provides fan 

setpoint control. 

• Networked Speed Test – See Networked Speed Test for more information.  

• GPS Control Panel – See GPS for more information. 

• SM Network Configuration – See SM Network Address Configuration for more 

information. 

• I/Q Recorder – See I/Q Recorder for more information.  

• SCPI Log – See SCPI Log for more information. 

3.1.7 Help 
• User Manual – Open the Spike user manual in the system default PDF reader. 

• Signal Hound Website – Open www.signalhound.com in the system default web browser. 

• Support Forums – Open the signal hound support forum web page in the system default 

web browser. 

• About Spike – Display version and product information. 

3.2 THE CONTROL PANELS 
The control panels are a collection of interface elements for configuring the device and configuring the 

measurement utilities of the software. Each control panel can be moved to accommodate a user’s 

preference. The panels may be stacked vertically, dropped on top of each other (tabbed), or placed side 

by side. This can be accomplished by dragging the panels via the control panel’s title bar. 

Different measurement modes will show different control panels. These controls are described in more 

detail in Analysis Modes. 

3.3 THE TOOL BARS 
The tool bar is located under the application menu. The toolbar is populated with commonly used 

functionality and view related controls for the current software configuration. All measurement modes 

share a set of controls while some measurements provide additional controls. 

The shared functionality is described below. 

• Single – Request the software perform one more measurement before pausing. 

• Auto – Request that the software continuously perform measurements.  

http://www.signalhound.com/
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• Recal – Recalibrate the device for any potential temperature drift. This button should be 

pressed any time the software presents the Perform Cal annunciator or when the user 

believes a recent change in temperature is affecting the measurement accuracy. Most 

measurement modes will auto recalibrate the device when a 2C temperature drift has been 

measured. 

• Preset – Restores the software and hardware to its initial power-on state by performing a 

device master reset.  

 

3.4 PREFERENCES 
The preferences menu can be found under Edit Menu→Preferences. The preferences menu contains a 

collection of settings to further configure the Spike software. 

• Trace Width – Determines the overall width of the trace being drawn on the graticule. 

• Graticule Width – Determines the width of the lines that make up the graticule. 

• Graticule Dotted – Set whether the non-border graticule lines are dotted or solid. 

• Display Line Width – Determines the width of the display line being drawn on the 

graticule. 

• Export Sweep Minimums – When this control is selected, the Export trace button will 

export a CSV of the form (frequency (Hz), min amplitude, max amplitude) instead of the 

normal form (frequency (Hz, max amplitude). 

• Export Scale – Select the frequency units to be used when exporting a trace. 

• Real Time Frame Rate – Set the update rate of the device and software when operating in 

real-time mode. Higher frame rates improve the resolution of events but also require 

higher PC performance. Can set values between 4 and 30 fps. This setting affects the SA 

and BB devices only. 

• Max Save File Size – Control the maximum size of a sweep recording. The software will 

stop recording when the max file size has been reached. For 32-bit machines, 1GB is the 

maximum possible file size. On 64-bit machines, the max file size can be set to 128GB.  

• Include Control Panels in Image – Toggles whether the control panels will appear along 

with the graticule in screenshot functions “Save as Image,” “Quick Save Image,” and “Print.” 

• Auto Reconnect – Automatically attempt to reconnect device after a forced disconnect.  

• Auto Reconnect Timeout – Duration of auto-reconnect attempt. 

• Show No/Multiple Device Notifications – Show modal alert on startup if there are either 

no devices connected or multiple devices connected. If there are no devices connected, 

then in order to run in demo mode this alert must be shown. If there are multiple devices, 

then Spike will start in Idle mode, and the user must select a device to connect with File > 

Connect.  

• Auto Recal – Automatically recalibrate the device when a 2C temperature drift has been 

measured. 

• Colors – Control the color of various software features. 

• SCPI Enabled – When enabled, the Spike software will listen on the chosen IP port for an 

incoming connection. If this selection is changed, the software must be restarted to take 

effect. 
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• IP Port – The port on which the Spike software listens for an incoming connection for SCPI 

control over TCP/IP. 

• Lockout Dialog Enabled – Show a modal alert dialog to indicate that Spike is being 

operated remotely via SCPI commands. 

• Log Enabled – Timestamp and save to a log all incoming and outgoing SCPI messages. 

• Log Max Entries – The maximum number of total entries in the log. 

• Log Max Message Length – The maximum number of characters that a SCPI message in 

the log may retain. Longer messages entering the log will be truncated to this length.  

• Log FIFO Mode – Drop the oldest messages when new messages are received or sent after 

the log max entries has been exceeded, otherwise new messages will not be logged. 

3.4.1 Language Selection 
The Spike software offers multiple language choices for most user-facing text and strings. The first time 

the software is launched on a PC, Spike will attempt to determine the best translation based on locale. 

Once loaded Spike will remember the last language used. 

In the preference menu, a user can change the translation Spike uses. Simply select the language of 

choice and press “Apply”. Once applied, the software will need to be restarted to take effect. On the next 

program launch, the selected language will be loaded. 

3.5 THE STATUS BAR 
The status bar runs across the bottom of the application. When the mouse enters the graticule the 

status bar displays the frequency/time value for the x-axis and the amplitude/frequency value for the y-

axis. The status bar readings should not be used for precise measurements but is great for quick 

estimations. 

The status bar also displays information about the current device connected if there is one. The type of 

device, temperature of the device, power supplied to the device, the device serial number and firmware 

version are displayed. 

3.6 ANNUNCIATOR LIST 
Annunciators are warnings and indicators providing useful information to the operator. Annunciators 

are typically displayed in the upper left-hand corner of the graticule. Below is a list of all annunciators 

and their meanings. 

• IF overload – This indicator appears when hard compression is present on the displayed 

measurement. This annunciator will appear in the top center of the graticule and will 

trigger the UNCAL indicator. This occurs when the input RF signal reaches the maximum 

possible digital level. To fix this, decrease input signal amplitude, increase the reference 

level, increase attenuation, or lower gain. 

• USB/UDP – This indicator appears when data loss occurred over USB (for USB devices) or 

the network (for 10GbE devices). The data loss results in an incomplete or failed 
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measurement. The software will continue to attempt to perform measurements in this 

scenario until a successful measurement can be performed. If you see this message 

regularly, this is an indication of potential PC problems, such as out of date drivers, faulty 

USB hardware, or over-taxed system.  

• Perform Cal – This indicator appears when the device has deviated more than 2 °C since its 

last temperature calibration. The software will automatically recalibrate the device in most 

measurement modes. For some measurement modes such as I/Q streaming, the user can 

determine when to recalibrate the device by pressing the Recal button on the user 

interface. 

• Low voltage – This indicator appears when the device is not receiving enough voltage from 

the USB 3.0 connection. The voltage value appears when this annunciator is present. The 

device requires 4.4V. If this annunciator appears, it may indicate other problems. Contact 

Signal Hound if you are unable to determine the source of this problem. 

• High temp – Specific to the SM series. When the FPGA internal temperature reaches 95C, 

this warning is shown. The software should be closed, and the device allowed to cool off. 

• Span limited by preselector – Specific to the SM series. When the preselector is enabled 

and the user configured span is limited by the bandwidth of the preselector filter, this 

warning is displayed. 

• PLT – Indicates the path loss table is active. 

• RLO – Indicates the reference level offset is a non-zero value. 

• CPU Resources Exceeded – Indicates that the current measurement was unable to 

properly finish due to either inadequate CPU resources or due to an interruption of the 

system during the measurement. Many measurements for Signal Hound devices require 

minimum processing requirements to complete real-time tasks. If the processor is unable 

to keep up with the required processing, you will see this warning. The measurement data 

should be ignored. 

• Uncal – This indicator appears whenever any warning indicator is active to notify the user 

that the device may not be meeting published specifications. This is also indicated in scalar 

network analysis mode to denote that the store through calibration has not been 

performed. 

• Swept Real Time – Active when an SM series device is configured in real-time mode with a 

span greater than 160MHz. 

4 Analysis Modes 
The Spike software provides several analysis modes for your spectrum analyzer. Each mode and its 

measurement capabilities are described below. Note that not all modes are available for all Signal Hound 

spectrum analyzers. 

4.1 SWEPT ANALYSIS 
This mode of operation is the mode which is commonly associated with spectrum analyzers. Through 

the software you will configure the device and request the device perform a single sweep across your 
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desired span. Spans larger than the devices instantaneous bandwidth is the result of acquiring multiple 

IF patches and concatenating the results of the FFT processing on each of these IFs.  

The processing performed on each IF patch is determined by the settings provided. Each time a trace is 

returned, the device waits until the next trace request. For you, the software user, you can choose to 

continuously retrieve traces or manually request them one at a time with the Single and Auto buttons 

found on the Sweep Toolbar. 

4.1.1 Sweep Settings Control Panel 
The Sweep Settings control panel controls the sweep acquisition parameters for the device in standard 

swept-analysis and real-time modes. 

4.1.1.1 Frequency Controls 
• Center – Specify the center frequency of the sweep. If a change in center frequency causes 

the start or stop frequencies to fall outside the range of operation, the span will be 

reduced. Using the arrows changes the center frequency by step amount. 

• Span – Specify the frequency difference between the start and stop frequencies centered 

on the center frequency. A reduced span will be chosen if the new span causes the start or 

stop frequencies to fall outside the range of operation. Use the arrows to change the span 

using a 1/2/5/10 sequence. 

• Start/Stop – Specify the start and stop frequency of the device. Frequencies cannot be 

chosen that are outside the range of operation of the active device. 

•  Step – Specify the step size of the arrows on the center frequency control. 

• Full Span – This will change the start, stop, center, and span frequencies to select the 

largest span possible. 

• Zero Span – Enter Zero-Span mode using the current center frequency. 

4.1.1.2 Amplitude Controls 
• Ref Level – Changing the reference level sets the power level of the top graticule line. The 

units selected will change which units are displayed throughout the entire system. When 

automatic gain and attenuation are set (default), measurements can be made up to the 

reference level. Use the arrows to change the reference level by the amount specified by 

the Div setting. 

• Div – Specify the scale for the y-axis. It may be set to any positive value. The chosen value 

represents the vertical height of one square on the graticule. 

o In linear mode, the Div control is ignored, and the height of one square on the 

graticule is 1/10th of the reference level. 

• Atten – Sets the internal electronic attenuator. By default, the attenuation is set to 

automatic. It is recommended to set the attenuation to automatic so that the device can 

optimize fo dynamic range and compression. 

• Gain – Gain is used to control the input RF level. Higher gains increase RF levels. When gain 

is set to automatic, the best gain is chosen based on reference level, optimizing for dynamic 
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range. Selecting a gain other than Auto may cause the signal to clip well below the 

reference level, and should be done by experienced Signal Hound users only. 

• Preamp – If the device connected has an internal preamplifier, this setting can be used to 

control its state. 

4.1.1.3 Bandwidth Controls 
• RBW Shape – Select the RBW filter shape. See RBW Filter Shape for more information. 

• RBW – This controls the resolution bandwidth (RBW). For each span a range of RBWs may 

be used. The RBW controls the FFT size and signal processing, similar to selecting the IF 

band pass filters on an analog spectrum analyzer. The selectable bandwidths displayed 

change depending on the RBW Shape selected. 

o RBWs are available in a 1-3-10 sequence. (e.g. 1 kHz, 3 kHz, 10 kHz, 30 kHz, 100 kHz, 

…) when using the arrow keys.  

• VBW – This controls the Video Bandwidth (VBW). After the signal has been passed through 

the RBW filter, it is converted to an amplitude. This amplitude is then filtered by the Video 

Bandwidth filter. When VBW is set equal to RBW, no VBW filtering is performed. 

o All RBW choices are available as Video Bandwidths, with the constraint that VBW 

must be less than or equal to RBW. 

o In Real-Time mode VBW is not selectable. 

• Auto RBW – Having auto selected will choose reasonable and fast RBWs relative to the 

span. When changing span, it is recommended to have this enabled along with Auto VBW.  

• Auto VBW – When enabled, VBW will equal RBW. 

4.1.1.4 Acquisition Controls 
• Video Units – In the system, unprocessed amplitude data may be represented as voltage, 

linear power, or logarithmic power. Select linear power for RMS power measurements. 

Logarithmic power is closest to a traditional spectrum analyzer in log scale. 

• Detector – The detector specifies how amplitudes in each bin are calculated. Each 

frequency bin in a sweep is the result of several FFTs depending on RBW/VBW/SwpTime. 

The results of the FFTs are then either averaged or min/maxed based on the choice of 

detector. Choose min/max to show the range between the min and max value. When 

min/max is selected, markers are placed on the max values. To place markers on the min 

values, select min detector. 

•  Sweep Time  

o For SA series devices, the sweep time value is ignored. 

o For BB and SM series devices, sweep time is used to suggest how long the spectrum 

analyzer should acquire data for the configured sweep. The actual sweep time may 

be significantly different from the time requested, depending on RBW, VBW, and 

span settings, as well as hardware limitations.  

• Sweep Interval – For all devices, the device will sweep at intervals of no more than the 

configured sweep interval. For example, a sweep interval will cause the device to sweep at 

most once per second.  
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4.1.2 Measurements Control Panel 
The Measurements control panel allows the user to configure the spectrum related measurements. This 

control panel is visible while the software is in standard swept analysis and real-time operating modes. 

4.1.2.1 Trace Controls 
The software offers up to six configurable traces. All six traces can be customized and controlled through 

the measurements control panel. When the software first launches only trace one is visible with a type of 

Clear & Write. 

• Trace – Select a trace. The trace controls will populate with the new selected trace. All 

future actions will affect this trace. 

• Type – The type control determines the behavior of the trace over a series of acquisitions.  

o Off – Disables the current trace. 

o Clear & Write – Continuously displays successive sweeps updating the trace fully 

for each sweep. 

o Max Hold – For each sweep collected only the maximum trace points are retained 

and displayed. 

o Min Hold – For each sweep collected only the minimum trace points are retained 

and displayed. 

o Min/Max Hold – For each sweep collected, the minimum and maximum points are 

retained and displayed. 

o Average – Averages successive sweeps. The number of sweeps to average together 

is determined by the Avg Count setting. 

• Avg Count – Change how many sweeps are averaged together when a trace type of 

average is selected. 

o The current count of averaged sweeps is displayed on the line below when a trace 

type of average is selected. 

• Color – Change the color of the selected trace. The trace colors selected are saved when 

the software is closed and restored the next time the software is launched. They are also 

configurable in Preferences > Colors. 

• Copy To – Copies the contents of the currently selected trace to a different trace. The 

contents of the destination trace of overwritten. If the destination trace type is off the trace 

type is set to clear and write. The destination trace is set to, update=off, and display=on. 

• Update – If update is not checked, the selected trace remains visible but no longer updates 

itself for each device sweep. 

• Hidden – If checked, the selected trace will 

• Clear – Reset the contents of the selected trace.  

• Export – Save the contents of the selected trace to a CSV file. A file name must be chosen 

before the file is saved. The CSV file stores (Frequency, Max Amplitude) pairs. Frequency is 

in Hz, Min/Max are in dBm/mV depending on whether logarithmic or linear units are 

selected. 
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4.1.2.2 Marker Controls 
The software allows for six configurable markers. All six markers are configurable through the 

measurements control panel. 

• Marker – Select a marker. All marker actions taken will affect the current selected marker. 

• Type – Specify the marker measurement type. For normal and delta marker readings, 

select Normal; for noise measurements, select Noise; for channel power at marker, select 

Channel Power; for N dB band, select N dB. 

• Place On – Select which trace the selected marker will be placed on. If the trace selected 

here is not active when a marker is placed, the next active trace will be used. 

• Update – When Update is ON, the markers amplitude updates each sweep. When OFF, the 

markers amplitude does not update unless moved. 

• Active – Active determines whether the selected marker is visible. This is the main control 

for disabling a marker.  

• Pk Tracking – When enabled, the selected marker will be placed on the peak signal 

amplitude at each trace update. 

• Pk Threshold – Specify the minimum amplitude required for a signal to be considered as a 

peak for the peak left/right buttons. 

• Pk Excurs. – Specify how far the amplitude needs to fall around a peak to be considered a 

peak for the peak left/right buttons. 

• Ch Power Width (Only visible for Channel Power marker type) – Specify the bandwidth of the 

channel power measurement. 

• N dB Offset (Only visible for N dB marker type) – Specify the offset used to determine the N 

dB band. 

• Set Freq – Manually place the marker on the selected trace at the selected frequency. 

Enable the marker if it is currently disabled. The marker frequency will be rounded to the 

closest available frequency bin. 

• Peak Search – This will place the selected marker on the highest amplitude signal on the 

trace specified by Place On. If the selected trace is Off, then the first enabled trace is used. 

• Delta – places a reference marker where the marker currently resides. Once placed, 

measurements are made relative to the position of the reference point. 

•  To Center Freq – changes the center frequency to the frequency location of the selected 

marker. 

• To Ref Level – changes the reference level to the amplitude of the active marker. 

• Peak Left – If the selected marker is active, move the marker to the next peak on the left.  

• Peak Right – If the selected marker is active, move the marker to the next peak on the 

right. 

• Min Peak – If the selected marker is active, move the marker to the lowest amplitude 

signal. 

• Next Peak – If the selected marker is active, move the marker to the next highest peak. 

• Disable All – Disables all markers. 

For peak left/right/next, peaks are defined by a group of frequency bins 1 standard deviation above the 

mean amplitude of the sweep. 
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4.1.2.3 Occupied Bandwidth 
• Enabled – When enabled, occupied bandwidth measurements will become active on the 

screen. 

• Target – Select which trace the occupied power measurement is performed on. 

• % Power – Percent power allows the percentage of the integrated power of the occupied 

bandwidth measurement to be adjusted. 

4.1.2.4 Trace Math Controls 
All controls related to the trace math capability in Spike. For more information see Trace Math. 

• Enabled – Turns on/off trace math. 

• Op1 – Set the first trace math operand. 

• Op2 – Set the second trace math operand. 

• Result – Set the trace math result trace (destination). 

• Operation – Select the trace math operation. 

• Offset – Set the trace math offset. Only applies to certain operations.  

4.1.2.5 Display Line Controls 
The display line is a configurable visual only reference line shown on the graticule for sweep and real-

time modes. The line is always drawn at a single y-amplitude across the entire graticule regardless of plot 

scale. 

• Enabled – Turns on/off the display line. 

• Level – Set the y position of the display line.  

4.1.3 Channel Power Control Panel 
See Channel Power for more information about taking channel power measurements. 

4.1.4 Intermodulation Distortion Control Panel 
See Intermodulation Distortion for more information about taking intermodulation distortion 

measurements. 

4.1.5 Sweep Recording Control Panel 
See Sweep Record and Playback for more information about sweep recording. 

4.1.6 Sweep Toolbar 
The sweep controls are visible when the device is operating in the normal sweep and real-time 

measurement modes.  

• Spectrogram – Enables the spectrogram display. See Spectrogram. 
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• Persistence – Enables/disables the persistence display. See Persistence. 

• Intensity – Controls the intensity of the persistence display.   

4.1.7 Sweep Plot 
The plot displayed in both sweep and real-time measurement mode has several of the same zoom 

capabilities of the plots throughout the application. See Zoom and Axis Manipulation for more 

information.  

The sweep plot is returned to auto scale when the measurement configuration changes. This can be due 

to the user changing a measurement parameter or loading a preset. 

4.1.8 Peak Table  
The peak table is a feature, in addition to markers, which allow the user to measure the absolute and 

relative amplitudes and frequencies of several signals present in spectrum at once. The peak table is 

available in sweep and real-time measurement modes.  The peak table displays up to 99 peaks sorted by 

frequency or amplitude, which exceed the user’s peak threshold settings. The peak threshold and 

excursion settings operate similarly to the ones available for markers (see Measurements Control Panel).  

 

 
Figure 3: Peak table measuring the harmonics of a 10MHz input CW signal. 
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4.2 REAL-TIME SPECTRUM ANALYSIS 
All Signal Hound spectrum analyzers can operate as real-time spectrum analyzers. Real-time spectrum 

analysis can be performed by selecting Analysis Mode -> Real Time in the main file menu. When the device 

is in real-time analysis mode, the bandwidth is limited to the real-time bandwidth, which is different for 

each Signal Hound device. 

Analyzing signals in real-time mode is critical for characterizing short duration spectral events, such as 

spurious emissions or for interference hunting. Real-time analysis is also great for monitoring spread 

spectrum signals and observing frequency hopping communications channels.  

These types of applications are possible because real-time spectrum analysis guarantees 100% 

probability of intercept for signals of a specific duration. That duration is dependent on the Signal Hound 

spectrum analyzer and the resolution bandwidth. Any signal that exceeds that duration is guaranteed to 

be captured and displayed by the Spike software. 

When in real-time mode, a special persistence display is shown. A screen shot of the software in real-

time mode is shown below.  

 
Figure 4: SA44B analyzing an FM radio station in real-time spectrum analysis mode. The persistence display is shown on the bottom half of the 

application and a 2-dimensional waterfall plot is shown on top. 

The persistence display shows a three-dimensional view of the signal density in the given span, where 

the X and Y axis still show amplitude over frequency, while the color of the plot is the density of the 

spectrum at any given point. As the spectrum density increases at a given point, the color of the plot will 

change from blue to green to red. The Signal Hound spectrum analyzers can create these plots from 

thousands to over a million traces worth of data per second to create these complex displays (depends 
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on RBW). The persistence display is the accumulation of roughly 2/3rd of a second of real-time data 

acquisition. 

4.2.1 Control Panels 
Real-time spectrum analysis shares controls panels with standard spectrum analysis. See Swept Analysis 

Mode for more information. 

4.3 ZERO-SPAN ANALYSIS 
Zero span analysis allows a user to view and analyze complex signals in the time domain. The application 

can demodulate AM, FM, and PM modulation schemes, and display the results through multiple 

configurable plots. A user can enter zero span mode by using the Analysis Mode drop down file menu, or 

by pressing the zero-span button on the Sweep Settings control panel. Below is an image of the software 

operating in Zero-Span mode. 

 
Figure 5: Triggering and measuring a pulsed waveform in zero-span mode. 

The control panel contains inputs for controlling the capture settings of the device as well as specifying 

trigger conditions for the zero span sweeps. Available triggers are video and external. Video triggers 

begin the sweep only after a signal exceeds the amplitude specified in the Video Trigger input. When 

external triggering is selected, acquisition occurs when a trigger is detected on the spectrum analyzer 

trigger input port. 

The control panel also contains a section to define the measurement interval, a subset of the zero-span 

capture that will be visible for measurement in the various plots. The Time Overview plot shows the 
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interval in relation to the whole capture and provides an interface to control the same parameters 

graphically. 

Zero-Span mode has the capability to record and playback I/Q waveforms using the record and playback 

control panels. For an in-depth discussion of I/Q record and playback see Zero-Span Recordings. 

The application window is split into multiple views and provides a control panel for controlling zero span 

acquisitions. Zero span mode currently offers ten unique plots. 

4.3.1 Zero-Span Settings Control Panel 
4.3.1.1 Capture Settings 

• Input Pwr – Expected input power of the signal. Input power controls the reference level 

and the gain and attenuation. It is suggested to keep gain and attenuation set to Auto so 

the software can best choose them based on the Input Pwr. 

• Center – Specifies the tuned center frequency of the capture, or in another way, the 0Hz 

frequency of the I/Q data capture. 

• Step – Controls how much the center frequency shifts when pressing the center frequency 

arrow keys or using the up/down arrow keys on your keyboard when the center frequency 

text is highlighted. 

• Decimation – Controls the overall decimation of the I/Q data capture. For example, a 

decimation of 2 divides the analyzer sample rate by 2. Increasing decimation rate increases 

the possible capture time of the software but decreases the time resolution of each 

capture. 

• Sample Rate – Displays the sample rate of the current visible I/Q data capture. This 

number is equal to the device sample rate divided by the decimation value. 

• IF BW – (Intermediate Frequency Bandwidth) Controls the bandwidth of the passband filter 

applied to the I/Q data stream. The bandwidth cannot exceed the Nyquist frequency of the 

I/Q data stream. 

• Auto IFBW – When set to Auto, the IF Bandwidth passes the entire bandwidth of the I/Q 

data capture. 

• Swp Time – (Sweep Time) Controls the length of the zero-span data capture. The length is 

relative to the sample rate selected by decimation. Sweep times are clamped when the 

resulting capture contains less than 20 samples, and at the upper end, when the resulting 

capture contains more than 65536 samples. 

4.3.1.2 Trigger Settings 
• Trigger Type – Select a trigger type for the data capture. Possible trigger types are 

immediate, video, external, and frequency mask trigger.  

o Immediate trigger causes an acquisition immediately. 

o Video trigger triggers an acquisition once the sample amplitude crosses the user 

specified trigger level. 
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o External trigger triggers an acquisition when a signal event is detected on the 

external trigger input port on the spectrum analyzers. Not all Signal Hound 

spectrum analyzers have access to this trigger type. 

o Frequency mask trigger, see Frequency Mask Triggering for more information. 

• Trigger Edge – Select whether to trigger on a rising or falling edge. Applies to both external 

and video triggers. 

• Video Trigger – Select the amplitude for the video trigger to trigger on. This value is 

ignored if video triggering is not selected. 

• Trigger Position – When a video or external trigger is selected, trigger position determines 

what percentage of samples of the sweep are displayed before the trigger. For example, in 

a 100-point sweep with a 10% trigger position, the sweep will display the 10 points before 

the trigger occurrence, and the first 90 points after the trigger. 

• Edit FMT – Open the frequency mask trigger editor dialog. See Frequency Mask Triggering 

for more information. 

4.3.1.3 Measurement Interval Settings 
The measurement interval settings menu in zero-span controls the measurement interval, or subset of 

the full capture, displayed by all the plots except Time Overview and Waterfall. 

• Auto Interval – When auto interval is enabled, the measurement interval is the entire 

capture. 

• Interval Offset – The time into the capture for the measurement interval to start. 

• Interval Length – The length of the measurement interval. 

4.3.1.4 FFT Settings 
The FFT settings menu in zero-span controls the FFT parameters for the spectrum and waterfall plots, 

and the waterfall’s spectrum view. 

• RBW – The desired RBW for the spectrum plot. Lower RBWs increase the required FFT 

window length. If the FFT window length is not long enough to achieve the desired RBW, 

the spectrum window will show a warning and the user will need to either increase RBW or 

increase the FFT Window length or overall capture size to display the spectrum plot. 

• Auto Overlap – When auto overlap is enabled, an overlap percentage is chosen to produce 

the maximum number of FFTs up to Max FFTs. 

• Overlap % - The percentage of overlap between FFTs. 

• Max FFTs – The maximum number of FFTs. Computation will stop when this number is 

reached, even if only a portion of the capture has been covered. 

• Step Length – The length of time from the start of one FFT to the start of the next. 

4.3.2 Record / Playback I/Q Control Panels 
See Zero-Span Recordings. 
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4.3.3 Frequency Mask Triggering 
Frequency mask triggering (FMT) is available in zero-span measurement mode. FMT works by taking 

overlapping FFTs on the input I/Q data and checking each FFT result against a user defined frequency 

mask. When the FFT results exceed the user defined mask, the software triggers the acquisition starting 

at the beginning of the FFT that exceeded the mask. The FFT size is based on the current RBW with an 

overlap rate of 50%. The flat-top window is used for all spectrum processing in zero-span mode. The 

frequency mask can be configured using the FMT editor.  

 
Figure 6: FMT editor 

The editor mirrors the standard zero-span spectrum plot as a guide for mask building. Using the editor 

buttons, you can add or remove mask points, create a mask using the spectrum plot as a baseline, apply 

frequency and amplitude offsets, and import/export existing masks for future use. Additionally, each 

point in the mask can be dragged on the spectrum plot using the left mouse button for quick mask 

building. When finished editing, select OK on the dialog and the mask is updated. Note: The frequency 

mask is not updated with the new values until you have selected OK on the dialog. 

4.3.4 Zero Span Toolbar 
These controls are available in zero-span measurement mode. 

• Add Measurement – Add a new measurement plot to the view area. 

• Auto Fit – When Auto Fit is selected the visible views will be auto scaled to fit the available 

application space. Disabling Auto Fit allows a user to scale and move the views into a 

custom configuration without the software interfering. 
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• Reset View – Resets the view area to the default configuration.  

4.3.5 Zero-Span Plots 
All plots in zero-span follow the basic plot interface in Spike.  

4.3.5.1 Time Overview 

 
Figure 7: Time Overview plot with the measurement interval set to encompass the triggered pulse. 

Shows and allows adjustment of the measurement interval in relation to the whole capture. The 

measurement interval is the portion of the capture that is displayed by every other plot, except for the 

Waterfall plot, which shows all computed FFTs across the capture. 

The measurement interval is represented by the unshaded region. Adjust the interval by dragging it or 

dragging its start and end points. 
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4.3.5.2 AM vs Time 

 
Figure 8: AM vs Time plot on triggered waveform. 

Shows the AM waveform over time. Can choose between log (dBm) or linear (mV) y-axis units.  

When triggering is enabled, a vertical gray bar appears at the trigger location. 

When the spectrum acquisition settings are set to manual, a gray shaded region covers the FFT region 

selected. 

You can export the I/Q values of the acquisition by right clicking and selecting Export I/Q (.csv) in the 

context menu. 

4.3.5.3 FM vs Time 
Plots the waveform as frequency vs time. 

4.3.5.4 PM vs Time 
Plots the waveform as phase vs time. Can choose between radians or degrees as the y-axis units. 
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4.3.5.5 I/Q Vs Time 

 
Figure 9: Pulsed CW 

Plots the individual I and Q channels as amplitude in mV vs time.  

4.3.5.6 I/Q Polar Plot 
Plots the I/Q values as mV on the cartesian plane. The plot scale is set to the selected reference level of 

the acquisition. 
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4.3.5.7 Spectrum Plot 

 
Figure 10: FM signal with max hold. 

Shows the frequency spectrum of the part of the zero-span capture defined by the measurement 

interval. The plot shows the amplitude over frequency of the waveform signal.  

Under FFT Settings in the control panel, RBW is selectable up to the maximum number of points in the 

sweep. A flattop window is used with zero-padding to achieve selected RBWs. The FFTs max-held to form 

this plot must all begin and end within the measurement interval. Thus, the interval must be at least the 

size of one FFT for the plot to have data. If the selected RBW is not able to be met with the measurement 

interval portion of the acquisition size, a warning message is shown with the length of time required to 

meet the RBW. 
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4.3.5.8 CCDF Plot 

 
Figure 11: Comparing synthetic noise signal to a Gaussian reference and ideal test signal. 

The Complementary Cumulative Distribution Function (CCDF) plot shows how often the signal is above 

the average signal power. The x-axis of the plot runs from 0dB above the signal mean to a user selected 

reference level. The y-axis is the percentage of time the signal appears above a specific a given 

amplitude.  

The plot can be configured to operate on a single I/Q capture or a series of I/Q captures, by selecting the 

capture mode. When the capture mode is set to continuous, the capture time control sets the 

continuous capture buffer size. New samples are shifted into this buffer and the oldest samples are 

shifted out. 

A Gaussian reference curve can be plotted which represents the ideal Gaussian distribution.  A user 

stored reference waveform can be stored by pressing the Store Ref button. This stores the active user 

trace in memory. The reference waveform is stored until the Store Ref button is pressed again. 
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4.3.5.9 Waterfall Plot 

 
Figure 12: Measuring deviation of FM signal using reference marker, with a spectrum view of peak. 

Shows the frequency spectrum of the signal over time. When an FFT sweep is selected with the marker, it 

is shown in the Waterfall Spectrum View above. The Spectrum View can be enabled and disabled from 

Preferences in the context menu. 

This plot is functionally the same as the Spectogram. 
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4.3.5.10 Channel Power Plot 

 

Figure 13: Measuring main and adjacent channels of an FM signal in Zero Span’s Channel Power plot. 

Configures and measures the channel power of a main channel and an optional adjacent channel, 

consisting of a lower and upper component. 

The plot is created by averaging FFTs across the measurement interval and taking channel power 

measurements on the resulting spectrum. FFTs default to 50% overlap but spread out if required to keep 

the number of FFTs at the configured maximum within the measurement interval. 

The configuration dialog is accessed through the context menu. Use it to set the main channel width, 

enable the adjacent channel and set its width and offset, set the maximum number of FFTs, and reset to 

the default configuration. Widths and offsets default to ¼ of the sample rate, with 100 max FFTs. 

 

Figure 14: Configuration dialog for the Zero Span Channel Power plot. 
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4.3.6 Zero-Span Recordings 
WARNING! Zero-Span recording can consume a large amount of space on your hard drive in a short 

amount of time. Caution must be exercised, particularly if you are storing waveforms on your Windows 

disk drive. See I/Q Capture: Precautions for more information. 

In Zero-Span mode, a user can save and playback a short duration I/Q waveform. Waveforms are 

recorded in a binary format, using an XML description file. The full file format is described below. 

For long term I/Q recording see I/Q Recorder. 

4.3.6.1 Recording 
I/Q captures are performed using the Record I/Q control panel in zero-span mode. This control panel 

allows you to change the capture settings of the I/Q data. The settings are described below. 

• Save Directory – The default directory for the I/Q waveform files to be stored.  

• File Prefix – Applies a file name prefix to all files saved. Useful for creating identifiable file names. 

• Capture Size – Specify the minimum capture length for a single file. 

• Max Number of Files – Specify the number of waveforms to record. 

 

Acquisitions begin by pressing the Start button located on the Record I/Q control panel. If the trigger 

type is set to No Trigger acquisitions begin immediately. If either External Trigger or Video Trigger are 

selected, the software will wait until a trigger occurs before starting acquisition. When the number of files 

to save is greater than 1, and a trigger is active, each file will require a trigger to begin acquisition. 

 

The Spike software plots do not update during acquisition, but several statistics show you the status of 

the acquisition and the current capacity remaining on the selected disk drive. 

 

4.3.6.2 Playback 
A file recorded through the Record I/Q control panel can be viewed in the software using the Playback 

I/Q control panel.  

Start waveform playback by pressing the Open File button and selecting the XML description file for the 

capture you are interested in viewing. Playback should begin immediately.  
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Figure 15: Playback I/Q control panel interface during waveform playback. 

Several tools exist for accelerating measurements during I/Q playback.  

• The I/Q scroll bar provides a preview trace for the full I/Q capture and a selectable region to 

quickly scroll through the entire waveform capture.  

• The step size control specifies the number of samples to advance each time the view is updated. 

The step size control is only applicable when no triggering is active.  

• The playback rate controls the speed at which the Spike software is updated when loading 

waveforms from the I/Q file.  

• The Single/Auto buttons can be used to step through the capture manually.  

• Enabling Video Trigger will force the Spike software to search the capture for a trigger before 

updating the plots. If no trigger is found, the capture will stop at the end of the file. 

 

4.3.6.3 Using the I/Q Playback Control Panel to Analyze a Recording in 
Spike 

To begin playback, press the Open File button. This prompts you to select the XML file of the recording 

you wish to analyze. Only one file may be open at a time. 

If Spike can open the file, you should see the playback scroll bar populated with the I/Q preview trace 

and the Playing message found below the scroll bar. 

To play through a file normally, ensure the Playing message is displayed and the Auto button is pressed 

in the toolbar and No Trigger is selected. You should see the view window in the scroll bar slide to the 

right as the contents of the file are updated in the plots. 

At any time, you can press the Single button in the toolbar to pause the playback and single step through 

the file. 
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You can also slide the view window within the scroll bar to quickly move anywhere in the file. By doing 

this you will cause the playback to be Paused and must press the Play button for the playback to 

continue. 

To video trigger on the contents of the file, ensure your video trigger is properly configured, press the 

Single button on the tool bar, ensure the file is not currently paused by pressing the play button. Then 

pressing Single should align the next capture on the next video trigger found. If no trigger is found in the 

remaining contents of the file, the plot view moves to the end of the file. 

For any mode of playback, the playback toolbar must display the Playing message or else the software 

will not update the waveform. If you see the Playing message and the software still is not updating the 

on-screen waveform, ensure you are currently not in single trigger mode. 

Looking for a trigger within a very large file may cause the software to delay several seconds or more. 

Use the scrollbar to quickly navigate to the region of interest or capture smaller files to reduce this delay. 

4.3.6.4 I/Q File Format 
Each I/Q capture is saved as two files, an XML description file, and I/Q data binary file.  

The XML file contains the acquisition settings and scale factors necessary to reconstruct the original I/Q 

waveform. The XML elements are described below. 

• DeviceType – Product name of the analyzer used in the acquisition. 

• SerialNumber – Serial number of the device used in acquisition. 

• DataType – Should be Complex Short indicating the binary format of the binary I/Q file. 

• ReferenceLevel – The reference level, in dBm, set in the Spike software for the acquisition. 

• SampleRate – Sample rate in Hz, of the I/Q waveform acquisition. 

• Decimation – Power of two integer value representing the decimation rate of the I/Q waveform 

from the full sample rate of the analyzer. (40MS/s for the BB60C/D and 486111kS/s for the 

SA44/124) 

• IFBandwidth – Cutoff frequency of the I/Q bandpass filter. 

• ScaleFactor – Used to scale the I/Q data from full scale to mW. 

• IQFileName – Full file path of the I/Q binary file saved by the Spike software. If you move the 

waveform files into another directory on your system, you must update this value to reflect the 

new location of the binary file. If you do not, the Spike software will be unable to playback the 

requested waveform. 

• EpochNanos – Nanoseconds elapsed since January 1, 1970. Often referred to as Unix time, Unix 

epoch, or Unix timestamp. The timestamp references the first sample in the I/Q waveform 

acquisition.  

• SampleCount – Number of I/Q values stored in the I/Q binary file. 

• PreviewTrace – Values used to create the waveform trace on the I/Q playback scrollbar. The 

values are created using a max hold decimation algorithm on the full I/Q waveform capture. 

 

The binary file contains SampleCount signed 16-bit I/Q values. The binary file has little-endian byte 

ordering. Samples are stored in sequential order as 

 I1, Q1, I2, Q2 … In, Qn 
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The values are stored as full scale, ranging from -32768 to +32767 representing floating point values 

between -1.0 and 1.0. To recover the original values, perform the following steps. 

1) Read in the binary file to signed 16-bit complex values. 

2) Convert the full scale 16-bit I and Q integer values into floating point values in the range of -1.0 to 

+1.0. 

3) Multiply each I and Q value by the inverse of the scale factor in the XML file. 

4) The I/Q samples should now be scaled to mW, where I2 + Q2 = mW. 

4.3.6.5 Precautions 
Precautions must be taken when performing I/Q captures to ensure your existing data does not become 

corrupted and your I/Q waveforms are captured without error. Below is a list of recommendations and 

precautions when using the I/Q record capabilities of the Spike software. 

1) Store waveforms to an external hard drive and not the operating system (OS) hard drive. If your 

OS hard drive approaches 100% capacity, you will run into issues which will prevent your OS 

from operating properly. If you absolutely must store I/Q waveforms on the same drive as your 

OS, keep 20% of the disk free. (Windows suggests 15%) 

2) Calculate the expected capture size beforehand using this simple formula. 

𝑆𝑖𝑧𝑒 𝑜𝑓 𝐶𝑎𝑝𝑡𝑢𝑟𝑒(𝐵𝑦𝑡𝑒𝑠) = 𝑆𝑎𝑚𝑝𝑙𝑒𝑅𝑎𝑡𝑒(𝑆/𝑠) ∗ 𝐶𝑎𝑝𝑡𝑢𝑟𝑒𝑇𝑖𝑚𝑒(𝑠) ∗  4 

 For example, a 5 second capture with the BB60C at the full sample rate is 

40𝑀𝑆/𝑠 ∗ 5 ∗ 4 = 800𝑀𝐵   

3) Ensure your hard drive write speed exceeds the acquisition speed of the analyzer. For many 

sample rates on BB and SM series devices, standard hard drive write speeds will be insufficient 

to sustain long term captures. This will create gaps in the data which will affect the quality of 

your measurements. A simple calculation of the record speed is  

𝑊𝑟𝑖𝑡𝑒 𝑆𝑝𝑒𝑒𝑑 (𝐵𝑦𝑡𝑒𝑠 𝑝𝑒𝑟 𝑠𝑒𝑐𝑜𝑛𝑑) = 𝑆𝑎𝑚𝑝𝑙𝑒 𝑅𝑎𝑡𝑒 ∗ 4 

It is expected the hard drive write speed exceeds this value by a reasonable margin. For some of 

the highest BB and SM series sample rates, a combination of solid-state drives and/or RAID 

configuration will be necessary. 

4) Ideally, an operator should be present at the software and monitoring the acquisition status. In 

the use case where you are capturing several triggered events over a extended time interval, 

consider performing test runs on known signals to ensure your acquisitions settings are correct 

before committing to a long acquisition process. 

4.4 HARMONIC ANALYSIS 
The harmonic measurement mode provides the ability to measure up to 10 harmonics of a specified 

carrier frequency. Each harmonic measurement consists of a sweep at the fundamental and all 

harmonic frequencies. The span, RBW, and VBW can be controlled. All harmonic sweeps are plotted 
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sequentially, and the amplitudes are reported as dBc. Total harmonic distortion is reported in the upper 

right-hand corner of the spectrum plot. 

 
Figure 16: Carrier frequency at 1MHz and 9 harmonics. 

4.4.1 Measurement Procedure 
The first sweep is performed centered at the selected Center Freq. If peak tracking is enabled, the center 

frequency measured at is the frequency of the previously measured fundamental. The frequency and 

amplitude of the fundamental is measured. The amplitude is measured using either a peak search or 

channel power, depending on the Meas Type selection. When channel power is selected, the frequency is 

measured using the center of the 90% occupied bandwidth. 

All subsequent harmonics are measured at multiples of the measured fundamental frequency. The 

amplitudes are measured in the same way and stored as dBc. 

The spectrum plot and harmonic list are updated as the harmonic measurements are performed. 

Measuring and plotting all harmonics is considered a single measurement.  

4.4.2 Harmonic Controls 
• Center Freq – The center frequency of the fundamental measurement.  

• Step – Controls the frequency step of the arrows on the Center Freq control. 

• Span – The measurement span used at each harmonic. 

• RBW – The measurement RBW used at each harmonic. 

• VBW – The measurement VBW used at each harmonic. 

• Input Level – The maximum expected input level. It is recommended to set this value to 5 

dB above the maximum expected input level. 
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• Disp Ref – The displayed reference level of the spectrum plot. 

• Div – Vertical spectrum plot division height. 

• Harm Count – Number of harmonics to measure and plot. 

• Meas Type – Select the measurement type at each harmonic. When peak is selected, a 

peak search is performed to find the frequency and amplitude of each harmonic. When 

channel power is selected, a channel power measurement is used to find the amplitude 

and occupied bandwidth measurement is used to find the frequency of each harmonic. 

• Trace Type – Select the trace behavior. 

• Pk Tracking – When enabled, the fundamental frequency is measured at the previously 

measured fundamental frequency. When any setting is changed, the tracking center 

frequency is reset to the selected Center Freq.  

4.5 SCALAR NETWORK ANALYSIS 
If a BB or SA-series spectrum analyzer and tracking generator are both connected to the PC, select 

Analysis Mode > Scalar Network Analysis in the file menu. Scalar network analysis is used to measure the 

insertion loss of a device such as a filter, attenuator, or amplifier across a range of frequencies. This 

mode, when used with a directional coupler, can also measure return loss.  

 

 
Figure 17 The SA44B and TG44A sweeping a passive bandpass filter. 

To learn more about scalar network analysis and how the Signal Hound devices perform this task, please 

refer to the Signal Hound Tracking Generator user manual. 
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Ensure the TG sync port on the tracking generator is connected to the Sync Out port on the SA series 

spectrum analyzer. 

4.5.1 Scalar Network Analysis Control Panel 
4.5.1.1 Tracking Generator Settings 

• Sweep Type – Specify whether an active or passive device is being swept. This will affect 

the attenuation and gain used during the sweep. Failing to properly set this value may 

result in reduced dynamic range or IF overload. 

• Sweep Size – Specify a suggested sweep size. The final sweep size is affected by this 

suggestion as well as hardware limitations. 

• High Range – If high range is selected, the software will optimize the sweep for dynamic 

range when a 20dB pad store through is performed. Sweep speed will increase when 

unselected at a penalty of lower dynamic range. 

• Store Thru – Press this button to normalize the sweep on the next acquired sweep. This 

may be re-pressed in the event a poor normalization occurred. 

• Store 20dB Pad – Perform a normalization when a 20dB pad is inserted in the RF path. 

Should only be performed after a normal “Store Thru”. 

4.5.1.2 Frequency Settings 
• Center – Specify the center frequency of the sweep. If a change in center frequency causes 

the start or stop frequencies to fall outside the range of operation, the span will be 

reduced. Using the arrows changes the center frequency by step amount. 

• Span – Specify the frequency difference between the start and stop frequencies centered 

on the center frequency. A reduced span will be chosen if the new span causes the start or 

stop frequencies to fall outside the range of operation. Use the arrows to change the span 

using a 1/2/5/10 sequence. 

• Start/Stop – Specify the start and stop frequency of the device. Frequencies cannot be 

chosen that are outside the range of operation of the active device. 

•  Step – Specify the step size of the arrows on the center frequency control. 

4.5.1.3 Amplitude Settings 
• Plot VSWR – Plot the return loss as VSWR.  

• Ref Level – Specify the displayed reference level of the plot. Changing this value causes the 

display to update immediately and does not affect the calibration status of the 

measurement. Specified as dB or SWR depending on whether Plot VSWR is selected. 

• Div – Specify the vertical plot divisions. When plotting VSWR, the graticule ranges from 1.0 

at the bottom of the plot, to 1.0 + 10 * div at the top. When plotting on a log scale the 

graticule will range from Ref Level at the top of the plot and Ref Level – 10*div at the bottom 

of the plot. 
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4.5.2 Measurements Control Panel 
See Measurements Control Panel in Swept Analysis mode. 

4.5.3 Configuring Scalar Network Analyzer Sweeps 
The controls for Frequency, Amplitude, and Tracking Generator are used to configure sweeps, as follows:  

• Use the Frequency controls to configure the desired center frequency and span. 

o For most devices, a start frequency of >250 kHz and a span of >100 kHz is 

recommended. This maximizes dynamic range, sweep speed, and accuracy. 

o  (SA44/SA124 only) For crystals or other very high Q circuits with a bandwidth of 50 

Hz to 10 kHz, select a span of 100 kHz or less. A slower narrow-band mode will be 

automatically selected. In this mode, a 100-point sweep takes about 7 seconds, but 

the sweep updates at each point. 

• Use the Amplitude controls to set the Reference Level, a good starting value is +10 dB. 

• Using the Tracking Generator Controls: 

o Select the desired sweep size. A 100-point sweep is a good starting point.  

o If measuring an amplifier, select Active Device 

o Leave High Range checked unless faster sweeps are needed at the expense of 

dynamic range.  

o If accurate measurements are needed below -45 dB, use the default settings of 

Passive Device and High Range. 

4.5.4 Performing Sweeps 
Before accurate measurements can be made, the software must establish a baseline, something to call 0 

dB insertion loss. In the Spike software, this is accomplished by clicking Store Thru. 

1. Connect the tracking generator RF output to the spectrum analyzer RF input. This can be 

accomplished using the included SMA to SMA adapter, or anything else the user wants the 

software to establish as the 0-dB reference (e.g. the 0-dB setting on a step attenuator, or a 20dB 

attenuator in an amplifier test setup). 

2. Click Store Thru and wait for the sweep to be completed. The sweep should be normalized at 0 

dB when this process is completed. At this point, readings from 0-dB to approximately -45 dB are 

calibrated. 

3. (Optional) If accurate measurements are needed below -45 dB, insert a fixed SMA attenuator, 

and then click Store 20 dB Pad. The actual attenuation value does not matter, but it must 

attenuate the signal from the TG by at least 16 dB and not more than 32 dB. This corrects for any 

offsets between the high range and low range sweeps, giving accurate measurements down to 

the noise floor. 
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4. Insert the device under test (DUT) between the tracking generator and the spectrum analyzer 

and take measurements. All traces and markers are accessible during the network analyzer 

sweeps. 

Note: Changing the sweep settings (frequency, amplitude, etc.) will require repeating steps 1-4. 

4.5.4.1 Improving Accuracy 
One shortcoming of the Signal Hound tracking generators is poor VSWR / return loss performance.  

However, this can be easily overcome by adding good 3 dB or 6 dB pads (fixed SMA attenuators) to the 

output of the tracking generator and / or the input of the spectrum analyzer.  A good 6dB pad will 

improve return loss by nominally 12dB to >20dB and should enable accurate measurements.  These 

may be included when sweeping the "thru," effectively nulling them out. This will decrease the overall 

dynamic range. 

4.5.4.2 Testing High Gain Amplifiers 
When measuring an amplifier that will have a gain of 20 to 40 dB, the use of a 20-dB pad is required. 

Insert the 20dB pad before the Store Thru and leave the pad on either the SA or TG when connecting to 

the amplifier. For amplifiers with more than +20 dBm maximum output, the pad should go on the 

output of the amplifier. If an amplifier cannot safely handle -5 dBm, place the pad on the amplifier’s 

input.  

4.5.5 Measuring Return Loss 
A directional coupler of appropriate frequency range (sold separately) may be used to make return loss 

measurements. 

• Connect the tracking generator to the directional coupler’s "OUT" port. 

• Connect the spectrum analyzer to the directional couplers "COUPLED" port. 

• Use the "IN" port as the test port. Leave it open (reflecting 100% of power). 

• If a cable is used between the test port and the antenna, connect it to the IN port but leave 

the other end of the cable open. 

• Click Store Thru. The sweep should be normalized to 0 dB. 

• Connect the device under test (e.g., antenna) to the "IN" port or cable.  Return loss will be 

plotted. 

Once again, measurement accuracy will benefit from 3 to 6 dB pads on the Signal Hound devices prior to 

Store Thru.  This method is not as accurate as using a precision vector network analyzer, but with a good 

directional coupler, accuracy within a few tenths of a dB is typical.  

4.5.5.1  Adjusting an Antenna 
To adjust an antenna for a certain frequency, use the Return Loss setup, above.   Lengthen, shorten, and 

tweak impedance matching elements until the desired return loss is achieved.  Be aware that you will be 

radiating some RF during this process.  It is your responsibility to understand and obey the laws 

regarding transmitting on those frequencies. 
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4.5.6 Levels Used in Sweeps 
This section covers the amplitudes used by the tracking generator for the various sweep configurations 

available in the Scalar Network Analysis mode. 

If High Range is disabled, the tracking generator sweeps the specified frequency range at -30dBm. 

If High Range is enabled, the tracking generator sweeps at 2 levels, once at -30dBm, followed by another 

sweep at -10dBm. These two sweeps are used to generate a single measurement (sweep) in the Spike 

software. 

If Passive Device is selected, the analyzer will expect the signal to be at or below the tracking generator 

output power (no amplification) 

If Active Device is selected, the analyzer will allow up to 20dB of amplification. 

If you exceed the analyzer’s expected input level, the analyzer can be overdriven resulting in an invalid 

measurement. 

If you need additional amplification, add an attenuator in the signal chain.  

4.5.7 Manual Tracking Generator Sweeps 
To test devices with bandwidths below 50 Hz (e.g., 60 Hz notch filter), or if more than 90 dB of dynamic 

range is needed, do not use Scalar Network Analysis mode. Instead, stay in Swept Analysis mode and 

use Utilities→Tracking Generator Controls to set the tracking generator to a CW frequency output. 

Use Peak Search and Delta to establish relative amplitude, then insert the DUT and manually tune the TG 

across a narrow range of frequencies. A TG output of -10 dBm combined with an RBW of 10 Hz should 

give around 130 dB of dynamic range for most frequencies.  Care must be taken in cable and device 

placement to avoid crosstalk.  

4.6 PHASE NOISE MEASUREMENTS 
You can use the phase noise measurement mode to measure single side band (SSB) phase noise of an 

input RF signal. Phase noise can be measured using any single Signal Hound spectrum analyzer, or by 

using the PN400 phase noise test system. To learn more about making measurements with the PN400 

phase noise test system, see the section on cross-correlation.  
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Figure 18: SM200B measuring the phase noise of a VCO at 8GHz. 

4.6.1 Measurement Theory 
This section describes phase noise measurements made with a single spectrum analyzer. For 

measurements made using the PN400 phase noise test system, see the section on cross-correlation. 

The phase noise measurement requires a fixed CW input into the analyzer. If at any point the input 

signal is removed, the measurement updates will stop, and a warning will be displayed on the phase 

noise plot. 

When configuring a new measurement, a coarse frequency estimate must be made. The coarse 

frequency estimate of the input signal can be measured automatically using the signal search function or 

manually entered in the carrier frequency setting. Once a coarse frequency estimate is made, a fine 

frequency and amplitude estimate is performed. This provides the measurement configuration for the 

phase noise measurement itself. A fine estimate is performed prior to every phase noise measurement 

to ensure optimal settings are always used in the event of signal drift. 

The phase noise measurement is performed directly using an FFT approach. Either phase noise, AM 

noise, or the combination of both can be measured. The resulting sweep contains 100 points per 

decade. Each phase noise measurement result is used to update the user configured traces and trace 

measurements. 
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Figure 19: Measurement Flow Graph 

4.6.2 Cross-Correlation 
Using the PN400 adapter and 2 SM200/435 spectrum analyzers, Spike can perform cross-correlated 

phase noise measurements improving the sensitivity of the measurement by up to 35dB over the base 

SM phase noise performance.  

 
Figure 20: Cross-Correlation Measurement at 3.7GHz Carrier Frequency 

To enable cross-correlation, follow these steps, 

1) Connect your equipment according to the diagram below. Optionally connect a shared 10MHz 

reference or 10MHz reference output from the DUT to the 10MHz reference input to the SM 

devices if external reference is desired. 

2) In the phase noise measurement mode, connect to both the PN400 and second SM analyzer 

using the controls found in the configuration control panel. 
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3) (Optional) Configure the VCO supply and tuning voltages if measuring a VCO. 

4) Enable cross-correlation. 

 

 

Figure 21: Typical Cross-Correlation Setup Using the PN400 Adapter.  

4.6.2.1 Measurement Theory 
This section covers cross-correlated phase noise measurements. For non-correlated phase noise 

measurements, see Measurement Theory. 

Cross-correlation is a method which can improve the phase noise measurement performance of any 

single device by making a simultaneous measurement on a second device and using signal processing to 

achieve these performance gains. The more cross-correlations that can be performed, the better the 

noise floor improvement. Spike uses a direct FFT method, which results in the ability to perform more 

correlations at wider offsets. The number of correlations is displayed for each decade. 

Cross-correlation improves performance by a factor of  

5 ∗ 𝐿𝑜𝑔10(# 𝑜𝑓 𝑐𝑜𝑟𝑟𝑒𝑙𝑎𝑡𝑖𝑜𝑛𝑠) 

Below is a table of expected performance improvements based on correlation count. 

Correlation Count Gain (dB) 

10 5 

100 10 



Analysis Modes | Phase Noise Measurements 
  

52 

1,000 15 

10,000 20 

100,000 25 

1,000,000 30 

10,000,000 35 

 

Below is the measurement flow graph. The main difference from non-correlated measurements is that 

once the maximum correlations have been achieved the measurements stop and the user must 

manually restart a correlated measurement. Any change to the measurement settings will automatically 

restart the measurement. 

 
Figure 22: Cross-Correlation Measurement Flow Graph 

The Spike software limits the number of correlations to for each offset. Once the maximum number of 

correlations have occurred at a given offset, processing for that offset stops, but will continue for the 

other offsets. Maximum correlations occur for wider offsets faster than close in offsets. 

4.6.2.2 Reference 
For the best results, both SM analyzers should use the same reference clock. Below is a short description 

of the possible reference settings. This setting overrides the Spike reference setting in the Settings -> 

Reference menu. 

• Int Ref – Both devices use their internal 10MHz references. A configuration step attempts 

to get these clocks to match as closely as possible. 

• Ext Ref – Both devices use an external 10MHz reference. Preferably one that it shared with 

the DUT, or one that the DUT is providing directly.  

• RF Ref – The input RF frequency is used to discipline the 2 SM devices. When RF ref is 

selected, signal search is bypassed and the entered Signal Freq is used.  
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4.6.2.3 Gain Indicator 
The gain indicator is the gray region located below the trace when cross-correlation is enabled. It 

represents the ideal trace location if the full performance gain of cross-correlation was realized. As the 

number of correlations is increased, if the gain indicator improves significantly faster than the measured 

trace (or the measured trace no longer improves), it would indicate additional correlations are not 

providing additional benefit. It is up to the customer to determine how much separation between 

measurement trace and gain indicator must be present to feel confident in the resulting measurement. 

 
Figure 23: The separation near "A" would indicate we are adequately measuring the DUT at this frequency offset. The lack of separation at "B" 

indicates either additional correlations are needed, or this measurement performance is out of range for this DUT (if we are already at max 

correlations). 

4.6.2.4 Measuring Near Cardinal Frequencies 
Spurious signals can appear when measuring near or at 100MHz multiples while taking advantage of 

cross-correlated phase noise measurements. Using an external reference that is shared between the SM 

devices and DUT, or using RF Ref can reduce or remove these mixing spurs. 

4.6.3 Phase Noise Control Panel 
This control panel appears when the measurement mode has been changed to Phase Noise. These 

settings control the acquisitions parameters of the sweep, trace and marker outputs, and jitter 

measurement configuration.  

4.6.3.1 Frequency Settings 
• Signal Freq – When signal search is disabled, this value will be used for the coarse 

frequency estimate. 

• Peak Tracking – When enabled, small drifts in the signal frequency will be tracked during 

the fine estimation procedure. 
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• Ampl Thresh – Specify the minimum detected carrier level needed to perform a phase 

noise measurement. If this threshold is not met, the software will continue to look for a 

valid carrier frequency. 

• Signal Search – When enabled, the input frequency of the signal is estimated using a wide 

band sweep between the search start and stop frequencies. This sweep can take significant 

time for slower Signal Hound spectrum analyzers, and manually entering the input 

frequency may be desired when known. 

• Search Start – Start frequency used for automatic signal search. Ignored if signal search is 

disabled. 

• Search Stop – Stop frequency used for automatic signal search. Ignored if signal search is 

disabled. 

4.6.3.2 Sweep Settings 
When using the SA44/SA124, the start/stop offsets can drastically affect measurement speed. See the 

section on measurement speed for more information. 

• Meas Type – Selects between phase noise, amplitude noise, or both for what to measure 

and display. 

• Start Offset – Select the first decade to be measured and plotted.  

• Stop Offset – Select the last decade to be measured and plotted.  

4.6.3.3 View Settings 
These settings control the vertical range of the phase noise plot. The total vertical range of the plot can 

be calculated as, 

[𝑀𝑎𝑥, 𝑀𝑖𝑛]  =  [𝐷𝑖𝑠𝑝𝑅𝑒𝑓, 𝐷𝑖𝑠𝑝𝑅𝑒𝑓 −  𝐷𝑖𝑣 ∗  𝑁𝑢𝑚𝐷𝑖𝑣𝑠] 

• Disp Ref – Specify the displayed reference level as dBc/Hz. 

• Div – Specify the plot division height in dB. 

• Num Divs – Specifies the number of vertical plot divisions.  

4.6.3.4 PN400 
These settings are used to connect and control the PN400 accessory. 

The limits are used to constrain the Vsupply and Vtune settings. When out of range voltages could 

damage the VCO, it is best practice to set the limits prior to settings the voltages to prevent accidental 

entries. 

• Connect – Used to connect to the PN400 over USB. An attempt to discover and connect the 

PN400 is made when entering phase noise measurements. It is only necessary to manually 

connect when the PN400 is connected to the PC via USB after phase noise measurements 

have started. 

• Load Defaults – Revert all voltage output values to their defaults. 

• Vsupply – Specify the supply voltage. 
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• Vsupply Limit Min – Specifies the lower limit on the Vsupply setting.  

• Vsupply Limit Max – Specifies the upper limit on the Vsupply setting. 

• Vtune – Specify the tuning voltage. 

• Vtune Limit Min – Specifies the lower limit on the Vtune setting. 

• Vtune Limit Max – Specifies the upper limit on the Vtune setting. 

• Output Enabled – Enables the Vsupply and Vtune on the PN400 using the user entered 

Vsupply and Vtune values. 

4.6.3.5 Cross Correlation 
• Connect 2nd Analyzer – Used to connect to another SM device required for cross 

correlation measurements. 

• Status – Shows status of second SM device connection. Must be connected to enable cross 

correlation. 

• Enabled – Enables cross-correlated measurements. Requires second SM device and PN400 

to be connected before enabling. 

• Reference – Select the timebase reference of the cross-correlated test system. This setting 

overrides any individual reference setting. See the cross-correlation section for more 

information. 

• XCorr Factor – Sets the number of cross-correlation processing steps to occur before the 

measurement stops. Each processing step represents a specific number of correlations per 

decade. 

• Gain Indicator – Enable/disable the gain indicator display on the plot. 

• Counts Visible – Enable/disable the display of the cross-correlation amounts per decade 

on the plot. 

4.6.3.6 Trace Settings 
• Trace – Select the active trace. All other trace settings apply to this active trace. 

• Type – Select the active trace type.  

o Off – Trace disabled/not displayed. 

o Normal – Trace is overwritten with each new measurement. 

o Averaging – Up to “Avg Count” successive traces are averaged together. Averaging 

occurs in dBc/Hz units. 

o Reference – Trace does not update with each new measurement. Current trace is 

held. 

o Max Hold – A max hold detector is applied with each new measurement. The 

detector occurs for each frequency bin. 

o Min Hold – A min hold detector is applied at each frequency bin with each new 

measurement. 

• Avg Count – When trace averaging is enabled, set the number of traces that are averaged 

together to create the output trace. 

• Update – Stops the update of this trace. Similar functionality to Reference trace. 

• Hide – Hides the display of the trace on the plot. Depending on settings, will continue to 

update while hidden. 
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• Smoothing – When enabled applies a smoothing window to the trace. The window length 

is controlled by the smoothing aperture. 

• Smooth Aperture – Controls the window size for the smoothing window. Larger window 

sizes improve smoothing at the expense of accuracy. 

• Hide Spurs – When enabled a spur reject algorithm attempts to remove spurs from the 

trace. 

• Spur Threshold – Threshold determination for the spur rejection algorithm. The spur must 

rise this amount above neighboring bins to be considered a spur. 

• Offset – Applies a fixed dB offset to the measurement. All trace measurements, including 

smoothing, spur reject, markers, and jitter occur on the offset trace. 

• Move To – Move the current trace to the trace selected. That trace will then become a 

reference trace. 

• Export – Export the current trace to a CSV file. 

• Clear – Clears any accumulated averaging or min/max held results. 

4.6.3.7 Marker Settings 
• Marker – Select the active marker. All other marker settings apply to the active marker. 

• Trace – Specify which trace the marker is placed on. 

• Enabled – Enable/disable the marker. 

• Delta Marker – Toggle the delta marker measurement. A reference marker is placed at the 

current marker position when the delta measurement is enabled. 

4.6.3.8 Jitter Settings 
• Enabled – When enabled, the integrated RMS jitter calculation is performed and displayed 

on the graticule. 

• Trace – Specify which trace the jitter measurement is performed on. 

• Meas Start – Specifies the start frequency of the integrated RMS jitter calculation. 

• Meas Stop – Specifies the stop frequency of the integrated RMS jitter calculation. 

4.6.4 Vibration 
Mechanical vibration can impact phase noise performance in oscillators. Vibration can negatively affect 

both the DUT and Signal Hound spectrum analyzers. Mechanical isolation might be necessary for 

sensitive measurements, especially from things like fans, keyboards, etc. 

4.6.5 Measurement Speed (SA44/SA124 only) 
Sweep speed is greatly affected by the start and stop frequency. The following configurations have the 

largest effect on sweep time. 

- Start frequencies at 10Hz and 100Hz. This affects all devices and can add 10+ seconds to the 

sweep time. 

- A stop frequency of 10MHz decreases sweep speed dramatically for the SA44/SA124 devices. 

This can add 25 seconds to the sweep time. 
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Any changes to the configuration will not be applied until after the current sweep is performed. 

Additionally, other actions such as changing the measurement mode or closing the software will not take 

place until the current sweep is finished. 

4.7 DIGITAL DEMODULATION 
In this mode, users can measure modulation quality such as EVM, magnitude, and phase error, and 

characterize impairments such as I/Q offset, amplitude droop, and group delay via equalization filters. 

The Spike software allows the demodulation of PSK, QAM, ASK, FSK, and custom constellation patterns 

using several standard filter types. 

4.7.1 Digital Demodulation Control Panel 
4.7.1.1 Demod Settings 

• Center Freq – Specify the carrier frequency of the modulated signal. 

• Freq Step – Specify the step size applied when using the center frequency arrays. 

• Input Power – Specify the maximum expected input power of the input signal.  

• Sample Rate – Specify the symbol rate of the modulated input signal.  

• Result Len – Specify the number of symbols in the measurement. 

• Modulation – Specify the modulation format of the input signal. See the symbol mappings for 

each of the supported schemes in the Appendix: Constellation Mappings. 

• Edit Custom Mod – Bring up the constellation editor. See Custom Modulations. 

• Source Filter – Specify the filtering to be performed by the demodulator. See Selecting the 

Measurement Filter for more information. 

• Filter Alpha – Specify the bandwidth coefficient of the measurement filter. See Selecting the 

Measurement Filter for more information. 

• Auto IF Bandwidth – Specify whether the software selects an IF bandwidth automatically based 

on configuration. If automatic bandwidth is selected, the bandwidth is chosen as 2 times the 

symbol rate. 

• IF Bandwidth – Specify the width of an IF bandwidth filter to be applied before demodulation. 

This filter is used to reject out of band interference or adjacent channels. 

• I/Q Inversion – Specify whether to swap I/Q channels before demodulation occurs. 

• Averaging – When checked, measurement averaging occurs. 

• Average Count – Select the average count for the modulation quality metrics on the error 

summary panel. 

• Pts/Sym – Displays the samples per symbol or oversample rate. Not selectable. 

• I/Q Offset – When enabled, removes the I/Q offset prior to the error calculations. 

• Ampl Droop – When enabled corrects any linear amplitude error prior to the error metric 

calculations. 

4.7.1.2 Wide Carrier Estimation 
See Wide Carrier Estimation for more information. 
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• Enabled – Enables wide carrier estimation. 

• Range – Sets the wide carrier estimation search window. 

4.7.1.3 Trigger Settings 
These settings affect the trigger used to frame the result/search window. 

• Trigger Type – Specify the trigger source.  

• Trigger Level – Specify the video trigger level. The measurements will occur once this amplitude 

threshold has been met.  

• Trig Delay – Specify the number of symbols to delay the measurement by after a video or 

external trigger.  

4.7.1.4 Sync Search 
See Sync Search for more information. 

• Enabled – When enabled, pattern sync search occurs within the measurement results. 

• Pattern (Hex) – Specify the sync search pattern. 

• Pattern Length – Specify the number of symbols in the sync pattern. The pattern bits are 

specified in the Pattern entry. If the number of bits in the pattern entry are greater than the 

number of bits necessary to meet the length specified, then the least significant bits are used. If 

the pattern is shorter than the length specified, then the pattern is padded with zeros to reach 

the number of symbols specified. 

• Search Length – Specify the size of the search window in symbols. The pattern will be searched 

for within this window. 

• Offset – Number of symbols to offset the result window from the start of a successful sync 

search. 

4.7.1.5 Equalization 
See Equalization for more information. 

• Enabled – Enables adaptive equalization. 

• Filter Len – The filter length in symbols.  

• Convergence – Adaptation rate of each adaptive step. 

• Hold – When enabled, stops adapt steps. 

• Reset Filter – Resets the filter kernel to the unit impulse response. 

4.7.2 Digital Demodulation Toolbar 
This toolbar provides several controls to help the user customize the view layout. 

• Add Measurement – This control allows a user to add to the view area one of many 

default data views. 

• Auto Fit – When Auto Fit is selected the visible views will be auto scaled to fit the available 

application space. Disabling Auto Fit allows a user to scale and move the views into a 

custom configuration without the software interfering. 
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• Choose Setup – Select from several default configurations. 

4.7.3 Selecting the Measurement Filter 
It is possible to specify a baseband filter to be applied to the received data. Specifying the correct filter is 

necessary to demodulate the system under test. Below is a table of the possible configurations that the 

software provides. 

Selected Source Filter Meas. Filter Used Ref. Filter Used 

Raised Cosine None Raised Cosine 

Root Raised Cosine Root Raised Cosine Root Raised Cosine 

Gaussian None Gaussian 

Rectangular None Rectangular 

 

A user must also select the filter bandwidth, sometimes referred to as the filter alpha. If the 

measurement filter is root raised cosine, then the filter alpha of the transmitter filter must be provided to 

produce accurate demodulation. 

All filters used have an impulse length of 32 symbols. 

When the rectangular filter is selected, the sidelobes generated by the rectangular filter on the reference 

waveform are filtered out. Only the main lobe is present in the reference waveform. A filter cutoff equal 

to the sample rate is used. Put another way, the bandwidth of the I/Q baseband reference waveform 

after this filter is applied is 2 times the sample rate.  

4.7.4 Custom Modulations 
Spike can demodulate custom constellations. These constellations can be configured in the constellation 

editor. The custom constellations must adhere to the following rules. 

• The number of symbols must be a power of two. 

• The constellation must be symmetric about a 180, 90, 45, or 22.5-degree angle. 

• The constellation cannot have duplicate points. 

Differential encoding is not customizable with the constellation editor, nor is any I or Q time offsets (i.e. 

OQPSK). Any currently configured custom modulation is stored in the user presets. If the custom 

modulation is not valid, the measurement defaults to QPSK. 

4.7.4.1 Constellation Editor 
The constellation editor can be opened with the Edit Custom Mod button on the digital demodulation 

control panel. 

I/Q values can be entered directly in the symbol table. The constellation plot shows the currently entered 

I/Q values. For loading a large constellation, it is recommended to load a formatted CSV file.  
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• Add Symbol – Inserts a new symbol row at the end of the symbol table. 

• Remove Symbol – Removes the row of the currently selected cell. If no cell is selected, the 

last row is removed. 

• Load Default I/Q Map – Selects and populates the constellation table with a default 

selection 

• Define APSK Mod – Opens the APSK Editor  

• Load – Load a formatted CSV file containing a saved custom constellation. 

• Save – Save a formatted CSV file describing the custom constellation. 

• Clear Table – Remove all symbols. 

• Accept – Verifies the constellation and if the constellation is valid, stores the constellation 

as the active custom modulation. 

 
Figure 24: APSK32 in the constellation editor. 

4.7.4.2 APSK Editor 
The APSK editor can be opened with the Define APSK Mod button in the Constellation Editor. 

There are four parameters that are used to define each APSK ring. They can each be manually edited in 

the table found in the APSK editor. 

• Ring ID – ID number where 0 is the inner most ring 
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• # States – The number of symbols represented in this ring 

• R#/R0 – The ratio of the radius of this ring to the inner most ring(R0) 

• Phase – The phase offset of the first state in this ring 

Some of the addition controls for the APSK Editor are described below. 

• Load Default I/Q Map – Selects and populates the constellation table with a default 

selection 

• Add Row – Adds another ring to the table 

• Remove Row – Removes the last ring from the table 

• Load – Loads a previously APSK configuration  

• Save – Saves the current configuration to a csv 

• Accept – Validates that the total number of states is a power of 2, stores the data, and 

closes the window 

 
Figure 25F: APSK32 in the APSK editor. 

4.7.5 Wide Carrier Estimation 
When enabled, wide carrier estimation performs an additional search step over a custom frequency 

range. This allows for demodulation of signals with large carrier frequency error. This additional step is 

implemented as a sweep prior to demodulation using the user specified range as the sweep span. An 

occupied bandwidth measurement is performed, and the center frequency of the estimated occupied 

bandwidth is used as the new center frequency of the demodulation measurement. This step is 

performed prior to each demodulation measurement.  

The range should be set to at least two times the maximum expected frequency error plus half the signal 

bandwidth.  

𝑅𝑎𝑛𝑔𝑒 =  2 ∗  (𝐶𝐹𝑒𝑟𝑟𝑜𝑟  +  
𝐵𝑊

2
) 
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4.7.6 Sync Search 
When sync search is enabled, demodulation occurs over a duration of search length symbols (user 

selected). The sync pattern is then searched for within this search length. If the sync pattern is found, the 

position of the first symbol that matches the pattern is used to frame the measurement. An additional 

offset can be applied to this framing. See the diagram below. 

Search length must be longer than measurement length. The measurement is not allowed to go beyond 

the search length. Ideally, search length would be much larger than the measurement length. If the 

offset adjusts the result outside the search window, the sync pattern is considered not found. 

Sync search can be used in combination with triggering. When performing sync search on pulsed 

waveforms, ensure the search length does not exceed the pulse duration, as demodulation occurs over 

the entire search length. For example, if the pulse duration is 512 symbols, search length should be no 

more than 512 symbols, thus limiting your result length to less than 512.  

If the search pattern occurs more than once in the search length, only the first occurrence is considered. 

If the search pattern is not found, “Pattern Not Found” will be displayed on the demod bits plot. 

 
Figure 26: This diagram illustrates how sync search is performed and how the measurement is framed within the search length. 
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4.7.7 Equalization 

 
Figure 27: Characterizing a QAM64 waveform over a heavily impaired channel using equalization. 

Equalization is used to measure and correct for the amplitude and phase frequency response (group 

delay) over the measurement channel due to fading, multi-path, reflections, or system components such 

as filters, amplifiers, etc. This allows some linear effects/impairments to be removed from the system 

isolating non-linear errors. 

Equalization is only available for PSK and QAM modulation formats. 

The Spike software uses a complex adaptive LMS FIR filter to perform adaptive equalization. The 

adaptation step is performed on the measured and reference waveforms and the filter weights output 

from the adaptation step are applied to the I/Q data on the next measurement prior to symbol lock, 

carrier recovery, and demodulation. 

Since equalization is performed blind (no training sequence), large EVM and bit errors may cause the 

equalization filter to have difficulty adapting and converging. 

It is important to ensure the frequency error of your signal is a small percentage of the symbol rate. We 

recommend a 1% frequency error or less. Small equalization filters will be more resistant to frequency 

errors. We recommend tuning the analyzer to an ideal center frequency before running equalization.  
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When the filter is reset, the filter is initialized with the unit impulse response. Below is a list of conditions 

on which the equalization filter is reset. 

• Program startup 

• Leaving and entering the digital demodulation measurement mode. 

• The measurement filter is changed. 

• Symbol rate has changed. 

• Equalizer filter length is changed. 

• The reset filter button is pressed.  

The filter length is calculated by the equation, 

• Tap count = (User Selected Filter Length – 1) * Pts/Sym + 1 

The convergence factor selected by the user is scaled by a normalization factor of 1.0e-6. Larger 

convergence values allow the equalizer to adapt faster to the current channel conditions but is more 

susceptible to noise and may cause the filter to become unstable. Smaller convergence values cause the 

equalization filter to adapt more slowly to the channel but resist noise and other non-periodic 

fluctuations in the signal. 

We recommend starting with values between 1-100 to converge quickly on the channel conditions and 

reducing the convergence factor as EVM improves. 

If at any point the filter becomes unstable, it will no longer be applied to the measurement data and will 

wait for the user to reset the filter. You can see when a filter is unstable on the equalization plots. 

The equalizer filter impulse, frequency response, and phase response can be viewed using the equalizer 

plots. 

The equalizer filter impulse response can be exported in the context menu of the equalizer impulse 

response plot.  

4.7.8 High Order QAM Signals 
This section contains a few tips for making measurements with high order QAM modulations. 

• The measurement length should be 2-4 times the modulation order. For example, when 

measuring 256QAM signals, use between 512-1024 symbols. 

• Ensure there is adequate randomness in the symbols/data. Ideally, all symbol points will be 

hit in a measurement indicating a random bit sequence. 

• Ensure the frequency error is small. Even a small center frequency error will cause invalid 

measurement results. User lower order modulations to measure and offset for frequency 

beforehand or use a common timebase where applicable. 

• Measurements can take several seconds up to 1 minute for large captures with high order 

QAM. Once the measurement has started, it must finish before accepting new 

configuration changes. Where possible ensure all other settings are correct before selecting 

the high order QAM modulation. 
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4.7.9 Customizing the Display 
Spike allows a user to add and organize the measurement displays. The displays can be added to the 

main view area by selecting the “Add View” combo box on the toolbar and selecting the measurement 

displays. If “Auto Fit” is enabled, the view is added to an organized grid of views. If Auto Fit is disabled, 

then the user can move and resize the view to their liking. The view organization is saved when the 

application is closed and restored on the next program invocation. 

All plots in digital demodulation mode adhere to the basic plot interface in Spike.  

4.7.9.1 Error Summary 
The Spike software provides an error summary read-out which displays modulation quality metrics such 

as error vector magnitude (EVM), phase error, magnitude error, and frequency error. These error values 

are used to measure signal characteristics and quality. Most error values are provided as a peak and 

RMS average value taken over a sample size chosen by the user. The error value is first averaged over 

the capture interval at each symbol, and then peak held and RMS averaged to generate the displayed 

values. For peak symbol error values over a single 

capture, see the Error vs Time plots.  

Modulation quality metrics are described below. 

EVM is a common way to measure the quality of a 

communication system. EVM is defined as the root mean 

square (RMS) of the error vectors. It is calculated in the 

Spike software as 

%𝐸𝑉𝑀 =
√1

𝑁
∑ (𝐼𝑒𝑟𝑟𝑜𝑟

2 + 𝑄𝑒𝑟𝑟𝑜𝑟
2)𝑛−1

0

𝑁𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑎𝑡𝑖𝑜𝑛 𝑅𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒
 ∗ 100% 

Magnitude error is defined as 

𝑀𝑎𝑔𝑛𝑖𝑡𝑢𝑑𝑒 𝐸𝑟𝑟𝑜𝑟[𝑛] =  
|𝑀𝑎𝑔𝑟𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒[𝑛]| −  |𝑀𝑎𝑔𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑[𝑛]|

𝑁𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑎𝑡𝑖𝑜𝑛 𝑅𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒
 

for each symbol. The RMS average and peak are calculated using all magnitude measurement errors for 

the given capture window. 

Phase Error is defined as 

𝑃ℎ𝑎𝑠𝑒 𝐸𝑟𝑟𝑜𝑟[𝑛] =  𝐴𝑛𝑔𝑙𝑒𝑟𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒[𝑛]  − 𝐴𝑛𝑔𝑙𝑒𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑[𝑛] 

FSK Error is defined as 

𝐹𝑆𝐾 𝐸𝑟𝑟𝑜𝑟 =
𝑅𝑀𝑆(𝐹𝑆𝐾 𝐸𝑟𝑟𝑜𝑟 𝑎𝑡 𝑒𝑎𝑐ℎ 𝑠𝑦𝑚𝑏𝑜𝑙)

𝐷𝑒𝑣𝑖𝑎𝑡𝑖𝑜𝑛
 

Figure 28: Visualization of the EVM, Magnitude and Phase 

Error Calculations 
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where the error at each symbol is 

𝐹𝑆𝐾 𝐸𝑟𝑟𝑜𝑟 𝑎𝑡 𝑆𝑦𝑚𝑏𝑜𝑙 𝑖 = 𝐹𝑆𝐾 𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑑[𝑖] − 𝐹𝑆𝐾 𝑅𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒[𝑖] 

and deviation is the peak frequency deviation. 

Frequency Error is defined as the difference between the reference carrier frequency and measured 

carrier frequency, where the reference frequency is the user supplied center frequency. 

The Spike software uses a normalization reference of one. This is defined as the value of the maximum 

constellation magnitude. The Spike software forces the largest constellation magnitude to be one for 

each of the selectable modulations. 

4.7.9.2 Constellation Diagram 

 
Figure 29: Constellation Diagram for a QAM 16 Input Signal 

The constellation diagram helps a user visualize the quality of the signal and identify signal impairments 

such as phase noise, amplitude imbalance, and quadrature error. The constellation plot displays the 

modulation states and transitions of the input signal in the complex plane.  

4.7.9.3 Symbol Table 
The symbol table displays the demodulated bits of the input signal. The number of bits shown is equal to 

the symbol count selected times the number bits each symbol represents for the modulation type 

selected. The bits can be displayed in binary or hexadecimal format.  

The symbol table will also display the trigger pattern and whether it was detected. 
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4.7.9.4 Eye Diagram 

 
Figure 30: Eye diagram for a Pi/4DQPSK signal 

Spike allows the addition of an eye diagram display in modulation analysis mode. The eye diagram is 

used to visualize system performance characteristics, such as signal distortion, inter-symbol interference, 

signal-to-noise, and timing errors. 

4.7.9.5 Error vs Time 
Spike provides several error-vs-time displays. These displays offer a symbol resolution view of the 

common quality metrics such as EVM, magnitude error, and phase error. Below is the EVM vs Time plot, 

displaying individual EVM error over all symbols in the configured capture. 

 
Figure 31 : EVM vs Time plot 
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4.8 EMC PRECOMPLIANCE 
Precompliance measurements are available for SM, SP, and BB series devices. Precompliance 

measurements are accessed through the Analysis Mode -> EMC Precompliance file menu selection. 

Precompliance mode provides useful measurement functions for easily testing emission regulation 

requirements. These measurement capabilities include, 

• Setting up to 10 log scaled sweep ranges with custom limits and sweep parameters.  

• Path loss and antenna factor tables for calibrating your test setup. 

• A spur table showing all spurs which break the user defined limits and thresholds.  

• Quasi-peak, peak, and average detectors for testing signals of interest, shown the bar 

meter plot. 

• Detector lists which store results for the bar meter detector graph. 

 

These functions provide a usable workflow for making conducted and radiated emissions precompliance 

measurements on your product. 

Each function is detailed further below.  

 
Figure 32 : Radiated Emissions Precompliance Testing for the VSG25A 

4.8.1 Pre-Compliance Control Panel 
• Disp Start – The start frequency used when auto frequency display range is disabled. See 

Auto Freq below. 



Analysis Modes | EMC Precompliance 
  

69 

• Disp Stop – The stop frequency used when auto frequency display range is disabled. See 

Auto Freq below. 

• Auto Freq – When auto freq is enabled, the trace display will show the full frequency range 

determined by all active EMI sweeps. When auto freq is disabled the trace display will only 

span the frequency range selected by the Disp Start/Stop controls. This can be used to 

selectively display a region of interest.  

• Disp Ref – This is the reference level used for the trace display. 

• Max Input – Specify the maximum input signal to be received by the unit. This controls the 

sensitivity of the unit. This value will be used to all active sweep ranges. Select a value that 

is roughly 5dB higher than the largest expected input. 

• Div – Adjust the y-axis scale of the plot. 

• Trace Type – Select between a clear-and-write, max-hold, and average trace behavior. All 

ranges will follow this behavior. 

• Average Count – Specify the number of trace averages to occur when trace type is 

average. All ranges will use this value. 

• Export – Export the current sweep to a CSV file. 

• Clear – Clear the displayed sweep. 

• Set Marker – Manually set the marker frequency. 

• Pk Threshold – Specify the minimum amplitude required for a signal to be considered as a 

peak for the peak left/right buttons. 

• Pk Excurs. – Specify how far the amplitude needs to fall around a peak to be considered a 

peak for the peak left/right buttons. 

• Peak Search – Set the marker to the frequency of the largest amplitude signal found. 

• Disable – Hide the displayed marker. 

• To Ref – Set the reference level to the current marker amplitude. 

• To Meters – Set the bar meter frequency to the current marker frequency. 

• Peak Left – Move marker to the next peak on the left. 

• Peak Right – Move marker to the next peak on the right. 

• Freq – Select the meter center frequency. 

• Bandwidth – Select the bandwidth used for the meter readings. 

• Meas Time – Select the acquisition time to be used for the meter readings. 

• Start – Start meter detection. This will interrupt sweeps. 

• Stop – Stop meter detection. The software will resume sweeping.  

• Clear – Clear the current and peak meter readings. 

• To List – Store the current meter readings to the meter list. 

4.8.2 Range Table 

 
Figure 33: Range Table Control Panel 



Analysis Modes | EMC Precompliance 
  

70 

The range table allows you to customize up to ten sweep ranges. Each range can have its own frequency 

range, RBW, VBW, and test limits. Changes to the range table are reflected immediately in the software. 

The table can be saved to disk and imported later. 

• Load Default – Load the default range table inputs. 

• Save Table – Save the current table setup to a CSV file. 

• Load Table – Load a previously save table setup. This overrides the current setup. 

• Enabled – Enable or disable the selected range. Enabling ranges are swept and shown on 

the sweep display. 

• Start Freq – Select the start frequency of the selected range. 

• Stop Freq – Select the stop frequency of the selected range. 

• RBW Shape – Select between the 6dB CISPR RBW (Gaussian) or Flattop 3dB RBW filter. 

• RBW – Resolution Bandwidth. 

• VBW – Video Bandwidth. 

• Auto VBW – When enabled, tracks RBW. When disabled, VBW must be equal to or lower 

than RBW. 

• Video Units – Video processing unit type. 

• Detector – Select between Peak and Average detectors. 

• Dwell Time – Select the duration the spectrum analyzer dwells at any given frequency. This 

is helpful for capturing a periodic event. It is recommended to have the peak detector 

enabled when increasing dwell time. 

• Threshold – Minimum signal level for a signal to be considered a spur. This value must be 

lower than the limit setting. 

• Limit Start – Set the limit at the start frequency at which a signal is considered to fail the 

test setup. 

• Limit Stop – Set the limit at the stop frequency at which a signal is considered to fail the 

test setup. 

o The limit is drawn between the limit start and stop values. If you desire a flat limit, 

set them equal. The limit line is interpolated on a logarithmic scale. 

• Selectivity – Determines how sensitive the spur detector is. Higher values increase the 

necessary separation needed for a signal to be considered a spur. Caution: low selectivity 

values may greatly increase the number of reported spurs. 
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4.8.3 Frequency Scan Display 

 
Figure 34: Frequency Scan Display Showing Four Configured Sweep Ranges. 

For precompliance measurements, the main display is the frequency scan display. This plot shows all 

configured sweep ranges on one plot. The frequency axis is logarithmically scaled. 

The plot stretches from the minimum to maximum configured frequencies. It displays each sweep range 

along with visible red lines denoting the limits you entered and numbered spur markings. A single 

marker is available by clicking anywhere in the spectrum.  

The visible sweep can be configured using the control panel, either as a max hold or normal trace. 

Configuring the sweep as max hold can assist in finding signals of interest, such as intermittent and short 

duration events. 

4.8.4 Spur Table 

 
Figure 35:  Spur Table Sorted by Spur Amplitude 
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The spur table lists all signals above the minimum threshold set for each sweep range. The spur column 

value correlates to the numbered spur shown on the frequency scan display. Only the first 100 spurs will 

be shown. Spurs which violate the upper limits set in the range table will be highlighted red. 

Once you have identified one or more spurs of interest, it is easy to begin measuring each frequency of 

interest. Using the Single button and pausing the sweeps will cause the spur table to stop updating. Then 

you can sort by frequency or amplitude and measure each frequency of interest independently using the 

Selected Spur to Meter button. 

• Export Spur Table – Export both the peak table and meter list to a CSV file. 

• Selected Spur to Meter – Move the currently selected spur frequency to the meter 

frequency input. 

• Scan Spurs – Take meter measurements at all spurs and add results to Meter Readings list. 

• Failing Only – Only measure failing spurs (spurs that exceed the limit) on Scan Spurs.  

• Spur – The spur number. The spurs are ordered by frequency by default. 

• Range – Signifies which configured range the peak is presently in. 

• Freq – The frequency of the spur. 

• Amp – The amplitude of the spur. 

• Limit – The interpolated limit of the range in which the spur occurs. 

• Margin – The difference between the amplitude and the limit (Amp - Limit). 
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4.8.5 Bar Meters 
The bar meters’ display is the second measurement tool for 

precompliance testing. The bar meters show you three different 

detector readouts at a single center frequency.  

The bar meter measurement is activated using the Start and 

Stop buttons found on the control panel. It is automatically 

started after clicking the Selected Spur To Meter button in the 

Peak Table panel. While these detector measurements are 

active, sweeps are no longer updating.  

The frequency and bandwidth can be selected through the 

control panel, and there are several quick ways to populate the 

configuration for your signal of interest, such as the markers To 

Meters button which sets the detector frequency to the current 

marker value, and the Selected Spur to Meter button, which 

moves the frequency for the currently selected spur in the spur 

table to the meter settings.  

The bar meters show the output of up to 4 detectors. The peak 

and quasi-peak detectors are always shown, and the average 

detector can be set to RMS or linear average. 

A red limit line is shown at the meter frequency, interpolated 

from Limit Start and Limit Stop in the Range Table. 

The meter’s update at the rate set by Meas Time on the meter 

settings control panel.  

The meter’s store and display the max held detector values read since the last time the Clear button was 

pressed. Pressing the To List button stores the current peak detector values to the meter list. 

4.8.6 Meter List 

 
Figure 37: Meter Reading Results 

The meter list is generated by taking detector measurements at various frequencies and saving them 

with the To List button, or by clicking Scan All in the Peak Table panel. This list can be exported into a CSV 

file. 

 
Figure 36: Bar Meters Measuring Pulsed Signal 
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• Export Meter Readings – Export meter readings to a CSV file. 

• Delete Selected – Remove the selected meter reading(s). 

• Clear List – Remove all readings from the list. 

• Frequency – The frequency that the meter reading was performed at. 

• RBW – The resolutions bandwidth of the measurement. 

• Peak/Quasi Pk/Avg – The detector results of the measurement. 

• Limit – The interpolated limit of the range in which the spur occurs. 

• Date/Time – Timestamp of the reading. 

• Comments – Entry field for notes about the reading. 

4.8.7 Report Panel 

 
Figure 38: PDF Report configuration and generation. 

The report panel enables the generation of a formal PDF report of the results of the precompliance 

testing. The report contains all the readings in the Meter Readings list, in tabular form, a snapshot of the 

sweeps plot, the metadata as entered (report number, DUT product name, DUT product info, date of 

test, test engineer, and notes), and a full description of the spectrum analyzer used under test 

equipment, including the manufacturer, model number, serial number, and firmware version. 

• Generate Report – Generate and save the PDF report to chosen location. 

• Clear Info – Clear metadata entry fields. 

• Report Number – Identifying number for report. 

• DUT Name – Name of product under test. 

• DUT Info – Additional description of product under test (eg. serial number). 

• Date of Test – Date the readings were carried out. 

• Test Engineer – Engineer responsible for test. 

• Notes – Additional information. 

4.8.8 Quasi-Peak Measurements 
Quasi-peak (QP) measurements are available through the bar meters display. QP measurements begin 

when pressing the Start button on the precompliance settings control panel.  

The QP detector in Spike is defined by the CISPR 16.1 and ANSI C63.2 standards. The characteristics are 

shown below. 

Frequency Range Charge Time Constant Discharge 

Time Constant 

9 - 150 kHz 45 ms 500 ms 
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150kHz - 30 MHz 1 ms 160 ms 

30 MHz - 1 GHz 1 ms 550 ms 

 

The charge time is defined as the time needed after the instantaneous application of a constant RF 

sinewave voltage at the instrument input, for the output voltage to reach 63% of its final value.1 The 

discharge time constant is the time needed, after the instantaneous removal of a constant sinewave 

voltage applied to the input of the instrument, for the output voltage to fall to 37% of its initial value.1 

The QP detector is realized in the Spike software with digital filters. 

4.8.8.1 Damped Output 
The output of the QP detector is simulated as a critically damped meter with time constant of 160ms for 

9 kHz – 30 MHz and 550ms for 30 MHz – 1 GHz.  

This meter output is realized in the Spike software with digital filters. 

4.9 ANALOG DEMODULATION 
The Spike software can perform analog modulation analysis on AM and FM modulated signals. This 

mode provides several plots and measurements for analog modulation analysis. Analog modulation 

measurements are available through the Analysis Mode->Analog Demod file menu.  

This mode provides 5 views for the AM and FM time and frequency domain. All plots in analog 

demodulation mode adhere to the basic plot interface in Spike.  

• AM Time Domain plot shows the amplitude modulation over time in the units specified by the 

Input Level settings. 

• AM Spectrum plot displays the frequency spectrum of the AM waveform. The y-axis shows the 

AM depth% on a logarithmic scale, using 100% depth as the reference. 

• FM Time Domain plots shows the FM demodulated signal over time with a selectable frequency 

reference level. 

• FM Spectrum displays the frequency spectrum of the FM waveform. The y-axis is frequency 

deviation in Hz, with the reference level reference level equal to the device sample rate. 

• Analysis Summary displays the modulation measurement results for the AM and FM 

waveforms. 

 

Configuring the software to perform measurements involves selecting the input signal power level, 

carrier frequency and low pass filter using the controls found on the right-hand side control panel. The 

low pass filter is applied to the demodulated signal before modulation analysis is performed. Changes to 

the settings are reflected immediately in the acquisition. 
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Figure 39: Viewing a broadcast FM signal and observing the 19kHz FM pilot tone in analog demodulation mode. 

The analog demodulation mode performs a number of basic measurements on an audio signal such as: 

• Carrier Frequency records the carrier frequency. 

• Carrier Error records the difference between the measured carrier frequency and 

configured center frequency. 

• Avg Power records the average power of the entire capture in dBm.  

• Peak (+/-) records the minimum and maximum peak of the audio signal, recorded in Hz for 

FM and depth% for AM 

• RMS records the root mean square of modulation. RMS is displayed as Hz for FM and 

depth% for AM. 

• Modulation Rate records the frequency of the AM/FM modulation. 

• SINAD (SIgnal-to-Noise And Distortion ratio) records the signal quality defined by the 

function  

𝑆𝐼𝑁𝐴𝐷 =  
𝑃𝑠𝑖𝑔𝑛𝑎𝑙 + 𝑃𝑛𝑜𝑖𝑠𝑒 + 𝑃𝑑𝑖𝑠𝑡𝑜𝑟𝑡𝑖𝑜𝑛

𝑃𝑛𝑜𝑖𝑠𝑒 + 𝑃𝑑𝑖𝑠𝑡𝑜𝑟𝑡𝑖𝑜𝑛
 

THD (Total Harmonic Distortion) records the presence of harmonic distortion in the audio signal as 

defined by the function 

𝑇𝐻𝐷 =
√𝑉2

2 +  𝑉3
2 + ⋯ + 𝑉9

2

𝑉1

 

or in words, the RMS of the first nine harmonics to the RMS of the fundamental frequency. 

Both SINAD and THD measurements occur for AM or FM depending on which demodulation type is 

selected for Zero-Span. 
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4.10 INTERFERENCE HUNTING 
Interference is a critical concern wherever RF signals are broadcast or regulated. When links are noisy, 

signals are dropped, or data rate is low, interference is a likely culprit. If interference is present, then 

there will be an elevated noise floor on the receive channel. The interfering signal itself may not be on 

the receive channel, however it must be within the analyzer’s bandwidth. Interference Hunting mode 

provides tools to help spot and characterize such a signal. 

 
Figure 40: Detecting events in Interference Hunting mode with an acquired baseline. Yellow area on right is an exclusion zone. 

A signal can be detected by setting a baseline, or an amplitude threshold above which a signal is 

considered suspicious. Any time a signal occurs above this baseline level, an “event” is created in 

software to describe this instance in as much relevant detail as possible. An event stores the frequency, 

bandwidth, peak level or channel power, threshold (baseline level at that frequency), margin (decibels 

over threshold), start time, and duration of the signal. 

Events are then displayed in a list on screen that updates after every sweep, and they can be logged as 

they occur in a CSV file. Logging allows for unmanned operation over an extended period of time, which 

is especially useful for sparsely intermittent signals. The software can sit for days watching, and it will 

automatically capture all relevant details of interesting signals, producing data for later inspection. 
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4.10.1 Setting a Baseline 
A baseline can be either a flat line, representing a single amplitude level threshold, or can be acquired 

over a period of sweeps. In the latter case it may represent, for example, a max held image of the noise 

floor. 

   

       Figure 41: A flat baseline.         Figure 42: An acquired baseline. 

A flat baseline can be set instantly by simply choosing a threshold level. A baseline is acquired by setting 

a time interval for acquisition, and a mode of acquisition-- min hold, max hold, or average. Once 

acquired, a decibel offset can be applied to move the baseline to the desired location on the amplitude 

axis. Acquired baselines can be exported and imported, using a CSV format. 

4.10.1.1 Baseline File Format 
A baseline is saved as a CSV file, consisting of a header and a list of points defined as (frequency, 

amplitude) pairs.  If you export an active baseline, you will observe the file format below. 

BASELINE, Version 1 

startFreq, 2.00E+09 

binSize, 100.0E+06 

RBW, 30.0E+03 

VBW, 30.0E+03 

refLevel, -20.00 

div, 10.00 

timestamp, 1.50714E+12 

offset, 5.00 

  

frequency(Hz), amplitude(dBm) 

2.00E+09, -50.00 

2.10E+09, -51.00 

2.20E+09, -48.00 

2.30E+09, -39.00 

... 

... 
Table 1: Baseline file format example. 

The frequency of each point is inferred from startFreq and binSize as defined in the header; the first 

point’s frequency is equal to startFreq, and each following frequency is spaced binSize from the one 

before it. The frequencies listed are for convenient reference and are NOT USED when importing the 

baseline. 
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RBW, VBW, refLevel, and div reflect the sweep settings at the time of capture. Like the timestamp and 

point frequencies, they are for reference and are ignored. Offset refers to the dB offset specified in the 

Baseline section of the General Control Panel.  

Custom baseline CSV files utilizing this format can be edited or created in a spreadsheet editor and then 

imported. 

4.10.2 Defining Events 
For a single sweep, an event is the portion of a signal that is above the baseline. However, since an event 

has a time dimension, and may exist over multiple sweeps, the issue arises of when to consider a single-

sweep event to be merely a snapshot of an ongoing multi-sweep event, when to consider it as the full 

event, and when to not consider it an event at all.  

 

Figure 43: A single-sweep snapshot of an event. 

Two parameters are available to fine-tune what constitutes an event in the time domain—frequency 

deviation and minimum duration. Deviation refers to the maximum allowable difference in center 

frequencies between consecutive snapshots for those snapshots to be considered part of the same 

event. Minimum duration sets a lower bound on how long a signal must persist before being considered 

an event. 

 

Figure 44: The frequency deviation between two single-sweep snapshots of an event.  

To maximize capture and catch quick or jumpy signals, set minimum duration to zero and deviation to a 

high value. To more tightly restrict what constitutes an event for more persistent and steady signals, set 

minimum duration to a higher value and dial down deviation. 

4.10.3 Regional Zoom 
Interference Hunting mode provides regional zoom functionality, which allows for close visual inspection 

of specific parts of spectrum without changing span. 
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Figure 45: The regional zoom controller. 

The regional zoom controller is located below the main sweep plot, appearing as a horizontal strip. It is 

used to control what portion of the sweep is visible in the main plot by adjusting the lower and upper 

bounds of the unshaded region. These bounds, visible as vertical black lines, to the left and right of which 

are the unseen shaded regions, can be dragged in either direction, and the entire unshaded window can 

be dragged. 

The full sweep at the current span setting, along with any baselines and events, is always visible in the 

regional zoom controller. 

 
Figure 46: Regional zoom being used for close inspection of event. 

4.10.4 Exclusion Zones 
Exclusion zones are areas of spectrum where events cannot occur. By excluding known sources, large 

areas of spectrum can be monitored with decreased risk of false positives. An exclusion zone is defined 

by a start and stop frequency. 

 

Figure 47: A signal breaking a flat baseline threshold and falling partially within an exclusion zone (the yellow shaded portion). Only the 

unexcluded part of the signal is considered an event (the red shaded portion). 
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Figure 48: Baseline subset of General Control Panel 

4.10.5 Spectrogram 
The spectrogram, or waterfall, is a useful view in this mode, and can optionally appear above the main 

plot. It is described in more detail in Display Modes. 

4.10.6 Sweep Settings Control Panel 
See Sweep Settings Control Panel in Swept Analysis Mode. 

4.10.7 Interference Hunting Toolbar 
• Spectrogram – Enables the spectrogram display. See Spectrogram. 

4.10.8 General Control Panel 
The General control panel contains the basic controls specific to Interference Hunting mode. It is divided 

into two sections, Baseline and Events, which are the two main abstractions introduced by the mode. 

4.10.8.1 Baseline 
A baseline defines the threshold, at each frequency it 

contains, above which a signal is considered to be an 

event. A baseline can be either a flat line, where the 

threshold is the same across all frequencies, or it can 

be acquired from a signal over a period of time. 

 

• Threshold – Specifies which type of baseline is 

being used: an acquired one, or a flat line 

(minimum signal). 

• Enabled – Specifies whether a baseline will be 

displayed on plots and used to detect events. 

• Acq Time – The amount of time over which a 

new baseline is acquired. 

• Acq Mode – What type of 

accumulation function to use on consecutive sweeps during baseline acquisition. 

• Offset – The amplitude offset of an acquired baseline from its original level. 

• Flat Line – The amplitude that is the constant threshold for what is considered an event. 

• Import – Load a saved baseline. 

• Export – Save the current baseline.  

• Acquire Baseline – Begin acquiring a new baseline according to the current acquisition 

rules. 

4.10.8.2 Events 
An event is an incident where the input signal jumps above the threshold set by the baseline over a 

frequency range. It is defined by a frequency, bandwidth, peak level or channel power, threshold 
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Figure 49: Events subset of General Control Panel 

(baseline level at that frequency), margin (decibels over threshold), start time, and duration of the 

signal. 

  

• Min Duration – The minimum amount of time 

a signal must break the baseline to be 

considered an event. 

• Deviation – The allowable variation of the 

center frequency of an event. 

• Level – The mode of level calculation. 

o Peak – The highest amplitude of event. 

o Channel Power – The channel power 

surrounding the center frequency of 

the event. 

• Auto-Width – In Channel Power 

mode, automatically choose a bandwidth for channel power computation. 

• Bandwidth – In Channel power mode, manually input a bandwidth for channel power 

computation.  

• Freq Format – The frequency format to be used in event list and logging. 

o Center / Bandwidth – Specify an event using its center frequency and bandwidth. 

o Start / Stop – Specify an event using its start and stop frequencies. 

• Dur Format – The duration time format to be used in event list and logging. 

• Basic (s) – Display time in seconds. 

• Extended (hh:mm:ss:ms) – Display time in clock format.  

• Color – The color of an event on the plots. 

4.10.9 Measurements Control Panel 
See Measure Control Panel in Swept Analysis Mode. 

4.10.10 Exclusion Zones Control Panel 
An exclusion zone is an area of spectrum in which an event cannot take place. An exclusion zone is 

defined by a start and stop frequency. It is useful for ignoring known sources. 

• Add Zone – Adds a new exclusion zone definition     

to the list and activates it. 

• Remove Zone – Removes the highlighted 

exclusion zone definition from the list. 

• Clear – Removes all exclusion zone definitions 

from the list. 

• All – Activates all exclusion zone definitions in 

the list. 

• None – Deactivates all exclusion zones 

definitions in the list. 

• Import – Import a saved set of exclusion zone 
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Figure 50: Exclusion Zones Control Panel 

definitions. 

• Export – Export the current list of exclusion zone 

definitions for later loading. 

 

 

 

4.10.11 Logging Control Panel 
Events can be logged in real time as they occur by being automatically written out to a CSV log file. 

Logging can occur over long periods of time and does not require monitoring. Logging continues until 

either the logging is manually cancelled, a set amount of time has elapsed, or a set number of maximum 

events has been reached.   

 

Figure 51: Logging Control Panel 

• Save Directory – The default directory for the CSV event list files to be stored.  

• File Prefix – Applies a file name prefix to all files saved. Useful for creating identifiable file 

names. 

• Capture Size – Specifies the length of time during which logging takes place. 

• Unlimited Events – No upper limit on events captured-- continue for the duration of the 

capture size. 

• Max Events – The maximum number of events that can be logged during one capture. 

• Max File Size – The maximum file size allowed for a CSV log file. 

4.10.12 Event List 
Current events appear in the event list, which is updated every time a new sweep arrives from the 

device. The event list can be continuously sorted by any of its columns and can be exported to a CSV file 

for a quick snapshot of events occurring at that time. When events are cleared, all future events are 

considered new, and start times begin at the time received and durations begin at zero.  

 

Figure 52: Event List 
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• Export Events – Save the current event list table to a CSV file, preserving the current 

sorting rule. 

• Clear Events – Delete all events in event list table.  

4.11 SPECTRUM EMISSION MASK 
The spectrum emission mask (SEM) measurement is used to detect out of band spurious, interfering, 

and excessive emissions. Emissions are tested against a mask that can be defined as relative to the in-

band power of a signal at frequency offsets relative to the center frequency.  

Masks are entered manually in the offset table. Spike also contains several preset masks that can be 

loaded directly into the table. Mask offsets are drawn on the graticule using shaded regions, green for 

passing, red for failing. 

When configuring the SEM measurement, an input level should be chosen that is as close to the 

expected input power as possible. This will improve the dynamic range of the measurement. An IF 

overload message will appear if the input power is set too low. 

All configured offsets are measured relative to an amplitude reference. This reference is measured using 

either a peak measured value, the channel power, or directly set by the user. The span of which the peak 

or channel power is measured is selectable and defaults to the span between the first configured offset. 

The reference is calculated for each sweep. 

The plot in SEM mode adheres to the basic plot interface in Spike. 

 
Figure 53: Testing input against an 802.11 OFDM transmission mask. 

4.11.1 Control Panel 
The following is a description of the various controls in the SEM Settings control panel. 
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• Center Freq – The reference frequency for the offset table and tuned center frequency of 

the sweep. 

• Step – Controls the frequency step size when using the center freq arrows. 

• Span – Frequency span around the center frequency. 

• RBW – Resolution bandwidth, using a flattop window. 

• VBW – Video bandwidth. 

• Input Level – The maximum expected input level of the signal. 

• Div – Controls the plots y-axis scale. 

• Video Units – In the system, unprocessed amplitude data may be represented as voltage, 

linear power, or logarithmic power. Select linear power for RMS power measurements. 

Logarithmic power is closest to a traditional spectrum analyzer in log scale. 

• Detector - As the video data is being processed, choose whether min/max or avg 

amplitudes are stored. 

• Trace Type – Specify whether a clear/write or max hold trace is used. 

• Meas Type – Specify how the reference amplitude is measured. 

• Reference – Specifies the amplitude reference directly. 

• Width Set – Specify the range of frequencies over which the channel power amplitude 

measurement reference is calculated. 

o When set to Auto the span between the center frequency and first frequency offset 

is used. 

o When set to Manual the entered width is used. 

• Width – Direct set width. 

• Meas Width – Actual measurement width. 

• Load Mask – Load a predefined offset table based. 

4.11.2 Context Menu 
• Show Pass/Fail Indicator – Toggles visibility of pass/fail indicator located at top center of 

graticule.  

4.11.3 Configuring Offsets 
Up to 16 offsets can be configured. Offsets can be tested against an absolute amplitude or one relative 

to the measured power of the in-band channel and can have linear shape (flat or linear slope). Offsets 

are configured as uppers offsets but are then applied as both upper and lower, symmetrical around the 

center frequency. 

 
Figure 54: SEM offset table editor. 
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4.11.4 Results 
The result of each configured offset is displayed in the results table. The results table shows the largest 

margin of both the upper and lower offset on one row. Results can be exported to a custom CSV. 

The frequency and level columns display the frequency and amplitude of the worst margin in the given 

offset. 

 
Figure 55: SEM Results Table. 

4.11.5 Limitations 
Not all Signal Hound devices can perform all mask measurements. The dynamic range limitations of 

some Signal Hound devices such as the SA44, SA124, and BB60 series spectrum analyzers might prohibit 

certain mask measurements such as the AM/FM masks at the outer offsets. To avoid failing 

measurements in these situations it might be necessary to disable the outer offsets. 

(A note about the legacy software broadcast mask measurements.) The legacy Signal Hound software 

performed custom sweeps to help overcome the dynamic range limitations of the SA series devices. 

These custom sweeps are not performed in the Spike software and thus you might have different results 

when comparing to the legacy software, particularly when comparing the FM broadcast mask 

measurements.  

4.12 NOISE FIGURE 
Noise figure measurements are available for SM, SP, and BB series devices. For more information, see 

Limitations. 

Noise figure is a measure of the noise a device contributes to a signal, expressed as the degradation in 

signal/noise ratio as the signal passes through the device. It is not a direct measurement, but is 

computed, using the Y factor technique, from several measurements taken by the spectrum analyzer. 
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Figure 56: Noise figure and gain plots of a small wideband amplifier, tested with an SM200A and an Agilent 346B noise source. 

4.12.1 Process Overview 
The measurement consists of two steps, each of which measures the noise power level when the noise 

source is in an ON and OFF state. In the first step (calibration), the noise source is connected directly to 

the spectrum analyzer. Then, in the second step (DUT measurement), the DUT is inserted in the signal 

chain between the noise source and the spectrum analyzer. 

The DUT properties are derived from the difference between the DUT measurement system and the 

calibration system. 

Once a calibration is performed for the current configuration, repeated measurements can be taken 

without the need for repeating the calibration step. 

4.12.2 The Y Factor Method 
The Y factor technique is a common method of calculating noise figure (NF). Its computations are carried 

out in terms of noise temperature (T) in linear scale.  

Noise figure is expressed on the logarithmic scale. Noise factor (F) is the linear equivalent: 

𝑁𝐹 = 10 log10 𝐹 

(1) 

The Y factor is defined as the linear ratio of noise power level when the noise source is ON and OFF: 
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𝑌 =
𝑁𝑂𝑁

𝑁𝑂𝐹𝐹

 

(2) 

The Y factor can be converted to noise temperature: 

𝑇 =
𝑇𝑆𝑜𝑢𝑟𝑐𝑒

𝑂𝑁 − 𝑌 (𝑇𝑆𝑜𝑢𝑟𝑐𝑒
𝑂𝐹𝐹 )

𝑌 − 1
 

(3) 

where  𝑇𝑆𝑜𝑢𝑟𝑐𝑒
𝑂𝑁  is the excess noise ratio (ENR) of the noise source, and 𝑇𝑆𝑜𝑢𝑟𝑐𝑒

𝑂𝐹𝐹  is the ambient room 

temperature, generally considered to be 290 K. 

Noise factor can then be derived from noise temperature: 

𝐹 = 1 +
𝑇

𝑇𝑆𝑜𝑢𝑟𝑐𝑒
𝑂𝐹𝐹  

(4) 

The measurement setup is considered a two-stage system, where the DUT is stage 1, and the spectrum 

analyzer is stage 2. The noise factor of a two-stage system (F12) can be derived from the noise factors of 

its component stages (F1, F2) and the gain of its first stage (G1): 

𝐹12 = 𝐹1 +
𝐹2 − 1

𝐺1

 

(5) 

This equation can be written in terms of noise temperature for stage 1: 

𝑇1 = 𝑇12 −
𝑇2

𝐺1

 

(6) 

DUT gain is computed: 

𝐺1 =  
𝑁12

𝑂𝑁 − 𝑁12
𝑂𝐹𝐹

𝑁2
𝑂𝑁 − 𝑁12

𝑂𝐹𝐹   

(7) 

So, after noise temperatures have been calculated from the calibration (T2) and DUT measurement  (T12) 

steps, the noise figure of the DUT is calculated using equations 4, 6, and 7. 

4.12.3 Control Panel 
The following is a description of the various controls in the Noise Figure Settings control panel. 
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• Freq Mode – Choose between Swept and Fixed mode. In swept mode the number of 

measurement points specified by Points are evenly distributed across the span. In Fixed 

mode, only the Fixed Freq is tested. 

• Start/Stop – The lowest and highest frequencies to test (when not in fixed mode). 

• Center – The center of the range of frequencies to test (when not in fixed mode). 

• Span – The range of frequencies to test (when not in fixed mode). 

• Points – The number of frequencies to test, evenly spaced across the span (when not in 

fixed mode). 

• Fixed Freq – The frequency tested in fixed mode. 

• Ref Level – The power level of the top graticule line. 

• RBW – Resolution bandwidth, using a flattop window. 

• VBW – Video bandwidth. 

• Auto RBW – Having auto selected will choose reasonable and fast RBWs relative to the 

meas span. When changing meas span, it is recommended to have this enabled along with 

Auto VBW.  

• Auto VBW – When enabled, VBW will equal RBW. 

• Meas Span – The span of the sweeps taken during measurement at each test frequency. 

• Averaging – If averaging is enabled, then for each frequency test point, the number of 

power readings defined in “Avg Number” will be averaged. 

• Avg Number – The number of sweeps averaged during measurement at each test 

frequency, if averaging is enabled. 

• Room Temp – The ambient temperature of the room, in Kelvin. 

• Play Alert – When enabled, a sequence of beeps will play when a full sweep through the 

measurement points is completed. 

• Noise Source (Cal) – Select the noise source to be used for the calibration step. (See Noise 

Sources & ENR Tables for more info.) 

• Noise Source (Meas) – Select the noise source to be used for the measurement step. (See 

Noise Sources & ENR Tables for more info.) 

• Manage ENR Tables – Opens a manager for the persistent collection of noise source ENR 

tables. (See Noise Sources & ENR Tables for more info.) 

4.12.3.1 Noise Sources & ENR Tables 
When the noise source is receiving power (ON state), its “hot” noise temperature is the excess noise 

ratio (ENR) at the frequency being measured. A table of ENR values is a part of the spec of a noise 

source, and is often printed on the device. This table must be manually entered into the software 

to obtain accurate measurements. 

 

The ENR Table Manager allows for the addition, removal, renaming, and editing of points of each 

ENR table. It is accessed via the “Manage ENR Tables” button. Once entered, an ENR table will 

persist across sessions until deleted. There is no limit on the number of ENR tables that may be 

stored, although in practice this would not exceed the number of noise sources available for use. 

 

The table(s) used for calibration and measurement are saved and loaded in global presets and 

matched by name to the current noise source list. 
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Figure 57: Noise Source ENR Table Manager 

4.12.4 Results Table 
This table displays the measured noise figure and gain at each frequency tested. The table can be 

exported as a CSV file using the “Export Results Table” button. 

 

Figure 58: Noise figure results table. 

4.12.5 Making Measurements 
Taking a noise figure measurement is a process that consists of a sequence of manual steps with 

different physical connections. Because of this, Noise Figure mode does not make continuous 

measurements. 

At any point a measurement can be cancelled using the “Abort” button on the progress dialog. This will 

revert the state to before the aborted measurement was begun. 

4.12.5.1 Calibration 
For the most accurate characterization of the DUT, the system should first be calibrated. This establishes 

a baseline, accounting for the analyzers’s noise contribution, that can later be subtracted out to isolate 

the DUT’s performance. This process is often called second stage correction. 

The calibration step is optional. If the DUT has high gain (exceeding 30 dB), and the spectrum analyzer 

has low noise figure, then the second stage error is minimal, and calibration can be skipped. Otherwise, 

skipping calibration will generally result in substantially higher errors. Note that calibration is required for 

gain measurement. 

Calibration is initiated with the “Calibrate” button on the main toolbar. When this process is complete, 

measurements can be taken with maximum accuracy. A calibration will hold (i.e. calibration data is 

stored in memory) for the duration of the Spike session, or until the configured measurement points 

change. In practice, measurement points are affected by the settings in the control panel’s “Frequency 
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List” section. If other aspects of the configuration change, such as sweep settings or averaging, the 

current calibration will continue to be utilized, but at a reduced measurement accuracy. 

The software is always in one of three calibration states, shown as “Cal State” in the toolbar: 

- Uncal (red) – There is no valid calibration currently stored. High measurement error is likely 

unless the DUT has at least 30 dB gain. 

- ~Cal (yellow) – There is a valid stored calibration, however the measurement accuracy has been 

reduced due to changes in the configuration since last cal. 

- Cal (green) – There is a valid stored calibration whose settings are identical to the current 

configuration. 

A fresh calibration can be run at any time. For the most accurate measurements, run a calibration 

whenever settings change and the calibration state goes out of green “Cal”. 

4.12.5.2 Measurement Process 
Throughout the measurement process, modal dialog boxes will prompt the user to make the necessary 

connections. 

The process is as follows: 

1) Configure the measurement. 

a. Define the frequency list using the “Frequency List” section of the control panel. This is 

the list of test frequencies at which measurements will be performed. If “fixed” is 

checked, then the frequency list will contain one frequency only, that defined by “fixed 

freq”. Otherwise, the span between start and stop will be divided evenly by the number 

of points. 

b. Define the measurement settings. This includes the settings for each sweep (meas span, 

the Amplitude and Bandwidth sections of the control panel), the number of sweeps to 

average at each point (Avg Number), the ambient temperature (Room Temp), and 

selecting the ENR table that corresponds to the noise source being used.  

2) Calibration (Optional). 

a. Connect the noise source directly to the spectrum analyzer. 

b. Follow prompts to switch power to the noise source on and off. 
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Figure 59: Noise figure calibration step setup. 

3) DUT Measurement. 

a. Insert the DUT in the signal chain between the noise source and the spectrum analyzer.  

b. Follow prompts to switch power to the noise source off and on.

 

Figure 60: Noise figure DUT measurement step setup. 

4) Results. 

a. Noise figure and gain calculations at each frequency will be shown in the Noise Figure 

and Gain plots, and the Results table. 

5) Repeat steps 3 – 4 as desired, or return to step 1 to define a new configuration. 

4.12.6 Annunciator List 
4.12.6.1 Invalid 
If the noise figure or gain calculation fails, an “Invalid” annunciator will be printed in red on the noise 

figure and gain plots. 

This will happen if the signal measured with the noise source powered ON is ever not higher than the 

signal with the noise source powered OFF. In this case, make sure the noise source is powered and 

generating a signal as expected and retake measurement.  

Some potential remedies to this issue include: 

- Using a noise source with sufficient ENR 

- Increasing averaging 

- Increasing meas span 

- Setting reference level for maximum sensitivity 

o The table below shows what this value would be for compatible analyzers: 

SM200/435 -20 dBm or lower 
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SP145 -30dBm or lower 

BB60C -50 dBm or lower 

BB60D -30 dBm or lower 

 

4.12.6.2 IF Overload 
This indicates that an IF overload occurred during a measurement. See “IF Overload” in Annunciator List. 

4.12.6.3 IF Overload (Cal) 
This indicates that an IF overload occurred during the calibration utilized by the measurement. See “IF 

Overload” in Annunciator List. 

4.12.7 Limitations 
• SA Series – Noise figure measurements are not available for SA series devices. Their use of 

software image rejection makes them unsuitable for broadband noise signals. 

• BB Series – For best results, keep ENR + gain below 40 dB. 

• SP Series – For best results, keep ENR + gain below 50 dB. 

• SM Series – For best results, keep ENR + gain below 60 dB.  
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4.13 BLUETOOTH® LOW ENERGY 

 

The Bluetooth Low Energy measurement mode allows customers to perform general purpose Bluetooth 

Low Energy measurements as well as test Bluetooth Low Energy waveforms against the Bluetooth 

Special Interests Group (SIG) test specifications for Bluetooth Low Energy transmitters. The Spike 

software performs automatic detection and demodulation of Bluetooth Low Energy waveforms and 

displays the results in several standard measurement windows. Additionally, decoded Bluetooth Low 

Energy packets can be saved to a .pcap file for further analysis in many pcap file analyzers. These 

features make Spike an affordable and easy option for Bluetooth Low Energy troubleshooting, pre-

compliance, monitoring, and device manufacturing.  

The Spike software supports waveforms meeting the specifications outlined in the core 5.2 spec. Spike 

supports the 1MHz PHY only.  

4.13.1 Measurement Concepts 
4.13.1.1 Demodulation 
When Demod measurement type is selected, Spike performs packet demodulation at the center 

frequency selected. An I/Q capture with a specified search length is performed, and a valid waveform is 

searched for over this interval. If a valid Bluetooth Low Energy waveform is detected, full demodulation 

occurs, any applicable transmitter tests are performed, and the measurement windows are updated. 

This will update all plots except the in-band emissions plot. 
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Detection is performed using a moving average power detector combined with a preamble detect. If a 

valid preamble is detected the access address and PDU header is decoded. The PDU is de-whitened 

using either the center frequency selected or if overridden, the specified channel index. The waveform is 

rejected if the signal length does not match the expected size as specified in the PDU header.  

4.13.1.2 Transmitter Testing 
The Spike software performs the following transmitter tests as defined by the Bluetooth® SIG*. 

• TP/TRM-LE/BA-BV-01-C, output power  

• TP/TRM-LE/BA-BV-03-C, in-band emissions 

• TP/TRM-LE/BA-BV-05-C, modulation characteristics 

• TP/TRM-LE/BA-BV-06-C, carrier frequency offset and drift 

*Tests are defined in RF-PHY.TS.p15. 

 

By default, test limits are defined to match the specification. Test limits can also be changed by the user. 

 

Output power, modulation characteristics, and carrier offset and drift measurements are all performed 

in the demodulation measurement mode. These tests are performed automatically when a valid 

payload is detected.  

• Output power measurements are performed over all valid Bluetooth Low Energy 

waveforms. 

• Carrier offset and drift measurements are performed when the physical layer PDU bits 

(transmitted bits) are equal to the pattern 10101010 or 01010101.  

• Modulation characteristic measurements are performed when the physical layer PDU bits 

(transmitted bits) are equal to the pattern 00001111 or 11110000. Please note, some 

measurements such as f2/f1 require both 01010101 and 00001111 patterns to be 

transmitted before a valid measurement can be made. 

The PDU type does not have to be a test packet (access address 0x071764129) for the payload bits to be 

checked, any PDU type will be searched. 

4.13.1.3 In-Band Emissions 
The in-band emissions test is activated by selecting the in-band emissions measurement type in the 

control panel. When this measurement is active, only the in-band emissions measurement plot is 

updated. 

The in-band emissions test is performed by perform a sweep over the full 2.4GHz band using the sweep 

configuration outlined in TRM-LE/BA/VB/03. The transmit channel is automatically detected by looking 

for the highest channel power from the 40 Bluetooth Low Energy transmit frequencies.  

The sweep configuration used is, 

• Span = 81MHz 
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• RBW = VBW = 100kHz 

• Detector = Average 

• Sweep time = 100ms 

4.13.2 Control Panel 
The following is a description of the measurement controls found on the Bluetooth Low Energy Settings 

control panel. 

• Measurement – Select between demodulation measurements and in-band emissions. See 

the Bluetooth Low Energy Measurement Concepts section for more information. 

• Channel – Quick frequency select. This control is used to change the center frequency for 

demodulation measurements. 

• Carrier Freq – Manual frequency selection for demodulation measurements. When 

Override Ch. Index is unselected, the carrier frequency determines the transmit channel 

and therefore the seed used for PDU de-whitening. 

• Step Freq – Controls the amount the carrier frequency changes when using the arrow 

buttons next to the carrier frequency control. 

• Bandwidth – Specify the acquisition bandwidth for demodulation measurements.  

• Override Ch Index – When enabled, the channel index can be specified manually for 

purposes of PDU de-whitening. This allows measurements on signals generated at any 

frequency. When disabled, the channel index is inferred from the carrier frequency setting. 

• Channel Index – When override channel index is enabled, the channel index is used to 

seed the PDU de-whitening. 

• Ref Level – Specifies the maximum input power to the spectrum analyzer.  

• Search Len – Specifies the length of the window in which a valid waveform is searched. 

Longer search lengths increase capture probability at a decrease in measurement speed. 

• Edit Test Limits – Change the test limits for the transmitter tests. Limits are only stored in 

the user presets. Modified limits do not persist through program instances unless saved 

and loaded through the preset menu. 

• Select Save Dir – Select the default directory in which PCAP files are stored. 

• Start Recording – Starts the PCAP recording. See PCAP recording for more information. 

4.13.3 Bluetooth® Low Energy Measurement Windows 
Measurement windows can be added to the plot area using the Add Measurement combo box. 
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Most measurement plots use the basic plot interface. 

4.13.3.1 AM vs Time Search 

 

The AM vs Time search plot is active for demod measurements and shows the full waveform search 

period. If a waveform was detected it will be underlined in blue. This plot will update even if no signal 

was found, making this plot useful for troubleshooting, or verifying signal activity at the frequency of 

interest. Both capture status and annunciators are present on this plot. 

The annunciators that can appear in this plot are: 

- No Signal Found, indicates the power detect algorithm did not detect a packet. This can occur if 

the signal to noise ratio is too low, or if the packet started before the search window took place 

(search window starts in the middle of an already started packet. 



Analysis Modes | Bluetooth® Low Energy 
  

98 

- No Preamble Found, indicates the leading edge of the packet did not appear to contain a valid 

preamble. Valid preambles will contain at least 8 alternating bits. If the SNR is too low, or if the 

frequency offset is too large, this error can occur. 

- Format Error Detected, can indicate the expected waveform does not match the measured 

waveform. When the demodulated header does not match a valid pattern, or when the 

expected payload extends beyond the packet signal this error can occur. This is most common 

when an interfering packet is transmitted mid packet, or when the SNR is too low. 

4.13.3.2 AM vs Time Capture 
This plot shows the amplitude vs time over the captured waveform, from the first symbol of the 

preamble to the last symbol of the CRC. 

4.13.3.3 FM vs Time Capture 
This plot shows the frequency vs time over the captured waveform, from the first symbol of the 

preamble to the last symbol of the CRC.  

4.13.3.4 Eye Diagram 

 

The eye diagram shows every FSK symbol transition in the captured waveform. The eye diagram can 

provide a quick at-a-glance view of the signal health, including frequency offset, drift, noise, filter 

performance, or symbol timing errors. 
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4.13.3.5 Spectrum 

 

The spectrum is calculated over the capture interval. A Nuttall window is used. 

4.13.3.6 Bit Info 
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The bit info plot displays the various data components of the captured waveform. Each component of 

the PDU header is displayed as well as the bits for the entire capture. The PDU type is determined both 

from the current channel index selected and the access address value. The CRC pass/fail message is only 

displayed for advertising and test PDU types. 

4.13.3.7 Transmitter Characteristics 

 

This plot displays all transmitter test results except in-band emissions. Test results appear once a valid 

packet has been detected for that test. Results are averaged/max-held for up to 10 captures. Test results 

can be reset by changing any configuration parameter or by pressing the Recal button. 
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4.13.3.8 In-Band Emissions 

 

This plot displays the test results of the in-band emissions transmitter test. This plot is only updated 

when the measurement type is set to In-Band Emissions. See Measurement Concepts: In-Band Emissions 

for more information. 

4.13.4 PCAP Recording 
The Spike software can be configured to store every successful demodulated packet into a .pcap file. The 

pcap file uses the libpcap file format with the LINKTYPE_BLUETOOTH_LE_LL_PHDR link layer header type. 

When recording is active every packet displayed when the Demod measurement type is active is stored 

into the pcap file. Recording can be started and stopped using the Start/Stop button on the control 

panel.  

Spike does not provide software which displays the contents of the pcap files. Several third-party 

applications exist for this. 

4.14 WLAN MODULATION ANALYSIS 
The Spike software can be used for 802.11b/a/n/ac/ax/ah modulation analysis. The software performs 

several physical layer (PHY) measurements including RF quality and performance metrics, channel 

characterization, and bit level troubleshooting.  

This section covers the various settings and controls for performing measurements, the measurement 

windows, demodulation procedure, and finally a measurement walk through. 

WLAN measurements are available for SM, SP, and BB series devices. 

4.14.1 Control Panel 
The following are descriptions of the various settings available on the control panel. 
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• Standard – Select the WLAN standard you wish to measure. When measuring 40MHz 

signal, the 40MHz standard must be selected. For AH signals, bandwidth is automatically 

detected. 

• Max DSSS Symbols – Maximum number of DSSS symbols to measure. Applies to 802.11b 

waveforms only. Packets are truncated to this length. 

• Decode PSDU – When enabled, OFDM PSDUs are decoded and shown in the decoded bits 

view. Only BCC encoded payloads can be decoded in Spike. This setting does not apply to 

DSSS waveforms. 

• Symbol Offset – (OFDM only) Specify a symbol offset as percentage of the guard interval. 

Specify a value between -100 and 0.0. -50% is default and results in sampling the symbol 

halfway through the guard interval. -25% offset results in sampling the symbol 75% of the 

way through the guard interval. When a short GI is detected, the symbol offset will become 

a % of the short GI length. 

• 2.4 GHz Ch. – Select a carrier frequency by selecting an industry defined channel. This has 

the same effect as manually entering a new carrier frequency. 

• 5 GHz Ch. – Select a carrier frequency by selecting an industry defined channel. This has 

the same effect as manually entering a new carrier frequency. 

• Carrier Freq – Select the center frequency of the measurement. For all OFDM waveforms, 

this should be the frequency of the center-most null DC subcarrier. Ensure the carrier 

frequency is within +/- 624KHz for 20/40MHz OFDM and +/-2.7MHz for DSSS signals of the 

channel center frequency. Outside of these limits, the software will not be able to achieve 

proper carrier recovery and symbol synchronization. 

• Step Freq – Select the frequency step size when using the up/down frequency buttons. This 

can be useful for stepping through several adjacent channels. 

• IF BW – Select the baseband filter bandwidth. This filter is applied before the measurement 

is performed. This filter should be wide enough to accommodate the signal of interest. If 

the BW it too wide, it may allow triggering on adjacent channels. 

• Ref Level – Determines the maximum signal input level before potential IF overload and 

clipping occur. For OFDM signals this may be several dB above the expected average power 

of the input signal due to OFDM having a high PAPR. Reference level also adjusts the 

sensitivity of the instrument. If reference level is too high relative to the signal level, this will 

negatively affect SNR and ability to trigger on packets.  

• Meas Filter – DSSS pulse shaping filter applied to the waveform.  Currently this is fixed as a 

rectangular window. 

• Filter Bbt – Adjust the pulse shaping filter coefficient. Currently not used when the 

rectangular window is applied. 

• Search Len – Length of search window. See Measurement Concepts for more information.  

• OFDM Trig Threshold – Specify a sliding window trigger threshold for OFDM 

measurements. The threshold must be positive. A lower threshold triggers signals with 

lower SNR at the expense of triggering on erroneous signals. This threshold is roughly the 

level above the noise floor (in the time domain) needed for packet detection to occur. 

• DSSS Trig Level – Video trigger level used for DSSS measurements. This is an absolute 

trigger level. The AM vs Time (Search) window can be used to estimate a valid trigger level 

when first setting up a measurement. 
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4.14.2 Measurement Windows 
Several measurement windows can be added to the main application. Most measurement windows 

target either OFDM or DSSS modulations. A quick setup button is available to quickly switch between 

OFDM and DSSS measurement window configurations. Additionally, the measurement layout can be 

saved and loaded through the presets.  

Most measurement plots use the basic plot interface. 

Below is a summary of some of the measurement windows. 

4.14.2.1 AM vs Time (Search) 

 

The AM vs Time search plot is active for successful and un-successful measurements and shows the full 

waveform search period. If a waveform was detected it will be underlined in blue. This plot will update 

even if no signal was found, making this plot useful for troubleshooting, or verifying signal activity at the 

frequency of interest. Both capture status and annunciators are present on this plot. 

4.14.2.2 Decoded Bits/Data 

 

When the PSDU is BCC encoded and Decode PSDU is selected, the decoded bits appear here. For non 

802.11ax waveforms, the leading service bits and trailing zero bits are discarded, and only the specified 
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payload size is displayed. For 802.11ax waveforms all bits up to the post-FEC bits are displayed, including 

all leading zero service bits.  

4.14.2.3 MAC Header Info 

 

This window shows the decoded payload as a MAC header. This window will only show valid MAC 

header info for non-aggregate payloads. 

4.14.2.4 Symbol Table 

 

The symbol table shows the transmitted bits for an OFDM waveform. Each OFDM symbol is represented 

on a different row. Only data and pilot subcarriers are shown, pilot subcarriers are highlighted in red. 

Each subcarrier is demodulated with its respective constellation (BPSK for pilots, refer to the MCS for the 

data subcarriers). 

4.14.3 Measurement Concepts 
4.14.3.1 Search Window 
Measurements are performed by acquiring data equal in length to the user specified search length. This 

acquisition is referred to as the search window. Then, a valid packet is searched for within the search 

window. The WLAN standard selected determines what algorithms are used to detect a valid packet. The 

packet must be fully contained in the search window for successful demodulation. For this reason, the 

search length should be sufficiently larger than the expected packet length. 
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If no packet is detected, the AM vs Time (Search) window is updated with an appropriate error status. If a 

packet is detected, but demodulation fails, the measurement is considered a failure and the AM vs Time 

(Search) window is updated with an appropriate error message. At that point, a new search window will 

be acquired, and a new measurement attempted. Only one measurement is performed on a search 

window. 

4.14.3.2 802.11 A/N/AC/AX Demodulation 
The demodulation process for 802.11a/n/ac/ax is as follows. 

• A sliding average power window using the OFDM threshold is used to find the leading edge 

of a packet transmission. 

• The L-STF is used to perform symbol timing. 

• Frequency offset is measured and corrected using the L-STF and L-LTF.  

• Equalization for the L-SIG is performed using both L-LTF symbols with an averaged zero-

forcing algorithm. Equalization on the PSDU is performed with a zero-forcing algorithm on 

the LTF sequence preceding the data symbols. 

• Symbols are demodulated using a user defined symbol offset (default -50%). 

• Pilot tracking occurs over the PSDU. Both phase offset and timing are tracked, correcting 

for both residual frequency offset and sample rate offset through the PSDU. The pilot 

errors are measured after equalization on each data symbol.  

• The PSDU is decoded if both the PSDU Decode setting is enabled and the PSDU is BCC 

encoded. If LDPC encoding is detected, PSDU decoding does not occur. 

4.14.3.3 802.11 AH Demodulation 
Bandwidth is automatically detected for AH measurements. For any given bandwidth, the center 

frequency specified should be the frequency of the center-most null DC component of the signal.  

When the 802.11ah standard is selected, the demodulation process is as follows, 

• A sliding average power window using the OFDM threshold is used to find the leading edge 

of a packet transmission. 

• Initial symbol timing is performed using the STF. 

• A bandwidth detector is used to determine the bandwidth of the signal (1/2/4/8MHz). 

• Fine symbol timing is performed on the LTF. 

• Frequency offset is measured and applied using the STF and LTF. 

• Equalization is estimated using the LTF and a zero-forcing algorithm. 

• Symbols are demodulated using the specified symbol offset (default -50%) 

• Pilot tracking occurs over the PSDU. This also determines the symbol rate error. 

• The PSDU is decoded if BCC encoded. 

4.14.3.4 DSSS Demodulation 
Signal detection occurs using a user supplied video trigger with a small amount of hysteresis followed by 

a preamble detect for synchronization. The waveform is then fully demodulated using standard 

BPSK/QPSK demodulation techniques.  
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4.14.4 WLAN Measurement Walkthrough 
This section will guide you through making an OFDM WLAN measurement in Spike. 

1) The first step is to determine if and where a WLAN signal is present. The easiest way to do this is 

by using the sweep measurement mode to find and center on a frequency of interest. In the 

picture below, the spectrum shows a WLAN signal at 1GHz is being generated by a signal 

generator. 

 

2) Once you have found a signal of interest, switch into WLAN measurement mode using the 

“Analysis Mode” drop down file menu. This will also carry over the current center frequency and 

reference level. 
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3) The first time the WLAN measurement tool is enabled, the layout will be preset for OFDM 

measurements, and the default standard set to 802.11a. You might see something like the 

picture below. In this case the AM vs Time (search) window is showing you the search waveform 

and a status message. In this case the status message indicates that a trigger was not found and 

we need to adjust our trigger settings. 
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4) The AM Vs Time (Search) plot is the most important plot for troubleshooting. Taken from the 

image above, this plot indicates that a video trigger was not found. We can see from the settings 

control panel the video trigger level is set to -30dBm and the highest amplitude measured in the 

search window is -40dBm. We need to lower the video trigger level. 

 

5) We also need to setup our measurement using the WLAN settings control panel. 

a. Select the waveform type. In this example the input waveform is an 802.11n 20MHz 

waveform. Select this from the standard drop down menu entry.  

b. It may be necessary to adjust the center frequency of the measurement. This can be 

done with the carrier frequency setting. 

c. The input level control is the reference level and should be set to above the maximum 

power of the input waveform. Decreasing the input level control when possible will help 

increase the sensitivity of the analyzer and might improve your measurements. 

d. Set the trigger level and search length. The search length is the length of the capture the 

software will acquire and look for a valid waveform. The trigger level is the amplitude 

used to detect the start of a waveform within the search length. In this example, we will 

set the trigger level to -55 based on the waveform shown in the AM vs Time (Search) 

plot. 
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6) Once all relevant settings have been updated, you can see the other windows updating and no 

longer see a status message in the AM vs Time (Search) plot. Notice in the AM vs Time (Search) 

plot a blue bar under one of the signals. This indicates that this part of the search waveform was 

used to make the measurement. 
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7) Pressing “Single” will force the software to make one more valid measurement. Screen updates 

where a trigger was not found, or the measurement was invalid will not pause the software. 

8) Add more measurement windows using the “Add Measurement” drop down menu. 

9) Save your current configuration using Save/Load presets. This will save all measurement 

windows/locations and settings. Un-check “Auto Fit” if you plan on organizing the measurement 

windows in a custom fashion. 

4.14.5 Troubleshooting 
• If the search window reports “Invalid Packet Format”, this means the first triggered 

measurement was not able to be demodulated using the current standard. This might 

mean the waveform was of a different standard or the signal was impaired beyond being 

able to successfully demodulate it. 

• If the search window reports “Not Enough Samples” this means the waveform was detected 

but was at the end of the search window and would not be able to be successfully 

demodulated. If you see this often, try increasing the search window length. 

• If the search window reports “Trigger Not Found”, verify the waveform is present in the 

search window and that your trigger level is set to a proper value for the levels you see in 

the search window. 

• Use the IF Bandwidth control to reject out of channel signals. WLAN waveforms coexist with 

other signals including WLAN and Bluetooth®. Out of channel energy might interfere with 

the measurement.  

• The BB60C/D is only capable of measuring 20MHz BW OFDM waveforms. 
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4.15 LTE 
Note: The LTE measurements in Spike require that the correct MATLAB® runtime libraries are installed. This is a 

free software download and installation instruction are provided in the Appendix. 

Note: LTE measurements are supported on 64-bit Windows and Linux operating systems only. 

 

LTE measurements can be made using the SM, SP, and BB line of spectrum analyzers. The LTE 

measurement mode in Spike provides basic downlink cell measurements including cell search and 

scanning capabilities. 

The primary measurements available are listed below, 

• Cell search and measurement at a specified center frequency. 

• Cell scanning over a range of specified frequencies and LTE bands. 

o Detected cells are aggregated in a scan results window. 

• Automatic MIB decoding and reporting of cell configuration values, 

o Physical Cell ID 

o Bandwidth 

o Duplex mode 

o Frame configuration 

• Power measurements 

o RSSI/RSRP/RSRQ 

o Frequency error 
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o EVM for PBCH and PSS 

o PAPR calculation 

• Automatic SIB1 decoding and reporting of various cell access related data, 

o All MCC/MCN pairs including Country/Provider lookup 

o EARFCN calculation 

o TAC/Cell Identity 

• Standard spectrum analysis plots for the measured LTE frame 

o AM vs Time 

o Spectrum plot 

o Waterfall plot 

o Constellation for PBCH and PSS 

4.15.1 Measurement Concepts 
Spike supports two LTE acquisition modes, 

1. Single frequency cell search and measurement. This is where the analyzer is tuned to a specific 

frequency. Cell search occurs at this frequency. If a cell is detected, full cell synchronization and 

demodulation occurs. Use this acquisition type when performing transmitter testing or 

characterizing a single cell. This is also the quickest way to determine if a valid cell exists at a 

specific frequency. This is the default measurement in the Spike LTE measurement mode. 

2. Cell scanning. The software scans a range of user configured frequencies/bands looking for cells. 

At each frequency cell search occurs. If a cell is found full synchronization and demodulation 

occurs. The software adds the measurement to the cell search results table, updates the plots 

with the latest measurement, and advances to the next frequency. Specific LTE bands can be 

scanned, or custom frequency ranges can be entered.  

4.15.1.1 Cell Detection 
Spike uses the PSS and SSS for the cell search. The cell must be within +/- 7.5kHz of the selected center 

frequency for a cell to be detected. If the PSS/SSS is detected, Spike uses this to determine the duplex 

mode, cyclic prefix length, and decode the MIB.  

If any step between the start of the cell search process and decoding the MIB fails, the entire 

measurement is considered failed, and the software will report an error measurement status code. If the 

MIB is successfully decoded, the measurement is considered valid, and the software will attempt to 

decode the SIB1.  

The SIB1 is transmitted on even numbered frames. If the frame detected in the cell search process 

above is odd numbered, the software will look at the next frame for the SIB1. Regardless of which frame 

is used for SIB1 decoding, the first valid frame in the captured I/Q data is used for the measurement 

plots. If the SIB1 is not able to be properly decoded, the measurement will continue as valid with the 

fields related to the SIB1 empty.  

This entire measurement process occurs on roughly 40ms worth of captured I/Q data from the analyzer. 

The I/Q data is captured at the highest bandwidth possible to allow all possible cell bandwidths. 
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In the single frequency measurement configuration, the reference level used is specified by the user in 

the Ref Level control. When performing a scan, the reference level is chosen automatically. At each 

frequency the software begins by configuring the analyzer in the most sensitive configuration. If the 

input causes an IF overload, the measurement is retaken with a higher reference level until an IF 

overload no longer occurs. 

4.15.2 Control Panel 
Following are descriptions of the controls found in the LTE settings control panel. 

• Center Freq- Specifies the measurement center frequency when performing single 

frequency measurements. This value is not used when performing cell scans. 

• Freq Step – Specifies the frequency step when using the arrow buttons next to the center 

frequency controls 

• Ref Level – Specifies the measurement reference level when performing single frequency 

measurements.  

• Correlation Threshold – Specifies the cell search correlation threshold. Must be between 

0.0 and 1.0.  

• Include in Results – When enabled, single frequency measurements are placed in the cell 

search results list. 

• Configure Scan – When pressed, brings up a dialog for selecting the bands for the cell 

scan. When finished, the Scan Info label should display a summary of your choices. 

• Scan Type – When set to single, a single scan through all configured bands occurs when 

Start Scan is pressed. When set to continuous, the software will continuously scan the 

configured bands until Stop Scan is pressed or the software leaves the LTE measurement 

mode. 

• Sort By – Determines how the cell search results are sorted by in the cell search results 

table. Choices are sorting by RSSI, frequency, or time. 

• Keep – When result grouping is enabled, and the software detects a duplicate cell, a 

decision must be made to determine which data to show for that grouped cell. This setting 

controls whether the last measurement made is shown in the results table, or the one with 

the highest power.  

• Group Results – When enabled, cell search results are grouped together in the cell search 

results table. Results are considered the same cell when the frequency and Physical Cell ID 

match.  

• Max Results – Determines the maximum number of cells that can be shown in the cell 

search results table.  

• Start Scan – Starts a scan of the user configured bands and shows the cells found in the 

cell search results table. 

• Stop Scan – Use this to stop a cell search mid-scan, or to stop a continuous scan. 
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4.15.3 Cell Search Results 

 
Figure 61: Result of cell scan. 

The cell search results window collects the scan results and if enabled, the single frequency 

measurement results in a simple ordered list. Results can be grouped together or can be individually 

placed in the list. When grouping is enabled, grouping occurs when both the frequency and cell ID 

match. Results can be sorted by frequency, amplitude, or time.  

Each line in the cell search results shows a summary of a cell detected during a scan. The results can be 

cleared at any time or continue to be accumulated for subsequent scans. Results can be exported in a 

CSV format for post processing, or a custom format that can be imported into the software later.  

4.16 MAPPING 

 

Mapping mode binds measurements to geolocations. It includes functionality for georeferenced map 

import, GPS integration, automated measurements, heat mapping, measurement directionality with 

visual triangulation, Received Signal Strength Indicator (RSSI) expressed in the frequency of an audio 
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tone, session import/export, and KML file export for integration with Google Earth and other compatible 

programs. 

4.16.1 Measurements 
Mapping mode can perform channel power measurements or several kinds of LTE measurements. 

These are selected between using the Meas Type selects in the Meas Settings and LTE Settings sections of 

the control panel. 

4.16.1.1 Channel Power 
The channel power measurement type takes a channel power measurement over the center channel 

spanning the Meas Bandwidth, using the configuration specified in the Sweep Settings section of the 

control panel. 

It results in readings for power, peak, and occupied bandwidth. 

4.16.1.2 LTE 
Note: The LTE measurements in Spike require that the correct MATLAB® runtime libraries are installed. This is a 

free software download and installation instruction are provided in the Appendix. 

Note: LTE measurements are supported on 64-bit Windows and Linux operating systems only. 

 

The LTE measurement type performs a single frequency cell search and measurement. The result can be 

specified as either RSSI or RSRP by Meas Type. See LTE Analysis Mode for detailed information about this 

measurement. 

The result  of an LTE measurement can be smoothed by applying averaging over the number of 

measurements specified by Avg Count. 

4.16.2 Measurement Settings Control Panel 
The following is a description of the various controls in the Measurement Settings control panel. 

4.16.2.1 Meas Settings 
• Center Freq – The center frequency of the sweep. 

• Ref Level – The power level of the top graticule line. This should be no lower than the 

maximum expected input level of the signal. 

• Meas Type – The type of measurement to be taken. 

4.16.2.2 Sweep Settings 
• Span – Frequency span around the center frequency. 

• Meas Bandwidth – The bandwidth of the channel bandwidth measurement.  
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• RBW – Resolution bandwidth, using a flattop window. 

• VBW – Video bandwidth. 

• Auto RBW – Having auto selected will choose reasonable and fast RBWs relative to the 

span. When changing span, it is recommended to have this enabled along with Auto VBW.  

• Auto VBW – When enabled, VBW will equal RBW. 

• Video Units – See Sweep Settings control panel. This should be set to Power. 

• Detector – See Sweep Settings control panel. This should be set to Average. 

• Sweep Time – See Sweep Settings control panel.  

4.16.2.3 LTE Settings 
• Meas Type – The type of LTE measurement to be taken.  

• Avg Count – The number of measurements to average. This can range from one (no 

averaging) to 25. 

• Curr Avg – The running count of measurements being averaged into current reading. This 

will not exceed the Avg Count. 

4.16.2.4 Point Settings 
• Declination – The adjustment for declination, specified in positive or negative degrees, 

applied to angles manually entered into the Azimuth field in the detail view of a point in 

map view. Declination can be found using a website such as NOAA. 

• Occupied Bandwidth – The percentage power in occupied bandwidth calculation. 

• GPS Meas Speed – The minimum time passed since last measurement for new 

measurement to be taken. 

• GPS Meas Min Delta – The minimum distance from location of last measurement for new 

measurement to be taken. 

• Max Points – The maximum number of measurements that can be acquired. This will not 

retroactively affect measurements taken. 

4.16.2.5 Audio Settings 
• Audio Enabled – Enables Received Signal Strength Indicator (RSSI) audio tone. This will use 

the system audio configuration. The frequency of the tone increases with the channel 

power of the signal being measured. 

• Volume – The volume of the audio tone. 

4.16.2.6 Plot Settings 
• Map – Shows or hides the map view. 

• Spectrum – Shows or hides the spectrum plot of the current measurement. 

• Measurements Table – Shows or hides the table of measurements. 

 

4.16.3 Map Settings Control Panel 
The following is a description of the various controls in the Map Settings control panel. 

https://www.ngdc.noaa.gov/geomag/calculators/magcalc.shtml
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• Map Scale – The zoom percentage of the map. 

• Point Border – Toggles a black border around points. 

• Point Size – Controls the size of points on the map. 

• Point Opacity – The color opacity of points. 

• Azimuth Lines – Toggles lines drawn on the map from directional points at their azimuth 

angles. 

• Min Color (dBm) – The power that represents the coldest color on the heat map. 

• Max Color (dBm) – The power that represents the hottest color on the heat map. This 

cannot be higher than the ref level. 

• Auto Color – Measurement points are automatically heat mapped based on the power 

range across them. 

4.16.4 Map View 

 

Figure 62: Map view with heat mapped measurements taken of a cell tower signal. 

The map view contains an interactive, georeferenced map with overlayed measurements, along with 

controls and informational readouts. 

A map is loaded by choosing Load Map from the local File menu, and then choosing an image from your 

hard drive. The map is georeferenced by choosing Set Coordinates from the File menu, and entering the 

bounding coordinates, that is the latitude coordinates corresponding to the top and bottom edges of the 

map image, and the longitude coordinates corresponding to the left and right. Map is removed with File 

> Unload Map. Note that this will clear all measurements and georeferencing coordinates. 

See the OSM Map Import Guide for instructions on downloading a georeferenced map from 

OpenStreetMap and importing it into Spike. 

If GPS data is present, either because the device has an internal GPS, or there is an external GPS 

connected to the PC, the user’s current location will be represented by a red target icon on the map. 
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See the GPS section for details on how to configure GPS with the GPS controls at Utilities > GPS Control 

Panel. 

On the map, a point represents a measurement tied to a geolocation and a time. There are three modes 

for interacting with measurements on the map, represented by icon buttons in the upper toolbar: 

1) Select mode – Indicated by the arrow icon, the mouse can be used to select and deselect points. 

When a point is selected, its information is displayed in the detail panel on the right. 

If a point is directional, then its azimuth angle can be changed by selecting it and dragging the 

point around its axis. 

2) Click mode – Indicated by the pencil icon, the mouse can be clicked to capture a measurement 

at the location of the mouse cursor. The point is immediately drawn on the map. 

3) GPS Tracking mode – Indicated by the GPS paddle icon, this mode is available when there is an 

external or internal GPS connected. Measurements are automatically taken at the time and 

minimum distance intervals specified in the GPS Meas Speed and GPS Meas Min Delta fields in the 

Point Settings section of the Meas Settings control panel. 

In the upper toolbar, the map mode is displayed, as well as the number of measurement points 

captured over the maximum points set by the user. 

4.16.4.1 Color Bar 
From red to blue, the color bar shows the hot-cold spectrum to which points are mapped based on their 

measurement results, and what dBm values are represented by the top and bottom. These values can 

be configured precisely using the Min Color and Max Color sliders in the Map Settings control panel. If set 

to Auto Color, then the top and bottom of the spectrum will be determined by the minimum and 

maximum powers of the current set of measurement points.  

4.16.4.2 Measurement Detail Panel 
The measurement detail panel appears whenever a point is selected, and shows all the details of that 

measurement. They are: 

• Frequency – The center frequency at the time of measurement. 

• Bandwidth – The meas bandwidth at the time of measurement.  

• Power/RSSI/RSRP – The measured channel power, RSSI, or RSRP of the signal. 

• Peak – The measured peak power of the signal.  

• Occupied/Cell Bandwidth – The measured occupied or cell bandwidth of the signal. 

• Time – Timestamp for when the measurement occurred. 

• Latitude – The latitude dimension of the point’s geocoordinates. 

• Longitude – The longitude dimension of the point’s map coordinates. 

• Pixels from Left – The horizontal position of the point on the currently loaded map. 

• Pixels from Top – The horizontal position of the point on the currently loaded map. 

• Directional – Whether or not the point has a directional component. 
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• Azimuth – The direction or bearing of the point, specified as an angle in degrees clockwise 

from North, from 0 to 360. If a declination is set in the Declination field of the Meas Settings 

control panel, then it will be automatically applied to any new value typed into this field. It 

will be added once to the angle entered. 

4.16.4.3 Sessions 
A session includes a georeferenced map image, set of measurement points, and measurement and map 

configuration set in the respective control panels. (The latter is what is saved in a preset.) 

Sessions can be imported and exported using Import Session and Export Session in the File menu. A 

session will be saved as three files: one with the .spikemap extension, a JSON format storing the 

measurements and map configuration, a .png file holding the map image, and an .ini file storing the 

measurement configuration as in a preset. If the session is manually moved on the hard disk, all three of 

these files must be moved together to the same directory. 

 

4.16.5 Spectrum Plot 
4.16.5.1 Channel Power 

 

Figure 63: Channel power spectrum plot showing an FM signal. 
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The channel power spectrum plot shows the current sweep, with the channel power measurement 

window shaded, and diamonds indicating the lower and upper bounds of the occupied bandwidth.  

The channel power reading is displayed top center, the occupied bandwidth reading bottom left.  

4.16.5.2 LTE 

 

Figure 64: LTE spectrum plot showing a cell signal. 

The LTE spectrum plot shows the LTE measurement with the cell bandwidth shaded if there is a valid cell 

signal detected. 
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4.16.6 Measurements Table 

 

Figure 65: Table showing all measurements acquired in current Mapping mode session. 

The measurements table displays a full list of all measurements captured in the current session. 

There are several options for export in its File menu: 

• CSV – Points are saved in CSV format to a file on hard disk. 

• KML – Points are saved in KML format, an XML-based geodata format compatible with 

Google Earth, Google Maps, and other programs that support the extension. Measurement 

details are compiled in an HTML table within the description field. Heat mapping will be 

visible in Google Earth. 
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4.16.6.1 Opening a KML file in Google Earth 

 

Figure 66: Opening a KML file in Google Earth. 

To open a KML file of measurement points saved with File > Save KML, open Google Earth in a web 

browser. Click the Projects icon, then click the New project button, and then choose Import KML file from 

computer. 

4.16.7 Audio Received Signal Strength Indicator (RSSI) 
An audio tone can be played which tracks with the channel power of the measured signal. The tone’s 

frequency rises with the signal power. Toggle on and off and set the volume in the Audio Settings section 

of the Meas Settings menu. 
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4.17 VCO CHARACTERIZATION 

 

VCO Characterization mode evaluates the performance characteristics of voltage controlled oscillators 

(VCOs). It includes standard measurements for frequency vs. voltage, sensitivity (frequency change per 

volt), power vs. voltage, current vs. voltage, and harmonic power vs. voltage for the first six harmonics. 

VCO characterization measurements require a PN400 phase noise tester, and are available for SM, BB, 

and SP145 series devices. 
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4.17.1 VCO Settings Control Panel 

 

Figure 67: VCO Settings control panel. 

The following is a description of the various controls in the VCO Settings control panel. 

4.17.1.1 PN400 Settings 
• Status – Indicates whether a PN400 device is currently connected. 
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• Connect – Button to connect a PN400 device. 

4.17.1.2 DC Source Settings 
• Enable Output – The overall state of the PN400 outputs. When disabled, no DC power will 

emit from the PN400. 

• Fixed V Supply – The level of V Supply, the fixed source PN400 output.  

4.17.1.3 Sweep V Tune Settings 
• Start – The starting or lowest control voltage to be measured. 

• Stop – The stopping or highest control voltage to be measured. 

• Meas Points – The total number of voltage points to measure. 

• Dwell Time – The delay between setting the PN400 output voltages and measuring the 

VCO’s response. 

4.17.1.4 Meas Settings 
• Ref Level – The power level of the top graticule line. This should be no lower than the 

maximum expected input level of the signal, that is the output level of the VCO. 

• Auto Freq Band – Automatically determine the frequency range for measurements. 

• Freq Start – The start frequency for each measurement. 

• Freq Stop – The stop frequency for each measurement. 

• Freq Resolution – The RBW of the analyzer sweep at each measurement point. 

• Channel Power Width – The width of the channel for power and harmonics 

measurements. 

4.17.1.5 DC Limits Settings 
• V Tune Min – The minimum output voltage level of the V Tune port on the PN400. 

• V Tune Max – The maximum output voltage level of the V Tune port on the PN400. 

• V Supply Min – The minimum output voltage level of the V Supply port on the PN400. 

• V Supply Max – The maximum output voltage level of the V Supply port on the PN400. 

4.17.2 Measurement Windows 
4.17.2.1 Frequency 
The frequency vs. voltage plot shows the frequency of the VCO’s peak output for a given control voltage. 
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4.17.2.2 Sensitivity 
The sensitivity plot shows the slope of the VCO performance, as the frequency change between 

measurement points in Hz/V. 
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4.17.2.3 Power 
The power vs. voltage plot shows the power of the VCO’s output for a given control voltage. 

 

4.17.2.4 Current 
The current vs. voltage plot shows the current of the VCO’s supply output for a given control voltage. 
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4.17.2.5 Harmonics 
The harmonics vs. voltage plot shows the harmonic power of the VCO’s output for a given control 

voltage, at each of the first six harmonics. 
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4.17.3 VCO Characterization Measurement Walkthrough 
When VCO Characterization mode is entered, Spike will automatically look for a local PN400 and try to 

connect to it. If successful, the Status in the PN400 section of the VCO Settings control panel will show 

the serial number of the PN400 in green. Otherwise, a dialog will be shown alerting the user that a 

PN400 must be connected. At this point, one can be connected to the PC, and the Connect button 

pressed. 

The mode remains in an idle state until Single is pressed to begin taking a measurement. This should be 

done after configuration is complete. 

Initially, DC power on the PN400 is disabled. To avoid VCO damage, it should only be enabled after 

setting appropriate V Tune and V Supply limits in the DC Limits section of the VCO Settings control panel. 

Once this is done, it is safe to enable output in the DC Source section of the panel. 

The rest of the configuration is accomplished in the Sweep V Tune and Meas sections of the control 

panel, and by setting the fixed output level of the PN400 in the DC Source section. 

At each point in the measurement, beginning with the Start voltage and ending with the Stop voltage, the 

PN400 V Tune port is set to output the given voltage, execution is delayed by the dwell time, and the 

analyzer is swept across the automatically or manually defined frequency band using the configured 

frequency resolution (RBW) and reference level. The peak value of this sweep is the basis for the 

frequency measurement. The sensitivity measurement considers the frequency measurement from the 

current and the previous sweep. The power and harmonics measurements derive from channel power 
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measurements taken around the peak and each of the first six computed harmonics using the 

configured channel power width. Current is reported by the PN400. 

A measurement may be aborted at any time using the Abort button in the tool bar. A configuration 

change during a measurement will trigger the measurement to restart with the new configuration. 

5 Taking Measurements 
This section helps a user learn how to measure, analyze, and record signals using the Spike software, 

utilizing built-in features such as markers, record/playback, and channel power. 

5.1 MEASURING FREQUENCY AND AMPLITUDE 
5.1.1 Using Markers 
The software has several tools for identifying a signal’s frequency and amplitude. The easiest to use is 

the marker. There are 6 markers available, each with its own reference. 

To activate and place a marker left click inside the graticule or press the Peak Search button on the 

marker controls to place the marker on the current trace peak and activate it simultaneously. Once a 

marker is active the frequency and amplitude readout of the marker is displayed in the upper right 

corner of the graticule. The marker’s accuracy is dependent on the span and RBW. Narrower spans and 

RBWs have higher marker accuracy. The amplitude accuracy is NOT dependent on the vertical dB/div, 

since the I/Q data is linear in voltage and has much higher resolution than is displayed. The marker may 

be re-placed at any time by clicking the graticule or by using the left and right arrows to shift the marker 

one sample point to the left or right.  

5.1.2 Using the Delta Marker 
To measure differences or changes in frequency and/or amplitude use the Delta markers. To use the 

delta markers, you must first create a reference point. With a marker active, click the Delta button on the 

marker/trace control panel. This places a reference location on the graticule. Now the marker readings 

will report the difference between the marker and the reference. To disable the delta marker, press the 

Delta button again. 

5.1.3 Measuring Low Level Signals 
To measure low-level signals, there are a few tricks to getting accurate readings. First, set the reference 

level to -50 dBm or lower. This internally selects the highest sensitivity settings. Using an external time 

base and narrow span (1 KHz or less) should give the best results. Video averaging may be required for a 

stable amplitude reading. 
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5.2 SWEEP RECORD AND PLAYBACK 
Spike provides the ability to store and playback a sequence of sweeps from any Signal Hound spectrum 

analyzer. Several controls exist which make it easy to perform short term acquisition and analysis or long 

recording projects such as spectrum monitoring. Sweep recording files store a series of sweeps along 

with configuration information to a file with the extension (.shr). 

 [Version 3.1.13 introduced the SHR file format but will continue to playback the BBR file format from earlier 

versions of the software. As of version 3.1.13 the software no longer generates BBR file.] 

5.2.1 Sweep Recording 

 
Figure 68: Active sweep recording. 

The sweep recording control panel is enabled in sweep and real-time analysis modes. Most controls on 

the recording panel are used to control the amount of data stored. Many Signal Hound spectrum 

analyzers sweep at rates that produce very large recording files if not properly managed. The available 

controls provide two ways to reduce the amount of data stored. 

1) Decimation in time – Decimation in time refers to the action of averaging or max-holding 

several sweeps over time. You can control either the amount of time or the number of sweeps 

you wish to decimate for. For example, selecting a 1 second decimation time and max hold 

decimation detector, the software will perform a max hold detector on sweeps over a 1 second 

duration, at which point the max held sweep will be stored to the file. This creates a file with a 

sweep being stored every 1 second. By specifying a sweep count, a similar effect is achieved, 

except instead of waiting for a specified duration, the detector operation will occur on ‘count’ 

number of sweeps. 

2) Decimation in frequency – Decimation in frequency refers to channelization of the sweep 

using a channel power measurement. The channel width and center frequency of the channels 

can be selected. The output of the channel power measurement can be stored in dBm or 

dBm/Hz units. For example, a channel center frequency of 2440MHz and channel spacing of 

1MHz will perform the channel power measurement on 1MHz channels evenly spaced 1MHz 

apart from the frequency of 2440MHz. The channel center frequency specified can be the center 

frequency of any channel. 

Both decimation types can be enabled simultaneously, at which point the channelization will occur 

before the decimation in time. If no decimation is required (i.e. store every sweep from the device), 

disable the channelizer and select the decimation type ‘count’ with a decimation count of 1. 
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In addition, the amount of data stored can be limited using the maximum file size and maximum file 

count settings.  

Press the Start Recording button to begin recording. The first file is created immediately in the configured 

directory. When the max file size is reached, recording will continue in another sequentially numbered 

file, until the maximum file count is reached. Pressing the Stop Recording button ends the recording 

session.  

5.2.2 Sweep Playback 

 
Figure 69: Playback of recorded SHR sweep file. 

To begin a playback of an SHR sweep recording file, press the play icon button on the Sweep Playback 

control panel. After selecting a valid file, sweep playback should begin immediately. Use the slider bar as 

well as the pause, step, and rewind buttons to control the playback. The playback speed determines the 

amount of time to wait before showing the next sweep in the recording. For example, a playback speed 

of 1 second plays sweeps from the recording at a rate of 1 per second. 

When replaying a saved session, all measurement functionality of the software remains, such as 

markers, min/max/avg traces, channel power, occupied bandwidth, persistence, and spectrogram views.  

When finished, press the stop icon button and software control will return to the connected analyzer. 

 

Tip: The title is also saved and shown 
during playback. Use a title to describe the 
session! 
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5.3 I/Q RECORDER 

 

Figure 70: I/Q Recorder Utility. 

The I/Q Recorder utility is used to perform dedicated short to long-term I/Q captures to disk. The I/Q 

recorder utility can be accessed through the Utilities drop down menu. 

It provides simple configuration for the device, file system, and data format, a minimal spectrum preview 

window with adjustable RBW, and an informational readout of critical information during capture. 

5.3.1 Configuration 
The following are descriptions of the various settings and displays on the control panel, used to 

configure the capture and preview window, and monitor relevant information. 

5.3.1.1 Capture 
• Center Freq – Specifies the tuned center frequency of the capture, ie. the 0Hz frequency of 

the I/Q data. 

• Ref Level – Specifies the expected input power of the signal. This controls the reference 

level and the gain and attenuation. 
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• Sample Rate – Selects the sample rate of the current visible I/Q data capture. This number 

is equal to the device sample rate divided by the decimation value. 

• Bandwidth – Controls the bandwidth of the passband filter applied to the I/Q data stream. 

The bandwidth cannot exceed the Nyquist frequency of the I/Q data stream. 

• Auto Bandwidth – When set to Auto, the Bandwidth passes the entire bandwidth of the 

I/Q data capture. 

5.3.1.2 Preview 
• RBW – The desired RBW for the spectrum preview plot. Lower RBWs increase the required 

FFT window length. If the FFT window length is not long enough to achieve the desired 

RBW, the spectrum window will show a warning and the user will need to increase RBW to 

display the spectrum plot. 

5.3.1.3 File 
• Save Directory – Selects the directory for the I/Q waveform files to be stored. 

• File Prefix – Applies a file name prefix to all files saved. Useful for creating identifiable file 

names. By default, the file name includes a second-resolution timestamp and sequence 

number. 

• Max File Size – Specifies the maximum amount of data to store in a single file. 

• Max Files – Specifies the maximum number of files to write. 

• Max Disk Usage – Specifies the maximum percentage of the hard disk that can be used. 

The hard disk is determined by the Save Directory. 

• Data File Format – Selects the file format to be used when saving I/Q data. By default, this 

is set to binary 16-bit complex integers. 

5.3.1.4 Informational 
• Data Saved – Displays the total amount of data written during the current capture.  

• Files Saved – Displays the number of files written during the current capture. 

• Disk Free – Shows the percentage of the hard disk that is free. The hard disk is determined 

by the Save Directory.  

• Rate – Shows the current rate of data being captured and written to disk. 

5.3.2 Recording 
Acquisitions begin by pressing the Record button located in the control panel. 

 

The capture begins immediately, and data is saved in sequentially labeled files in the Save Directory. Each 

file is prefixed with File Prefix, followed by a second-resolution timestamp tied to the start of the capture 

(not the start of the file). Each file has a maximum size specified by Max File Size. 

 

Recording proceeds until one of the following events occurs or conditions is met: 

1) The user presses the Stop button. 

2) Max Files have been written to disk. 

3) Disk usage will exceed Max Disk Usage. 
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Several statistics in the Informational section of the control panel show you the status of the acquisition 

and the current capacity remaining on the selected disk drive. 

5.3.3 I/Q File Formats 
Each I/Q capture is saved as a sequence of files holding the waveform data in the format specified by the 

“Data File Format” dropdown in the “File” section of the control panel. 

The available formats are listed and described below. 

5.3.3.1 16-Bit Binary 
Files saved in the 16-bit binary format contain I/Q values as signed 16-bit complex integers. They have 

little-endian byte ordering. Samples are stored in sequential order as 

 

 I1, Q1, I2, Q2 … In, Qn 

 

The values are stored as full scale, ranging from -32768 to +32767, representing floating point values 

between -1.0 and 1.0. To convert these samples to floating point, 

 

1) Read the samples from the file into signed 16-bit complex integer values. 

2) Convert to full-scale floating-point values with the following equations, 
o float re32f = (float)re16s / 32768.0; 

o float im32f = (float)im16s / 32768.0; 

The data should now be floating point values between [-1.0, 1.0) 

3) Optionally, if you want to recover the amplitude accurate I/Q samples referenced to dBm, use 

the following equations, 

o CorrectionFactor = sqrt(10^(refLevel in dBm / 10.0)); 

o Re32f *= CorrectionFactor; 

o Im32f *= CorrectionFactor; 

Once scaled, the I/Q data can then be converted to a dBm value rather than a dBFS value using 

the equation, 

o Sample power (dBm) = 10.0 * log10(re32f * re32f + im32f * im32f); 

5.3.4 Preview Window 
The preview window shows a spectrum plot of the waveform being recorded. It applies a single FFT 

using the specified RBW across a portion of the capture, and updates at a rate of roughly 10 FPS. 

The preview window plot adheres to the basic plot interface in Spike. 
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5.3.5 Precautions 
Precautions must be taken when performing I/Q captures to ensure your existing data does not become 

corrupted and your I/Q waveforms are captured without error. Below is a list of recommendations and 

precautions when using the I/Q record capabilities of the Spike software. 

1) Store waveforms to an external hard drive and not the operating system (OS) hard drive. If your 

OS hard drive approaches 100% capacity, you will run into issues which will prevent your OS 

from operating properly. If you absolutely must store I/Q waveforms on the same drive as your 

OS, keep 20% of the disk free (Windows suggests 15%).  

You can set an upper limit on this using the Max Disk Usage field in the File section of the control 

panel. The default value is 80%. 

2) Calculate the expected capture size beforehand using this simple formula: 

𝑆𝑖𝑧𝑒 𝑜𝑓 𝐶𝑎𝑝𝑡𝑢𝑟𝑒 (𝐵𝑦𝑡𝑒𝑠) = 𝑀𝑎𝑥 𝐹𝑖𝑙𝑒𝑠 ∗ 𝑀𝑎𝑥 𝐹𝑖𝑙𝑒 𝑆𝑖𝑧𝑒 (𝑘𝐵) ∗ 1000 (
𝐵

𝑘𝐵
) 

3) Ensure your hard drive write speed exceeds the acquisition speed of the analyzer. For many 

sample rates standard hard drive write speeds will be insufficient to sustain long term captures. 

This will create gaps in the data which will affect the quality of your measurements. The record 

speed will depend on the data file format. For 16-bit binary data, a simple calculation of the 

record speed is  

𝑊𝑟𝑖𝑡𝑒 𝑆𝑝𝑒𝑒𝑑 (𝐵𝑦𝑡𝑒𝑠 𝑝𝑒𝑟 𝑠𝑒𝑐𝑜𝑛𝑑) = 𝑆𝑎𝑚𝑝𝑙𝑒 𝑅𝑎𝑡𝑒 ∗ 4 

It is expected the hard drive write speed exceeds this value by a reasonable margin. For some of 

the highest sample rates, a performance hard drive configuration will be necessary. For 

example, at its highest sample rate, the SM200C can output 800 MB/s of data. 

When evaluating high performance drives to handle this throughput, make sure to note the spec 

for sustained write speed and not just burst speed. Otherwise, it will fall behind after writing a 

fixed amount of data. 

4) Ideally, an operator should be present at the software and monitoring the acquisition status. 

Consider performing test runs on known signals to ensure your acquisitions settings are correct 

before committing to a long acquisition process. 

5.4 CAPTURING SIGNALS OF INTEREST 
CSV files can be created of traces with the Trace Export button found on the control panel. CSV files are 

useful for performing further signal analysis or plotting outside the Signal Hound application. When 

exporting a trace into a CSV file, the currently shown trace is exported. Because of this it may be difficult 

to obtain a CSV file of a signal of interest. For example, an intermittent signal which appears sporadically 

may be difficult to capture, or some modes such as Real-Time signal analysis are prohibited from saving 

CSV files.  
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One way to export a desired signal is to record the spectrum using the playback toolbar. After capturing 

a signal via recording, the session can be played back and paused on the signal of interest. From there, 

the signal can be exported or measured through standard means. 

Min and Max hold traces are another way to capture intermittent hard to view signals. Min and max hold 

keep track of the minimum and maximum values over a period storing them in a separate viewable 

trace.  

5.5 CHANNEL POWER 

 

Figure 71: Channel Power control panel measuring a broadcast FM signal. 

The Channel Power control panel configures, measures, and logs a main channel and 5 adjacent 

channels, each consisting of a lower and upper component.  

The main channel controls are on the left. Channel power can be enabled from here. This applies to all 

channel power measurements, so the main channel must be enabled to take measurements on the 

adjacent channels. Target specifies which trace will be used for measurements. Channel width specifies 

in Hz the width of the band to measure. Power displays the channel power of the main channel. Start 

Logging creates a new CSV file and logs the main channel and all enabled adjacent channels for each 

sweep. Logging continues until Stop Logging is pressed. Change Directory sets the directory in which to 

save log files. 

The adjacent channels are listed as rows in the table on the right. The first three fields are for 

configuration, the rest for measurements. The state field is used to enable or disable the channel. Offset 

refers to the center-to-center frequency difference between the center channel and the adjacent 

channel. Between channels, there is typically (but not always) a small guard band whose power is 

ignored. Bandwidth specifies the width in Hz of the adjacent channel. 

The adjacent channels, which have a lower and upper component, show the channel power as well as 

the difference in power between the center channel and themselves. In the example below the 

difference might be used to determine if any power is “leaking” into an adjacent FM band. 

For example, the image below shows a channel bandwidth of 180 kHz with one adjacent channel with an 

offset of 200 kHz. The image shows the FM station 101.1 in the center channel. Each channel will be 

integrated and the resulting power is displayed in the table. 
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Figure 72: Channel Power on a Broadcast FM Signal 

For best results, set the video processing to AVERAGE, POWER, and turn spur reject off. The software will 

throw a warning if the settings are not configured properly when activating channel power. 

5.6 INTERMODULATION DISTORTION 

 

Figure 73: Intermodulation Distortion control panel. 

The Intermodulation Distortion control panel measures intermodulation products and computes third-

order intercept. 

It is expected that two signals are injected, one with lower frequency F1, and the other with higher 

frequency F2. The two highest peaks are found, and considered to be F1 and F2. From these points the 

third-order products 2F1 – F2 and 2F1 – F2 are derived. These four points are displayed on the graticule as 

trace markers. 
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Aside from frequency and amplitude, the table shows two additional calculations for the third-order 

products. Amplitude (dBc) is the differential amplitude between the third-order products and the base 

tones, and TOI is the third-order intercept point. They are calculated as follows (only the lower 

calculations are shown): 

∆𝑃𝐿𝑜𝑤𝑒𝑟 = 𝑃𝐼𝑀3𝐿𝑜𝑤𝑒𝑟
−

2 ∗  𝑃𝐿𝑜𝑤𝑒𝑟 + 𝑃𝑈𝑝𝑝𝑒𝑟

3
 

 

𝑇𝑂𝐼𝐿𝑜𝑤𝑒𝑟 =
𝑃𝑈𝑝𝑝𝑒𝑟

2
+ 𝑃𝐿𝑜𝑤𝑒𝑟 −

𝑃𝐼𝑀3_𝐿𝑜𝑤𝑒𝑟

2
 

5.7 TRACE MATH 

 
Figure 74: Power difference function measuring signal power below the instrument noise floor. 

Trace math performs simple math operations between 1 or 2 traces and stores the results in a user 

specified result trace. The source and result traces are selectable from the 6 user customizable traces. 

The math operations available are listed below. All operations are defined using a logarithmic plot scale. 

If linear mV scale is used, the result is converted to mV. All operations are performed on a bin-by-bin 

basis. 

• Power difference: A power difference is calculated between two traces and stored in the 

result trace. 

o Result = Log(Power(Op1) – Power(Op2)) 

• Power sum: A power sum is calculated between two traces and stored in the result trace. 

o Result = Log(Power(Op1) – Power(Op2)) 
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• Log Offset: A dB offset is applied to a single trace and is stored in the result trace. 

o Result = Log(Op1) + offset (dB) 

• Log Diff: A log difference is calculated between two traces and stored in the result trace. An 

additional dBm offset is applied to the difference. 

o Result = Log(Op1) – Log(Op2) + offset (dBm) 

When trace math is enabled, the trace math operation occurs at the time the result trace is normally 

processed. User traces are processed in order (1,2,3,4,5,6) after a sweep is retrieved from the spectrum 

analyzer. For example, the trace math operation {3 = 1 – 2} occurs when trace 3 is to be processed. In 

this example, trace 1 and 2 are already processed before the trace math operation occurs. An operation 

such as {2 = 1 – 3} means that trace 2 will be the result of trace one (updated just before trace math 

occurs) minus trace 3 (last updated on the previous sweep). 

A sweep must be retrieved from the analyzer before a math result can be displayed. Ensure all traces in 

the math equation are enabled (type not set to Off) to see the trace math result. Trace type operations 

can be combined in conjunction with trace math. For instance, trace math can be enabled with a result 

trace of 3, and trace 3 can also have trace averaging enabled. Markers can be placed on math result 

traces as normal. Use offsets for log operations to offset the result into the plot window. 

If the power diff operation is selected, any negative or zero valued bins calculated as the result of the 

difference are replaced by the smallest non-zero value in the trace after the difference operation is 

performed. 

5.8 USING THE REFERENCE LEVEL OFFSET 
When measuring a signal that has been attenuated or amplified it is useful to let the software adjust the 

measured signal by this offset. In Spike, you can enter this gain/attenuation value so you can directly 

view the corrected measurement. 

The proper way to set the reference level offset in Spike is the set the reference level offset and then set 

the reference level to the value you want to see after the offset is applied. For example, if you are viewing 

a 30dBm signal that is being attenuated by 40dB, first set the reference level offset to 40dB, then then 

set the reference level to 30dBm. 

5.9 NOISE MARKERS 
Noise measurements are made using the noise markers in the Spike software. To enable this 

measurement, change the active marker type to ‘Noise’ and place the marker on the spectrum. 

Noise marker measurements are only available in sweep and real-time modes, and with the average 

video detector enabled. For the most accurate measurements, average detector and power video units 

should be selected. 

The noise measurement reading is normalized to 1Hz and accounts for the under response due to either 

log or voltage scale VBW averaging. The measurement is averaged over ½ a division. The formula used 

for calculating the noise reading is below. 
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𝑃𝑑𝐵𝑚/𝐻𝑧 = 10 ∗ 𝑙𝑜𝑔10 ∑ (
𝑃𝑚𝑊

𝑆𝑝𝑎𝑛𝐻𝑠 ∗ 𝑁𝐵𝑊
)

𝑓2

𝑓1

+ 𝐶𝑑𝐵 

Where NBW equals the RBW filter (window function) noise bandwidth. f1 and f2 are frequencies 

spanning ½ a display division and are centered on the marker frequency. C is a constant, where C = 0.0 

when power video units are selected, C = 2.51 for log video units, and C = 1.05 for voltage video units. 

5.10 CHANNEL POWER MARKERS 
Channel power measurements can be made quickly using the channel power markers in the Spike 

software. To enable this measurement, change the active marker type to ‘Channel Power’ and place the 

marker on the spectrum. 

Channel power marker measurements are only available in sweep and real-time modes. 

The bandwidth of the channel to be measured is specified using the Ch Power Width field. 

5.11 N DB MARKERS 
An N dB marker can be used to measure the bandwidth of a signal in the Spike software. To enable this 

measurement, change the active marker type to ‘N dB’ and place the marker on the spectrum, on a peak. 

N dB measurements are only available in sweep, real-time, and scalar network analysis modes. 

Typically used to measure the bandwidth of a filter, the marker is placed on a peak, and the left and right 

arrow markers are shown about N dB down the transition band on either side of the peak. The result of 

this measurement is the frequency difference between these two arrow markers. 

The value of N, called the offset, is specified using the N dB Offset field. 

The N dB measurement works by looking for the closest point on either side of the primary marker that 

is at least N dB down from the primary marker, and then choosing the point with distance closest to this 

offset value.  

If no point is found on either side that is at least N dB down, then the measurement returns a result of “--

-” and the arrows are shown at the primary marker. 

5.12 RBW FILTER SHAPE 
Selecting the RBW filter shape affects how the spectrum analyzer achieves the desired RBW. Different 

shapes affect which window function is used and how the bandwidth is defined. Not all shapes are 

available for all devices or in all modes. Here is a short description of the filter shapes Signal Hound 

provides. 
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Flat Top – When this shape is selected, a variable bandwidth flat top window defined at the 3dB point is 

used to achieve the desired RBW. The flat top window is selected by default and is recommended for the 

most accurate measurements as it has very low scalloping loss. 

Nuttall – When Nuttall is selected, the analyzer uses a fixed bandwidth Nuttall window defined at the 

3dB point and powers of two FFTs with zero-padding to achieve discrete RBW values. Nuttall windows 

offer the fastest sweeps with the lowest number of points in the sweep to achieve the RBW selected. The 

downside of the Nuttall shape is the high scalloping loss at around 0.8 dB. 

CISPR – When CISPR is selected, the analyzer uses a Gaussian window defined at the 6dB bandwidth 

point and zero padding to achieve the selected RBW. This shape is commonly used for EMC/EMI pre-

compliance measurements. 

5.13 USING THE MEASURING RECEIVER UTILITY 
The Spike software provides the functionality of a measuring receiver to make tuned RF level 

measurements (TRFL). TRFL measurements are useful for characterizing attenuators, signal generators, 

or any device on which a user wants to measure the accuracy of incremental steps in the output power.  

TRFL measurements are capable of making more accurate power level readings and carrier frequency 

readings than in standard swept analysis mode and is capable of measuring power to much lower levels 

than in swept mode. 

The measuring receiver utility can be accessed through File Menu → Utility → Measuring Utility. Enabling 

the utility will bring up the dialog box shown below. 
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Figure 75: Measuring Receiver Control Dialog 

5.13.1 Measurement Procedure 
This section outlines the procedure for making TRFL measurements with the measuring receiver utility. 

1. With the Signal Hound device connected to the PC and application software running, select 

Measuring Receiver from the Utilities file menu. 

2. The measuring receiver will open and perform a 3-second calibration. Wait for this calibration to 

finish and connect the unit under test (UUT). 

3. Prepare the UUT by selecting the maximum output power and center frequency of the device. 

Ensure the UUT output is a CW signal. 

4. Prepare the software by entering the center frequency of the UUT and pressing Sync which 

recalibrates the measuring receiver for the new center frequency.  

Note: For correct operation, ensure the frequency entered is close to the output frequency of the UUT. 

After step 4 above, verify the RF Power and RF Frequency readouts are correct and ensure the Relative 

Power readouts are stable and very close to zero. A user is now ready to begin making stepped output 

power measurements. Perform the following steps for each output power level step. 

5. Decrease/step the output power level of the UUT by no more than 10 dB. 

6. Record any relevant readouts. 
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7. If the measuring receiver suggests recalibrating the device at a new power range, do so now. 

Recalibration takes about 3 seconds and is necessary to make continued accurate 

measurements to lower power levels. 

8. Return to step 5. 

To start the test over, select a new center frequency or press the Sync button and start over from step 1.  

Be careful of IF overload messages which warn that the UUT output power is too large for the current 

power range. Avoid this by either decreasing the UUT power or pressing the Sync button to return the 

measuring receiver utility to the highest power range.  

As the output power of the UUT, the measuring receiver prompts the user to enter new power ranges. 

The ranges are finite and a warning will be issued if the user has stepped over a range. To resolve this, 

increase the UUT output power slowly until entering the next lower power range. 

5.14 TIPS FOR BETTER MEASUREMENTS 
Signal Hound spectrum analyzers have internal gain and attenuation settings that are automatically 

adjusted for the selected reference level. While the software allows the user to manually control these 

settings, the AUTO value should be used for nearly all measurements. Manual control may place the 

compression point below the reference level, add spurious or residual signals, or raise the noise floor. 

There are times when a user wishes to increase the attenuator by 5 or 10 dB to improve linearity. This 

can be important for reducing the amplitude of intermodulation products. Rather than changing the 

attenuator setting, simply change the reference level. This is easier and more predictable than manually 

controlling the attenuator. 

For the best sensitivity and lowest noise floor, set the reference level at, or just above, the maximum 

input amplitude. To improve linearity and reduce intermodulation products, set the reference level 10 or 

20 dB above the signal level. 

For narrow-band and CW signals, the noise floor comes down approximately 3 dB for each decrease in 

RBW. When measuring low-level CW signals, narrower RBWs are recommended. 

For maximum sensitivity, a reference level of -50 dBm or lower is recommended. This will set the 

attenuator to a minimum and set the internal gain to a maximum.   

When the detector is set to “average” this is the equivalent to setting the minimum VBW for the current 

setup. This will have the lowest peak-to-peak noise floor but will also average intermittent signals. Set 

VBW to auto and the detector to “MIN/MAX” or MAX to measure pulsed or intermittent signals. 

For making average power measurements, make sure the detector is set to “average” and “power.” If the 

signal is modulated, either set the RBW wider than the modulation, or center the signal and use the 

channel power utility. 
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6 Additional Features 
The Spike software has several useful utilities. They are described here. 

6.1 SCPI 
The Spike software is programmable using SCPI commands. The Spike software maintains a SCPI TCP/IP 

socket connection on port 5025 (default). The connection can be disabled, and the port number can be 

changed through the preferences menu. 

When a SCPI connection is active and a command is received, the Spike software enters a remote 

operation mode. When in remote operation, a modal dialog appears in the center of the Spike 

application. To return to local operation either press the “Return to Local” button or close the dialog. If 

another SCPI command is received, the dialog will reappear. 

For programming information regarding Spike and SCPI see the Spike SCPI programming manual in the 

SDK download located on the Signal Hound website (on any device download page). 

 

Figure 76: SCPI Remote Mode Active Alert Dialog 

6.1.1 SCPI Log 
When logging is enabled, SCPI commands received, and responses sent by Spike are logged with 

timestamps. The log can be viewed in a non-modal dialog via the Utilities → SCPI Log menu option. 

In the upper left of the dialog, running counters show the number of commands received, responses 

sent, and total messages handled. 

The log’s active state is shown in the upper right of the dialog. It can be enabled or disabled in the SCPI 

preferences. A few milliseconds of overhead can be saved by disabling SCPI logging. 

The log can be exported as a plain text file using the “Export” button. 

The log can be cleared using the “Clear” button. 
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Figure 77: SCPI Log 

6.2 PRINTING 
Use the File → Print menu to print exactly what is shown on the graticule. Be careful, if the software is still 

updating traces, the software may not print the desired trace. Use the print preview option to see exactly 

what will be printing. Use the Single button to stop the measurement updates to guarantee you print the 

desired signal. 

 

6.3 SAVING IMAGES 
Use the File → Save to Image menu option to save the current graticule view as a PNG, JPG, or BMP image. 

The resulting resolution of the image is the exact resolution of the graticule at the time of the save. To 

obtain the highest resolution image, maximize the software and slide the control panels out of the way. 

The active color scheme is used in the resulting image. 

6.4 CORRECTION DATA 
Use the File → Manage Correction Data menu option to open a dialog that provides some useful 

correction data management functions. 

Tip: The active color scheme is used for 
printing as well. Under the View – Colors 
menu, we provide a simple printer 
friendly color scheme to help save ink! 
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Figure 78: Manage Correction Data Dialog 

Correction data is pulled from some Signal Hound devices and cached locally for faster access. It is 

sometimes necessary to manage this data. For example, when a device is recalibrated a new correction 

file is generated for it, rendering the old one obsolete. Simply removing the old one will cause the 

software to pull the new one from the device. This is done using the “Clear Correction Data” button. 

There are two available functions. 

1) View Correction Data: This opens the directory on your computer which contains correction 

data files for Signal Hound devices in Windows Explorer. 

2) Clear Correction Data: This removes all correction data files for Signal Hound devices that have 

been cached on your computer. When a device is connected, its correction file will be re-cached. 

You should only use these functions if you have recently had your device calculated, or if instructed by 

Signal Hound Support. Not all analyzers store calibration data on the device. If you have an older SA 

series device, make a copy of the calibration data before clearing any data. 

6.5 NETWORK DEVICES 
This section covers the configuration and connection of networked (10GbE) devices in Spike. This section 

applies to the SM200C, SM435C, and PCR4200 devices. 

6.5.1 Connecting Networked Devices 
Use the File → Manage Ethernet Devices menu option to open a dialog that provides Ethernet device 

management functions. 
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Figure 79: Manage Ethernet Devices Dialog 

The device’s IP address and port must be known in advance prior to opening the device. This dialog 

allows you to register several networked devices in the Spike software by specifying the IP and port 

address of the device. When a device is added to this list, it will appear in the File->Connect menu. 

When adding a new device to this list, the default IP and port addresses are used. If you haven’t modified 

your devices IP/Port, use the default values. The host IP address refers to the network interface that the 

device is connected to. 0.0.0.0 is the address used for ‘any’ which means that the PC will resolve this later. 

We recommend setting the host IP address to actual address of the NIC, and not the “any” address. 

Note that a device does not need to be connected to the computer to save or edit a device in this list, but 

the device will need to be connected to connect via File > Connect. 

There are two available functions. 

1) Add Device: This adds a new Ethernet device with default settings. 

2) Delete Device: This removes the Ethernet device currently selected in the list. 

6.5.2 Networked Device Configuration 
This utility is used to modify the IP address and port of a networked device.  

The network address of the SM200C and SM435C devices can be updated over USB or the network. The 

PCR4200 network address can only be updated via USB.  

To access the network configuration dialog, no device should be connected and active in Spike. Then in 

the Utilities drop down menu, select either SM Network Configuration or PCR Network 

Configuration. 
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6.5.2.1 Configuring Over USB 
If configuring over USB, ensure the networked device is connected to the PC with the provided USB 

cable. In the “Via USB” tab, press the “List Devices” button to show all networked devices connected to 

the PC over USB. If no devices are found, troubleshoot the USB connection to the PC. 

Once the target device can be found with “List Devices”, specify the target device serial number and new 

network settings you wish to apply to this device. Once finished, press the “Program Device” button. It 

will take a few seconds to program the new settings. At this point, “List Devices” should show the 

updated network settings.  

When non-volatile is unchecked, the new settings will not persist through a device power cycle. 

 
Figure 80: Configuring the network address over USB. 

6.5.2.2 Configuring Over UDP 
When configuring over UDP, the new settings are sent in a broadcast UDP packet. For this reason, only a 

single SM200C/435C should be connected to the local network interface. While specifying the “any” 

address often works, when possible, it is best to specify the host address directly. The update will report 

failed if changing to a new subnet, but the update may have still been successful. 
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Figure 81: Configuring the network address over UDP. 

6.6 PATH LOSS, LIMIT LINE, AND ANTENNA 
FACTOR FORMAT 

All correction and limit tables are loaded into the software in CSV file format. This means each value is 

separated by a comma, and each logical set of values is separated by a newline. These types of files can 

be edited in spreadsheet document software or even a basic text editor. 

Values provided are then linearly interpolated. 

Path loss tables are [Frequency (MHz), Gain (dB)] pairs which describe the response of one or more 

components in the system. A path loss table might look like this 

20.0, 0.1 

200.0, 0.4 

2000.0, 1.7 

… 

Path loss tables are applied to the received sweep before being displayed or processed. The first and last 

values are extended to the start and stop frequencies of the sweep configured. It is good practice to 

prefix and postfix your table with zeros if you do not wish to extend your corrections beyond the defined 

frequency range. 

Antenna factor tables are [Frequency (MHz), Antenna Factor (dB/m)] pairs which describe the response 

of an antenna. These tables have the same structure and behavior as path loss tables except they 
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change the units of measurement to one of electric field strength. Electric field strength measurements 

are used in compliance testing. 

Limit lines are of the form, [Frequency (MHz), Limit(dBm)]  

Limit lines are only tested within the frequency range of the lowest and highest frequency point. 

The limit lines are drawn on the graticule and each sweep is tested against them. Indicator text will 

appear in the center of the screen denoting whether the trace currently shown passes or fails the limit 

line test. 

Here is an example of a path loss CSV file built in a spreadsheet program. 

732 0 

738 2 

 

And here are the resulting path loss corrections applied to incoming traces for a 10MHz span centered at 

735 MHz: 

   

We can see the linear interpolation between the two points and flat lines off the sides. 

6.7 MANAGING PATH LOSS TABLES 
The path loss table dialog provides a user with the ability to manage up to 7 path loss tables and one 

antenna factor correction table. Loss tables are [frequency, dB] pairs which characterize loss or gain in 

the system. Typical use of loss tables corrects for cables, amplifiers, or attenuators. Antenna factor tables 
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are [frequency, dB/m] pairs which describe the response of an antenna and are generated by calibrating 

an antenna. Only one antenna factor table can be loaded and should be loaded into the appropriate 

spot to ensure the software recognizes its presence.  

See Path Loss, Limit Line, and Antenna Factor Format for more information. 

Tables can be loaded and removed through the dialog. The file names of the tables are stored with the 

presets and are loaded automatically when loading a preset later. If the file name has changed or moved 

since the preset was saved, then the table will be removed.  

6.7.1 When Are Path Loss Tables Applied? 
Path loss tables are applied in two ways. 

1) Full: The user provided path loss tables are applied at each output frequency point in the 

measurement.  

2) Single: Path loss applied at a single frequency: The measurement is corrected for a single 

frequency, usually the center frequency of the configured measurement. This is equivalent to a 

flat dB offset across the measurement. 

 

Each measurement mode in Spike applies path loss in one of the ways mentioned above. Below is a list 

of each measurement mode in which path loss is applied and denotes which application method is used. 

 

Measurement Mode Path Loss Method 

Swept spectrum analysis Full 

Real-time spectrum analysis Single 

Zero-span Single 

Harmonics viewer Full 

Scalar network analysis Full 

Phase noise None 

Modulation analysis Single 

EMC precompliance Sweeps: Full, QP Detector: Single 

Analog demod Single 

Interference hunting Full 

Measuring receiver None 

Spectrum Emission Mask Full 
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6.8 MANAGING LIMIT LINES 

 

Figure 82: Limit Line Manager 

The limit line dialog provides a user the ability to configure up to 6 limit lines. Each limit is stored as 

frequency amplitude pairs. The points tested against the sweep are interpolated from the limit line 

values. The limit line can be configured to act as a maximum or minimum threshold. Limit lines can be 

loaded from CSV files. See Path Loss, Limit Line, and Antenna Factor Format for more information. Limit 

lines are also stored in the presets. 

6.8.1 Settings 
• Enabled – Activates/deactivates limit line. 

• Name – The name of the limit line. This will be displayed on the plot if “Show Result” is 

checked. 

• Trace – Sets the trace the limit line acts upon. 

• Type – Sets whether the line is an upper or lower bound. 
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• Reference – Sets whether the frequencies are specified as fixed or relative (to center) 

values. 

• Convert To – Converts the limit line’s reference mode between fixed and relative. This 

recalculates the points based on their current position on screen. 

• Interpolation – Specifies whether linear or logarithmic interpolation is used. 

• Color – Sets the color of the limit line. 

• Pause On Break – When enabled, Spike will switch to single step mode if the limit line is 

violated. 

• Show Line – Sets the visibility of the line on the plot. 

• Show Result – Sets the visibility of the name and pass/fail status on the plot. 

• Offset – Sets an offset to be applied to all the points in the line. 

• Points To Build – Specifies how many points should be used when building a line from the 

current trace. 

• Build Line – Constructs new limit line data from the current trace, using the number of 

points set in “Points To Build”. 

• Modify Points – Opens the limit line table editor for editing individual points. 

• Copy To – Copies the limit line’s points, type, reference, and offset to the selected limit line. 

• Number of Points – Displays the number of points in the limit line. 

6.9 AUDIO PLAYER 
Using the Utilities →Audio Player menu option, a user can utilize the software to play broadcast audio. 

When using SpikeTM for audio playback, the dialog box below will appear. 

 

Figure 83: Audio Player 

Change the center frequency using the arrow keys, pressing the fine tune frequency adjustments, or 

through manual entry. The initial center frequency is the same center frequency displayed on the 

graticule when selecting the Audio Player menu option. A user can also manually change or select 

various bandwidths and the type of demodulation. A user may also specify audio low pass and audio 

high pass filter cutoff frequencies. 

All audio related variables other than center frequency are saved with presets. 
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6.10 FREQUENCY DIFFERENCE METER 
Spike provides a frequency difference utility to determine the frequency difference between two stable 

oscillators. The frequency difference is displayed as a digital readout as well as a zero-centered meter 

with selectable parts in 106, 107, 108, 109, 1010, and 1011. The frequency difference meter accepts 

frequency inputs across the entire operating frequency range of the spectrum analyzer. The types of 

measurements available through the frequency difference meter include, measuring, offsetting, and 

adjusting your oscillator, and analyzing the stability of your oscillator. 

 
Figure 84: Frequency difference meter observing frequency difference between two 10MHz oscillators 

Ensure your spectrum analyzer has an external reference connected to the input BNC port and is 

activated through the file menu. If an external reference is not connected and active, the internal 

timebase of the spectrum analyzer is used. Connect an oscillator to the input RF port on the spectrum 

analyzer and set the desired frequency setting. Set the reference level to about 5dB above the input 

signal level. Observe the frequency offset (Measured – Desired). As you adjust the input oscillator, use 

the scale radio buttons to adjust the frequency range displayed on the output meter. As the scale is 

TRY THIS: Utilize sweep mode to find a 
signal of interest and start the Audio 
Player to immediately begin listening at 
that frequency. 
 

TRY THIS: Utilize sweep mode to find a 
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increased, the damping increases on the output meter. Allow several seconds for the meter to settle on 

the smallest scale settings. 

6.11 ADJUSTING YOUR TIMEBASE 
Using the timebase adjust utility, you can semi-permanently adjust your Signal Hound’s internal 10MHz 

oscillator. Access the adjustment utility using the Utilities -> Timebase Adjustment option.  

 
Figure 85: Timebase Adjustment Utility 

The utility allows you to adjust the internal oscillator to a high precision external CW source or oscillator 

through the RF input port. Using the utility, the Spike software can store an adjustment for the serial 

number of the device to use for all future program invocations. Spike stores this adjustment for the 

serial number on the local PC. If you connect a difference device or use a different PC, the adjustment 

will not be applied. 

If you wish to restore the default factory adjustment settings, simply press the Restore Default button at 

any time. You do not need to provide an input CW signal to restore the factory adjustment setting. 

Steps: 

• Connect the high precision source/oscillator to the input RF port on the spectrum analyzer. 

• Disconnect any cables connected to the reference in/out BNC port. 

• Set the reference level about 5dB higher than the expected input signal. 

• Set the input frequency to match the input oscillator frequency. 

• Ensure the frequency offset reading is stable and reasonable before adjusting the 

timebase. 

• Press the Adjust Timebase button. 

• After adjusting, the frequency offset shown will reflect the new adjustment. 
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6.12 SPUR REJECTION 
When spur rejection is on additional signal processing is enabled attempting to remove spurious signals 

which are the result of mixing products. Spur rejection roughly doubles sweep time and is great for 

cleaning up a steady signal, but should not be used for pulsed RF, or modulated signals. Spur rejection is 

not available in real-time mode. 

6.13 NETWORKED SPEED TEST 
This utility tests the speed of a connected networked device, such as an SM200C or SM435C. It shows the 

result in Gigabits per second, and updates each second. 

Networked device to PC throughput is measured using UDP jumbo packets. This utility can be used for 

troubleshooting. For the SM200C/SM435C, network speed should sustain > 8Gbps speeds. 

 

 
Figure 86: Networked Speed Test utility 

6.14 GPS CONTROL PANEL 
The GPS control panel can be accessed from the Utilities menu.  

The Spike software can utilize a GPS device to capture both timestamps and GPS coordinates. The GPS 

information can be utilized in several measurements, including sweep recording, mapping, LTE 

measurements, and more. 

 The GPS device can be one internal to a Signal Hound spectrum analyzer (such as in the SP145, SM200, 

and SM435 devices), or an external device. For GPS devices internal to Signal Hound spectrum analyzers, 

the GPS will auto-lock when the GPS antenna is connected, and the GPS controls are set to “Internal”. 

External GPS devices can be connected over serial, (commonly serial over USB). Platform specific 

instructions are provided below for connecting an external GPS device. The NMEA sentences from the 

external GPS are parsed to determine the timestamps and coordinates. 

GPS data is updated roughly once per second. The current GPS lock status can be viewed in the GPS 

control panel or in the status bar of the Spike application. 
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For internal GPS devices, the “Platform Model” can be selected. Choices are stationary or portable. 

Portable is recommended for any scenario where the spectrum analyzer is not stationary and allows the 

GPS to maintain lock when velocity does not equal zero (for instance when making drive test 

measurements). 

 
Figure 87: GPS Control Panel 

 

 

6.14.1 Windows 
Connected COM devices will appear in the dropdown COM Device. Select the device that corresponds to 

the desired GPS unit. To refresh the list (if a GPS device is plugged in after opening panel), press the 

button Refresh COM Devices. 

6.14.2 Linux 
Enter the name of the serial device as represented in the file system under Device Name. For example, 

“ttyACM0”. This name can be determined using a command like ls /dev | grep tty.  

Pressing “Connect” attempts to communicate with the GPS device. The control panel will warn you if 

unable to detect the GPS device or the NMEA data does not match a valid form. The NMEA data must 

contain the RMC sentence to be considered valid form. 
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If an external GPS is connected, the GPS coordinates provided by the external GPS will override the ones 

provided by the SM. 

Some messages you may encounter using the GPS control panel. 

• Comm Error – The software was unable to find a valid RMC string in the NMEA sentences. 

The primary cause for this is an invalid baud rate. Verify the baud rate is set correctly by 

looking in the properties window for the COM device in the device manager. 

• Locked/Unlocked - Echoes the lock status in the RMC string of either ‘A’ or ‘V’. Coordinates 

are not used while unlocked. 

• Unable to Connect GPS – Verify the COM port and baud rate are correct before attempting 

to connect again. Ensure the device is configured properly on your system. 

6.15 GPS DISCIPLINED TIMEBASE 
(This section only applies to the SM series spectrum analyzers) 

The SM can use its internal GPS to discipline the timebase and internal clocks. This enables more 

accurate and consistent frequency measurements as well as accurate time stamping functionality (when 

using the API). This discipline behavior is enabled by default and the user only needs to connect the 

supplied antenna to start this process. 

When the SM is connected to the Spike software, an additional text field appears in the status bar 

indicating the current GPS status. The possible GPS states displayed are 

 
Figure 88: GPS state readout in Spike status bar. SM devices only. 

1) GPS Unlocked – Either the GPS antenna is disconnected or is connected and hasn’t achieved 

lock yet. After connecting the antenna expect several minutes for the lock. If you do not see a 

lock after several minutes, you might need to reposition the antenna. 

2) GPS Holdover – The GPS is unlocked but is using a holdover value from the last time it was 

disciplined. A typical message here is GPS Holdover (3d19h) denoting the holdover value is 3 

days, 19 hours old. 

3) GPS Locked – The GPS has achieved lock but has not yet disciplined the SM. The GPS must be 

locked for several minutes before discipline occurs. 

4) GPS Disciplined – The SM has been disciplined to the GPS. If the GPS antenna remains 

connected, the GPS will continue to discipline (it will usually update every few minutes). 

Once GPS disciplining has occurred the software records the last known timebase correction value, 

which will be used in future program invocations when a GPS is not present. This stored value is referred 

to as the GPS holdover value. This value is stored in the C:\ProgramData\SignalHound\cal_files directory 

(hidden directory) and is named of the form sm########gps.bin. It is safe to delete this file. 
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The state machine below explains how to determine how the SM timebase is being corrected at any 

given time. To summarize the state machine, a timebase correction value is generated during production 

and is used until the GPS disciplines the system and is stored as a holdover value. If the device is 

recalibrated/adjusted at any time, the newer calibration value will be used over the holdover value. (All 

timebase correction factors are timestamped and the newest one is used) 

 
Figure 89: State machine for GPS disciplining for the SM. 

6.16 BB60D GPIO CONTROLS 
The UART output port on the BB60D can be controlled in Spike using the BB60D UART Controls.  

• UART Rate – The UART clock rate can be selected from several predefined values. 

• Imm Config/Write – The UART output on the BB60D can transmit up to 8 bits. The 

immediate controls can be used to directly transmit a byte over the UART port. 

• UART Sweep – Up to 8 UART bytes can be transmitted at specific frequencies in a sweep. 

This is useful for intra-sweep antenna switching or controlling an external device during a 
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sweep. When enabled, a UART byte is transmitted when the sweep frequency crosses a 

user defined frequency. When enabled, this functionality will override the 10MHz output 

reference if configured. 

6.17 SP145 GPIO CONTROLS 
 

6.18 SM GPIO CONTROLS 
The GPIO on the SM200 and SM435 spectrum analyzers can be controlled in Spike. There are two GPIO 

output modes that can be configured, fixed and sweep. Fixed mode sets the GPIO output pins to fixed 

outputs, while the sweep mode changes the GPIO pins at different points in the sweep. The GPIO can be 

configured using the SM GPIO Controls found in the File->Utility menu. 

The DB15 port on the SM spectrum analyzers has 8 GPIO pins that can be configured. Please see the 

user manual for the SM200 and SM435 for a description and pinout of the DB15 connector. 

6.18.1 Fixed Output Mode 
Fixed GPIO mode is ideal for manually controlling external devices with up to 8 configurable GPIO pins.  

In fixed output mode the GPIO pins are fixed. Device measurements are stopped when updating the 

GPIO output pins. The GPIO remains fixed until disabled or modified. 

6.18.2 Sweep Output Mode 
The sweep output mode is ideal for switching between multiple antennas during a single sweep or 

controlling any other device via GPIO mid sweep. 

In sweep output mode, a sequence of frequencies and GPIO pin values are configured. When the sweep 

crosses the specified frequency, the GPIO pins are configured to the pin values associated with that 

frequency. The first frequency should be 0 Hz ensuring the GPIO pins start at a specified value.  

Up to 8 discrete frequency/GPIO steps can be configured.  

The resolution at which the frequency values can be configured depend on the measurement type. In 

standard sweep mode, the frequency resolution is 40MHz, and in real-time swept mode, the frequency 

resolution is 160MHz. Any attempt to specify frequencies at smaller resolutions will result in unspecified 

behavior.  
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6.19 DEMO MODE 
If Spike is opened with no device connected, a dialog will appear with the option to launch the demo 

device. This will allow several analysis modes to operate with simulated signals, with most functionality 

available. 

Analysis modes that can be demoed are Sweep, Zero-Span, Digital Demodulation, Interference Hunting, 

Spectrum Emission Mask, Harmonics, and Mapping. 

 

Figure 90: Demo mode dialog. 

6.20 MANAGING LICENSES 

 

Figure 91: License Manager dialog. 

The License Manager dialog is used to add, activate, remove, and see details about licenses stored on the 

machine. 



Additional Features | Managing Licenses 
  

163 

All licenses in use locally are displayed in the list on the left, with their associated serial number. Expired 

licenses are shown in red text. Clicking on a license will show its details on the right. It will also enable 

actions to be performed on it with buttons on the right. 

To enable a licensed feature, an active license must be added to the local store. Instructions on how to 

do this are below. 

6.20.1 Adding and Activating a License 
After purchasing a Signal Hound software license, you will receive a license key that is used to activate 

the license in Spike. An internet connection is needed for activation, but from then on the license is 

stored locally and no internet connection is needed. 

1. First, make sure Spike is up to date. You can download the latest version here. 

2. Navigate to your account page on the Signal Hound website. 

 

Figure 92: Navigating to My Account portal on Signal Hound website. 

3. Click “Licenses” in the sidebar. 

https://signalhound.com/spike/
https://signalhound.com/my-account
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Figure 93: Viewing licenses in My Account portal on Signal Hound website. 

4. Click the “Copy” button to copy the license key to your clipboard. 
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Figure 94: Copying license key from My Account portal on Signal Hound website. 

5. In Spike, open the License Manager from the Utilities menu. 
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Figure 95: Opening License Manager from Utilities menu. 

6. In the License Manager utility, click the “Add License” button. 

 

Figure 96: Add License button. 

7. Paste the license key into the text field and click “Ok”. 
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Figure 97: Add License dialog. 

8. When prompted, enter the serial number of the Signal Hound spectrum analyzer you would like 

to associate with this license. When the license becomes associated with a spectrum analyzer via 

its serial number it is considered active,  

6.20.2 Removing a License 
To remove a license, select it from the list, and press the Remove License button. This only removes the 

license information from the local machine, but does not affect the license itself, which can be re-added 

on this or another machine. 

6.20.3 Refreshing a License 
If a license was renewed or otherwise altered, the local information can be updated to reflect these 

changes by pressing the Refresh License button. 

7 Plotting 
This section describes the various plots and displays in the Spike software. 

7.1 BASIC PLOT 
Several plots in the Spike software adhere to a standard interface. Currently, plots in the following 

modes adhere to this interface. 

• Zero-span (except CCDF) 
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• Digital modulation analysis 

• Analog Demod 

• Spectrum Emission Mask 

• Bluetooth® Low Energy 

• WLAN 

• LTE 

• Noise Figure 

• Sweep/Realtime (zoom features only) 

 

Measurement modes not listed here will have custom plots with their own unique interface.  

 

This section describes the features of this standard plot. The plot below is the AM vs Time plot from 

zero-span and key points on the plot are labeled and described below. 

 

 
Figure 98: Basic plot areas of interest. 

A. Main plot window.  

B. Marker, left mouse click anywhere in the plot border to place a marker on the closet point 

in the graph. 

C. Delta marker, enabled through the context menu. Displays the reference point to which the 

marker is compared. 

D. Marker readout, displays either the position of the marker or if the delta marker is enabled, 

the difference between the marker and the delta marker reference. 

E. Plot Title. 

F. X-axis label. Might contain additional measurement information relevant to the current 

plot. 

G. Reference level and zoom indicator asterisk. 

H. Error annunciators. 
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I. Region to the left of the y-axis. In this region the user can control the y-axis scale. 

7.1.1 Zoom and Axis Manipulation 
There are four primary ways to manipulate the x/y axis of the plot. 

1) Left click and drag of the mouse within the plot border. This lets the user select a specific region 

of interest to display. This can only be performed after enabling drag zoom in the context menu. 

 

 
Figure 99: User is dragging a zoom region around the on period of a pulse. 

2) Click and drag to the left of the y-axis, or below the x-axis. This allows the user to move the 

reference level or time of the plot.  

3) Hover over the area to the left of the y-axis or below the x-axis and scroll the mouse wheel. This 

contracts/expands the y-axis or x-axis. 

4) In the context menu, select “Set Axes” and manually define the ranges of the x-axis and y-axis. 

 

When the user has modified the axes in any way, an asterisk appears next to the unit of the plot 

indicating that the user has overriden the default scale. The user can use the context menu to revert to 

previous or the default plot scales. 

7.1.2 Markers 
A single marker is available for control. Left clicking anywhere within the plot border will place the 

marker on the closest point. Further control of the marker can be performed by using the left/right 

arrow keys to move the marker a single index left or right on the current graph. If the plot contains 

multiple graphs/lines, using the up/down arrow keys will jump the marker between the two graphs. 
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When a marker is active, selecting delta marker in the context menu places a reference marker at the 

current marker location. Selecting delta marker again disables the marker. 

7.1.3 Context Menu 
The context menu is activated by right clicking anywhere within the plot. A description of each context 

menu item is provided below. 

 
Figure 100: The context menu is displayed after right mouse clicking anywhere in the plot. 

• Previous Zoom – Restores the previous level of zoom/scale. Additionally, it will show how 

many levels of user zoom/scale are active. 

• Auto Zoom – Restores the default scale. 

• Enable Zoom/Disable Drag Marker – When enabled the marker drag functionality is 

replaced with the ability to drag a zoom window on the plot. 

• Set Axes – Manually define the ranges of the x-axis and y-axis. 

• Peak Search – Move the marker to the location of the largest y-value. If the marker is 

disabled, enable it. 

• Minimum Search – Move the marker to the location of the smallest y-value. If the marker 

is disabled, enable it. 

• Place Delta Marker – If the marker is enabled, place the reference marker at the current 

marker position. 

• Disable Marker – Disable the marker and delta marker if enabled. 

• Export – Exports all graphs shown in the plot into a CSV file. 

• Save as Image – Save the current plot as an image. 
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7.2 SPECTROGRAM 

 
Figure 101: FM broadcast 

The software offers a spectrogram display, also called a waterfall display, which displays several sweeps 

over time. The spectrogram is available in sweep, real-time, and interference hunting measurement 

modes. 

The spectrogram stores a selectable number of sweeps in a scrollable history. Each horizontal line in the 

spectrogram represents a single sweep. The x-axis represents frequency, the y-axis represents time, and 

amplitude is represented using a color-coded scheme.  

Enable the spectrogram from the toolbar. The spectrogram can be resized by using the mouse to drag 

the splitter bar below the spectrogram display. 

Left-clicking on the spectrogram display places a marker on the sweeps, providing a method of 

measuring the frequency, amplitude, and time of any event stored in the spectrogram. The marker 

readout appears in the upper right of the display. The marker can be disabled in the right-click context 

menu. 

Right-clicking on the spectrogram display brings up a menu with four options. 

• Preferences – Opens the preferences menu described below. 

• Clear Spectrogram – Clears the current spectrogram display. 

• Delta Marker – Sets the delta marker at the currently selected position. 

• Auto Scale – Sets the min and max value of the scale to the min and max values of the currently 

displayed data. 
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The available preferences and a description of their function is below. 

• Sweep Depth - The number of spectrums stored in the spectrogram. Once this number of 

spectrums has been accumulated, the oldest spectrum is removed to make room for a new 

one. Each horizontal pixel line represents one stored spectrum. The current spectrum 

count and depth is displayed in the upper left of the spectrogram. 

• Time Density – Specifies the minimum amount of time each stored spectrum represents. If 

the device is sweeping at a faster rate than this value, several sweeps will be accumulated 

to create the single spectrum stored in the spectrogram.  

• Mouse Wheel Scroll Pixels – Controls the scrolling speed of the display when using the 

mouse wheel to scroll. 

• Auto Scrolling – Controls the behavior of the display when you are looking at past events 

(scrolled back through spectrums). If disabled, the plot will not advance when new 

spectrums are added to the display. (Note: Once the maximum number of spectrums has 

been met in the plot, the display will scroll regardless of this setting. 

• Marker Active – Enables/Disables the marker. 

• Color Scale – Switch between a color spectrum or gray scale gradient. 

• Scale to Ref – When enabled, the reference level and bottom of the graticule are used at 

the min and max amplitudes that are mapped onto the color gradient. When disabled, the 

min and max color settings are used (see below). 

• Min Color (dBm) – When Scale to Ref is disabled, this value overrides the bottom of the 

graticule as the minimum amplitude that is mapped onto the color gradient. 

• Max Color (dBm) – When Scale to Ref is disabled, this value overrides the reference level as 

the maximum amplitude that is mapped onto the color gradient. 

7.3 PERSISTENCE 
The persistence display is helpful for viewing spectral density over time. Instead of showing a single 

trace, persistence uses several sweeps to create an image where color is representative of how often a 

signal appears. The software uses the color spectrum to represent density over time. If a signal rarely 

occurs in a location, a light blue is used to color the trace. If a signal continues to appear in the same 

location the color will change from blue to green to red. Red is an indication of a signal persisting in one 

location for a good deal of time.  

There are two types of persistence displays, one for standard spectrum analysis and one for real-time 

analysis. For standard spectrum analysis, persistence is simply an accumulation of the most recent 

sweeps. This display is shown below. 
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Figure 102: Sweep mode persistence showing the signal from a poorly shielded commercial microwave oven. 

 
Figure 103: Real-time persistence display of a wireless router and Bluetooth® headset coexisting in the ISM band. 

In real-time mode, persistence is the accumulation of 2/3rd of a second worth of spectrum data. This 

means, each update in the persistence display is the accumulation of the result of 1600 – 400000 FFTs. 
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8 Troubleshooting 
If you experience a problem with your Signal Hound on Windows systems, please try these 

troubleshooting techniques. On Linux systems, please consult the README included in the download. 

This section will contain general troubleshooting tips as well as device specific tips. If a troubleshooting 

tip applies to a specific device, the tip will make note of it. 

8.1 THE SPIKE SOFTWARE REPORTS “DEVICE NOT 
FOUND” (ALL DEVICES) 

Try the troubleshooting tips here first, if these do not work, see the troubleshooting tips for your specific 

device below. 

Ensure the device is plugged in and the LED is a solid green color. If it is not, unplug then plug in the 

device. Once the green light turns on, use the File menu to try to connect the device again. 

8.1.1 The Device Light is solid green and still will not 
connect. 

Early BB60A units sometimes require a power cycle after the PC has restarted or woke up from 

hibernation. For these units, try a power cycle before restarting the software. 

If it is the first time the device has been connected to a PC, the device might require many seconds to 

identify and install the latest drivers for the device.  Usually, a PC will notify you if this identification 

process is occurring and when it is finished. Wait until the device has been properly identified by your PC. 

You can verify this by finding the device in the device manager. It will bear the Signal Hound name if it 

has been identified. 

If a power cycle still does not allow you to connect the device, it is possible the device drivers were not 

successfully installed. See the Driver Installation section for more information.  

8.1.2 The device is connected but does not exhibit a solid 
green light. 

For the BB series spectrum analyzers, 

• Power cycle the device by disconnecting the USB cable from the spectrum analyzer end. If 

the provided cable is a USB y-cable, ensure both USB ends are connected to the PC before 

connecting it to the device. 

• Update power management settings. 
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• If the device is connected to a charging port, attempt operation after moving the device to a 

non-charging port. For devices with a y-cable (SA124 and BB60) this should only affect the 

main data cable, not the auxiliary power cable. 

For the SA series spectrum analyzers, 

• Disable any anti-virus software. Aggressive anti-virus software has been known to interfere 

with Signal Hound devices. 

• Ensure the driver was configured correctly by your system. In the device manager, find 

“Serial Convert A/B” in the “Universal Serial Bus Controllers” tab. Right click and select 

properties, select the “Advanced” tab and ensure the “Load VCP” box is unchecked. 

8.2 THE SPIKE SOFTWARE REPORTS “DEVICE NOT 
FOUND” (BB60, SM200A/B, SM435B) 

Ensure the LED on the device is solid green. If the device is solid green, ensure the drivers have been 

properly installed by going to the "Device Manager" expanding the "Universal Serial Bus Controllers" tab 

and looking for the Signal Hound xxxx while the device is plugged in.  

If the LED on the device is not solid green after plugging it in, then it might be necessary to update your 

USB 3.0 drivers for your PC. You can upgrade your drivers using these steps. 

Fully update your PC through the Windows update utility. Also look for USB drivers provided by your 

manufacturer by searching for your PC model number on the manufacturer website or on your favorite 

search engine. Only download drivers found on trusted websites. 

Unplug the device before starting any USB driver updates, restart your PC afterwards, and verify 

operation. 

If you continue to experience issues, contact Signal Hound. 

8.3 THE SPIKE SOFTWARE REPORTS “DEVICE NOT 
FOUND” (SA44, SA124) 

Ensure your USB cables are properly secured and the LED on the device is solid green. 

Ensure you have installed the USB drivers. Download them from the related downloads section on the 

Spike download page. 

Ensure the driver was configured correctly by your system, In the device manager, find "Serial Converter 

A/B" in the "Universal Serial Bus Controllers" tab. Right click and select properties, select the "Advanced" 

tab and ensure the "Load VCP" box is unchecked. 
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Ensure the devices are properly powered, some laptops/notebooks may not provide sufficient power by 

default. Go to the "Power Options" menu found in the control panel and enable the "High Performance" 

power plan.  

Disable any anti-virus software. Aggressive real-time anti-virus software has been known to interfere 

with Signal Hound devices. 

8.4 THE DEVICE DISCONNECTS DURING 
OPERATION 

There are many reasons a Signal Hound device might experience an issue during operation. Most issues 

are USB related issues and some might be related to PC performance. Here are some things you can try 

to eliminate this behavior. 

• Disable any anti-virus software. Aggressive anti-virus software has been known to interfere 

with Signal Hound devices. 

• Update power management settings.  

• Update your USB drivers, see the “Device Not Found (BB60, SM200A/B, SM435B)” 

troubleshooting tip. 

8.5 THE DEVICE IS NOT VALID 
In the event the device ceases to operate or becomes corrupted, the Spike application might tell you the 

device does not appear to be valid. Before contacting us, attempt to power cycle the device and restart 

your computer to ensure nothing else is causing this issue. If the issue persists, please contact us. 

8.6 THE DEVICE REPORTS “IF OVERLOAD” ON 
PROGRAM STARTUP 

Some Signal Hound devices might report an IF overload condition for a short time after launching the 

software or connecting the device through the File menu. This condition is considered normal and is part 

of the normal hardware startup process. This condition should last typically less than one second of 

operation. 

8.7 POWER MANAGEMENT SETTINGS 
It is recommended to perform this step with the Signal Hound spectrum analyzer disconnected from the 

PC. 

Many laptops and PC’s are initially configured for energy savings. The Signal Hound spectrum analyzers 

are high performance USB devices and can benefit in stability and operation by configuring the PC or 

high-performance operation. 
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To change your power management settings to high performance you need to access the “Power 

Options” menu found in the control panel menu. You can also reach the Power Options menu by hitting 

the Windows key and searching for “Power Options”. 

Once in the Power Options menu, you need to select the “High Performance” power plan. You may need 

to click “Show Additional Plans” to show the high-performance option, and/or “Advanced Settings” to 

show power plans. 

You may also need to disable “Selective Suspend” in the “USB Settings” section of the Advanced Power 

Options settings menu. 

8.8 ERROR CODE 48: THE SOFTWARE FOR THIS 
DEVICE HAS BEEN BLOCKED 

Instructions for BB60C 

The device is not able to be found by the Spike software and the driver details for the device reports 

“Error Code 48: The software for this device has been blocked because it is known to have problems with 

Windows. Contact the hardware vendor for a new driver.”  

If you are seeing this message, it is likely the device drivers were improperly installed during the Spike 

installation procedure. Re-installing the drivers manually has been effective at resolving this issue. First 

uninstall the current driver by connecting the BB60C and navigating to the “Device Manager”. Under the 

“Universal Serial Bus Controllers” tab, find the BB60C. Right click and uninstall the driver. If there are any 

checkboxes that additionally state to delete or remove the BB60C driver completely, select those as well. 

Once the driver has been uninstalled, disconnect the BB60C from the PC. Now we need to manually 

reinstall the driver. Navigate to the Spike installation directory at C:\Program Files\Signal Hound\Spike 

and find the drivers folder. If you are on 64-bit system select the x64 folder, and select the x86 folder if 

you are on 32-bit Windows. Right click the cyusb3.inf file and select install. If the installation succeeds, re-

connect the BB60C and try launching the Spike software. 

8.9 THE DEVICE DOES NOT WORK IN MY 
WINDOWS VIRTUAL MACHINE (BB60C ONLY) 

The Signal Hound devices are not supported to work within Windows virtual machines, but several 

customers have reported success after some troubleshooting. 

The most common issues reported are device disconnect issues and Spike not being able to detect the 

BB60C. Both issues suggest USB configuration errors. 
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- Customers have reported success using the latest versions of VMware on both Windows and 

Apple computers. The PC must support USB 3.0, preferably with a 4th generation or later Intel 

i5/i7 CPU. 

- Ensure USB 3.0 SuperSpeed is enabled for the virtual machine. Customers report it is often 

disabled by default. 

- The Spike installer may not correctly install the BB60C drivers, and might need to be manually 

installed. See Driver Installation for instructions for manually installing the BB60C drivers. 

9 Calibration and Adjustment 
Contact Signal Hound for more information regarding calibration software and required equipment. 

10 Warranty and Disclaimer 
©2013-2021 Signal Hound. All rights reserved. 

Reproduction, adaptation, or translation without prior written permission is prohibited, except as 

allowed under the copyright laws. 

The information contained in this manual is subject to change without notice. Signal Hound makes no 

warranty of any kind with regard to this material, including, but not limited to, the implied warranties or 

merchantability and fitness for a particular purpose. 

Signal Hound shall not be liable for errors contained herein or for incidental or consequential damages 

in connection with the furnishing, performance, or use of this material.  

Refer to the End User License Agreement for additional warranty and disclaimer information covering 

the Spike software.  

10.1 CREDIT NOTICE 
Windows® and Excel® are registered trademarks of Microsoft Corporation in the United States and 

other countries.  

Intel® and Core™ are trademarks or registered trademarks of Intel Corp. in the United States and other 

countries.  

LabVIEW® is a registered trademark of National Instruments Corporation in the United States and other 

countries.  

MATLAB® is a registered trademark of The MathWorks, Inc.  in the United States and other countries. 
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The Bluetooth® work mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any 

use of such marks by Signal Hound is under license. Other trademarks and trade names are those of 

their respective owners. 

 

11 Appendix 
11.1 USING MULTIPLE USB 3.0 DEVICES ON LINUX 

There are system limitations when attempting to use multiple Signal Hound USB 3.0 devices* 

simultaneously on Linux operating systems. The default amount of memory allocated for USB transfers 

on Linux is 16MB. A single Signal Hound USB 3.0 device will stay within this allocation size, but two 

devices will exceed this limitation and can cause connection issues or will cause the software to crash.  

The USB memory allocation size can be changed by writing to the file 

/sys/module/usbcore/parameters/usbfs_memory_mb 

A good value would be N * 16 where N is the number of devices you plan on interfacing simultaneously. 

One way to write to this file is with the command, 

sudo sh -c ‘echo 32 > /sys/module/usbcore/parameters/usbfs_memory_mb’ 

where 32 can be replaced with any value you wish. You may need to restart the system for this change to 

take effect. 

*Includes both Signal Hound USB 3.0 spectrum analyzers and signal generators. 

11.2 COMMAND LINE OPTIONS 
The following command line options are available when launching Spike.  

--hidden, Hides the user interface, including on the taskbar. To be used in conjunction with SCPI to 

allow for ‘headless’ operation. The application can be closed via SCPI commands or manually in the task 

manager. 

The following dialogs will not be shown in hidden mode: 

• No device connected 

• Multiple devices connected 

• Connecting device.. 
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• SCPI remote operation notification 

  

--preset=n, Load quick preset number n after launching. n must be an integer between [1,9]. For this 

command to work, one device must be connected to Spike so that Spike will auto connect, and the 

preset specified must have been created with the connected device type. 

--preset-user=”filename.ini”, Load a user preset on startup. The full path to the file name must 

be specified. If the filename or path contains spaces, you must surround it with quotes, otherwise quotes 

are not strictly necessary. For this command to work, only one device can be connected to the PC, and 

the preset must have been created with the connected device type. 

--scpi-port=n, Set the SCPI port after launching Spike. n should be an integer not exceeding 65535. 

This has the same effect as modifying the SCPI port through the preferences menu. This command line 

assists customers who want to interface multiple instances of Spike with different SCPI ports.  

11.3 MATLAB® RUNTIME INSTALLATION 
INSTRUCTIONS 

To use the LTE measurements in Spike, the MATLAB® runtime and, for Windows, Visual Studio 2019 

(VS2019) C++ redistributable libraries must be installed on the PC. The next two sections detail how to 

install these freely available libraries. 

11.3.1 Installing the MATLAB Runtime 
The MATLAB® runtime is freely available for download from the following website. 

https://www.mathworks.com/products/compiler/matlab-runtime.html 

11.3.1.1 Windows 
Download the 64-bit Windows installer for R2021b (9.11). Extract the downloaded folder and run the 

setup.exe file. Install the MATLAB Runtime to the default installation folder. 

During installation, the installer will add the MATLAB® runtime folder to the system path. If this fails, you 

will receive this warning during installation.  

“The MATLAB Runtime could not be successfully added to your system path. You must add the following folder 

manually: C:\Program Files\MATLAB\MATLAB Runtime\v911\runtime\win64" 

This will often fail due to the system PATH environment variable exceeding its maximum length. In this 

event, you must add the runtime folder to the system path manually. This can be performed using the 

registry editor or through the environment variable editor on Windows. Editing the system path via the 

https://www.mathworks.com/products/compiler/matlab-runtime.html
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registry editor will allow you to exceed the length limit of 2047 characters. Editing the path via either 

method will require you to restart the PC before Spike will properly detect the MATLAB runtime libraries. 

11.3.1.2 Linux 
Download the 64-bit Linux installer for R2021b (9.11). Extract the downloaded folder and run the 

installation file with: 

sudo -H ./install 

Install the MATLAB Runtime to the default installation folder, which is /usr/local. 

11.3.2 Windows Only: Installing the VS2019 C++ 
Redistributable Library 

The Visual Studio 2019 C++ redistributable libraries are available at the following link. Download and 

install the 64-bit (non-ARM) libraries. 

https://docs.microsoft.com/en-US/cpp/windows/latest-supported-vc-redist?view=msvc-170 

11.3.3 Load Times 
The Spike software initializes the MATLAB runtime when the LTE measurements are accessed. This load 

time can take typically anywhere from 3-15 seconds. This load time cost will be incurred once per launch 

of the Spike application. The presence of anti-virus software can greatly affect these load times. Consider 

disabling any real-time AV monitoring software to reduce these load times. 

11.4 CONSTELLATION MAPPINGS 
BPSK 

Data Phase  

0 0 

1 180° 

 

QPSK 
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DQPSK 

Data Phase Change 

0 0 

1 +π/2 

2 - π/2 

3 π 

 

 

 

 

 

 

 

 

D8PSK 

Data Phase Change 

0 0 

1 +π/4 

2 +3π/4 

3 +π/2 

4 -π/4 

5 -π/2 

6 π 

7 -3π/4 

 

8-PSK 

π/4 DQPSK 

Data Phase Change 

0 +π/4 

1 +3π/4 

2 - π/4 

3 -3π/4 
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16-QAM 

 

Note: Positive I-axis is to the right, positive Q-axis is to the top. 

32/64/256/1024-QAM 

64/256 QAM is defined similarly to 16 QAM. Symbols are increasing from right to left, top to bottom, 

starting with 0 in the upper right-hand corner of the constellation diagram and ending with 63/255/1023 

in the lower left-hand corner. 

OQPSK 

Offset QPSK is the same as QPSK, except the Q is delayed by ½ symbol. 
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M-FSK 

All FSK modulations are gray coded. For example, 4FSK uses the following mapping, 

Data Frequency Offset (normalized) 

0 -1 

1 -1/3 

2 1 

3 1/3 

 

11.5 MANUAL GAIN/ATTEN SETTINGS (BB60) 
All settings must be set to non-automatic values to override the automatic settings. 

The preamplifier setting does not affect the BB60 measurement but should be switched from auto for 

manual selections to be used. 

For the gain setting, 

• Gain 0: Preamplifier off, add 5dB to attenuator 

• Gain 1: Preamplifier off, do not add attenuation 

• Gain 2: Preamplifier on, add 5dB attenuation 

• Gain 3: Preamplifier on, do not add attenuation 

 

For the attenuation setting, 

• Attenuation 0 – 20dB: adds 0 to 20dB of attenuation, plus any contribution from gain 

setting. 

• Attenuation 30dB: adds 30dB of attenuation, and the effects of gain 0 and 2 are the same 

as gain 1 and 3. 

12 References 
1. ANSI C63.2 “American National Standard for Electromagnetic Noise and Field Strength 

Instrumentation, 10Hz to 40 GHz – Specifications”, American National Standards Institute, 

January 1996. 
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